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Thank you for purchasing DAQStudio. 
This manual explains the use of DAQStudio. Please read this manual carefully before 
use and use DAQStudio correctly. 
After reading the manual, keep it safe at a location where it is easily available at the time 
of use. It will help you if you should not understand the handling during use. 
Adobe Reader 7 or later of Adobe Systems Incorporated is required to display this 
manual.

Notes
•	 The contents of this manual are subject to change without prior notice.
•	 Every effort has been made in the preparation of this manual to ensure accuracy. 

However, if any questions arise or errors are found in this manual, please inform the 
nearest Yokogawa sales representative office.

•	 Copying or reproduction by any means of all or any part of the contents of this manual 
without permission is strictly prohibited.

•	 Transfer or loan of the software to a third party is prohibited.
•	 Once the software is unpacked, Yokogawa will not guarantee the designed operation 

of the software, except when the original floppy disk is found to be physically 
defective.

•	 Yokogawa will not accept any responsibility for damage caused directly or indirectly as 
result of use of this software.

•	 The serial number will not be reissued, therefore, it must be kept in a safe place.
•	 Adobe Reader 7 or later by Adobe Systems Inc. is required to view the manual.

Trademarks
•	 vigilantplant, DAQSTATION, Daqstation, and DXAdvanced are registered trademarks 

of Yokogawa Electric Corporation.
•	 Microsoft and Windows are registered trademarks or trademarks of Microsoft 

Corporation in the United States and/or other countries.
•	 Adobe and Acrobat are registered trademarks or trademarks of Adobe Systems 

Incorporated.
•	 Company and product names that appear in this manual are registered trademarks or 

trademarks of their respective holders.
•	 The company and product names used in this manual are not accompanied by the 

registered trademark or trademark symbols (® and ™).

Revisions
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2nd Edition: April			  2009
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4th Edition: August		  2010

4th Edition : August 2010 (YK)
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Terms and Conditions of the Software License

NOTICE - PLEASE READ CAREFULLY BEFORE USE
Thank you very much for purchasing this medium containing a software program and related documentation provided by Yokogawa Electric Corporation (hereinafter called 
“Yokogawa”), and the program contained, embedded, inserted or used in the medium (hereinafter called the “Yokogawa Software Program”).
By installing the Yokogawa Software Program, you acknowledge that you understand and fully agree to the “Terms and Conditions of the Software License” (hereinafter called 
“Terms and Conditions”) which is written in the documentation and separately attached. Accordingly, the Terms and Conditions bind you.
The Yokogawa Software Program and its related documentation including ownership of copyright shall remain the exclusive property of Yokogawa or those third parties who 
grants Yokogawa the rights.
Yokogawa hereby grants you permission to use the Yokogawa Software Program on the conditions that you agree to the Terms and Conditions before you install it in or onto 
a computer.

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS, YOU CANNOT INSTALL THIS MEDIUM, AND MUST PROMPTLY RETURN IT TO YOKOGAWA OR ITS 
DESIGNATED PARTY.

Terms and Conditions of the Software License
Yokogawa Electric Corporation, a Japanese corporation (hereinafter called “Yokogawa”), grants permission to use this Yokogawa Software Program (hereinafter called the 
“Licensed Software”) to you on the conditions that you agrees to the terms and conditions stipulated in Article 1 hereof.
You, as the Licensee (hereinafter called “Licensee”), shall agree to the following terms and conditions on the software license (hereinafter called the “Agreement”) when the 
Licensed Software is installed by the Licensee.
Please note that Yokogawa grants the Licensee permission to use the Licensed Software under the terms and conditions herein and in no event shall Yokogawa intend to 
sell or transfer the Licensed Software to the Licensee.

Article 1 (Licensed Software under these Terms and Conditions)
1.1	 The terms and conditions stipulated herein shall bind any Licensee who purchases the Licensed Software on the condition that the Licensee consents to agree to the 

terms and conditions stipulated herein.
1.2	 The “Licensed Software” and required number of license herein shall be specified in the following paragraphs (1) and (2) respectively. The Licensed Software means 

and includes all applicable programs and documentation, without limitation, all proprietary technology, algorithms, a factor, invariant, process and/or other know-how 
contained therein. These terms and conditions shall also govern any additional software to the Licensed Software inclusive of its version-up or revision-up if Yokogawa 
provides them to the Licensee.
(1)	 Licensed Software Name: DAQStudio (Model DXA170)
(2)	 Number of License: 1

Article 2 (Grant of License)
2.1	 Yokogawa grants the Licensee, for the purpose of single use, non-exclusive and non-transferable license of the Licensed Software with the license fee separately agreed 

upon by both parties.
2.2	 The Licensee is, unless otherwise agreed upon in writing by Yokogawa, not entitled to change, sell, distribute, transfer, or sublicense the Licensed Software.
2.3	 The Licensed Software shall not be copied in part or in whole except for keeping one (1) copy for back-up purpose. The Licensee shall secure or supervise the copy of 

the Licensed Software by the Licensee itself with great, strict, and due care.
2.4	 The Licensed Software remains the exclusive property of Yokogawa and, if any, those of third parties from whom Yokogawa is sublicensed (hereinafter such third party’s 

software is called “Third Party Software”, which may include any software program made or coded by affiliates of Yokogawa). In no event shall the Licensee dump, 
reverse assemble, reverse compile, or reverse engineer the Licensed Software so that the Licensee may translate the Licensed Software into other programs or change 
it into a man-readable form from the source code of the Licensed Software. Unless otherwise separately agreed upon by Yokogawa, Yokogawa shall not provide the 
Licensee the source code for the Licensed Software.

2.5	 The Licensed Software and its related documentation inclusive of its ownership of copyright shall be the proprietary property of Yokogawa or a third party who grants 
Yokogawa the rights. In no event shall the Licensee transfer, lease, sublicense, or assign any rights relating to the Licensed Software.

2.6	 Yokogawa may use or add copy protection in or onto the Licensed Software. In no event shall, regardless of the purpose, the Licensee remove or attempt to remove 
such copy protection.

2.7	 The Licensed Software may include the Third Party Software. In the case that Yokogawa is granted permission to sublicense to third parties by any licensors (sub-
licensor) of the Third Party Software under different terms and conditions than those stipulated in this  Agreement, the Licensee shall observe such terms and conditions 
of which Yokogawa notifies the Licensee in writing separately.

2.8	 In no event shall the Licensee modify, remove or delete a copyright notice of Yokogawa and its licenser contained in the Licensed Software, including any copy 
thereof.

Article 3 (Restriction of Specific Use)
3.1	 The Licensed Software shall not be intended specifically to be designed, developed, constructed, manufactured, distributed or maintained for the purpose of the following 

events:
a)	 Operation of any aviation, vessel, or support of those operations from the ground;
b)	 Operation of nuclear products, its facilities and/or radiation apparatus;,
c) 	 Operation of nuclear weapons, chemical weapons and/or biological weapons, or railroad; or
d)	 Operation of medical instrumentation directly utilized for humankind or the human body.

3.2	 Even if the Licensee uses the Licensed Software for the purposes in the preceding Paragraph 3.1, Yokogawa has no liability to or responsibility for any claims or 
damages arising out of the use or operations of the Licensed Software, and the Licensee agrees, on its own responsibility, to solve and settle the claims and damages 
and to defend, indemnify or hold Yokogawa totally harmless, from or against any liabilities, losses, damages and expenses (including fees for recalling the Products and 
reasonable attorney’s fees and court costs), or claims arising out of and related to the above-said claims and damages.

Article 4 (Warranty)
4.1	 The Licensee shall agree that the Licensed Software shall be provided to the Licensee on an “as is” basis when delivered. If defect(s), such as damage to the medium of 

the Licensed Software, attributable to Yokogawa is found, Yokogawa agrees to replace, free of charge, any Licensed Software on condition that the defective Licensed 
Software shall be returned to Yokogawa’s specified authorized service facility within  12 month from the delivery of Yokogawa after opening the Package at the Licensee’s 
expense. As the Licensed Software is provided to the Licensee on an “as is” basis when delivered, in no event shall Yokogawa warrant that any information on or in the 
Licensed Software, including without limitation, data on computer programs and program listings, be completely accurate, correct, reliable, or the most updated.

4.2	 Notwithstanding the preceding Paragraph 4.1, when Third Party Software is included in the Licensed Software, the warranty period and related conditions that apply 
shall be those established by the provider of the third party software.
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4.3	 When Yokogawa decides in its own judgement that it is necessary, Yokogawa may from time to time provide the Licensee with Release Upgrades specified by Yokogawa 
(hereinafter called “Release Upgrades”).

4.4	 Notwithstanding the preceding Paragraph 4.3, in no event shall Yokogawa provide Updates where the Licensee or any third party conducted renovation or improvement 
of the Licensed Software.

4.5	 Correction of nonconformity in the manner and for the period of time provided above shall be the Licensee’s sole and exclusive remedy for any failure of Yokogawa to 
comply with its obligations and shall constitute fulfillment of all liabilities of Yokogawa and any third party licensing the Third Party Software to Yokogawa (including any 
liability for direct, indirect, special, incidental or consequential damages) whether in warranty, contract, tort (including negligence but excluding willful conduct or gross 
negligence by Yokogawa) or otherwise with respect to or arising out of the use of the Licensed Software.

4.6	 THE FOREGOING WARRANTIES ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES OF QUALITY AND PERFORMANCE, WRITTEN, ORAL, OR 
IMPLIED, AND ALL OTHER WARRANTIES INCLUDING ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE ARE 
HEREBY DISCLAIMED BY YOKOGAWA AND ALL THIRD PARTIES LICENSING THIRD PARTY SOFTWARE TO YOKOGAWA.

Article 5 (Infringement)
5.1	 If and when any third party should demand injunction, initiate a law suit, or demand compensation for damages against the Licensee under patent right (including utility 

model right, design patent, and trade mark), copyright, and any other rights relating to any of the Licensed Software, the Licensee shall promptly notify Yokogawa in 
writing to that effect.

5.2	 In the case of the preceding Paragraph 5.1, the Licensee shall assign to Yokogawa all of the rights to defend the Licensee and to negotiate with the claiming party. 
Furthermore, the Licensee shall provide Yokogawa with necessary information or any other assistance for Yokogawa’s defense and negotiation. If and when such a 
claim should be attributable to Yokogawa, subject to the written notice to Yokogawa stated in the preceding Paragraph 5.1, Yokogawa shall defend the Licensee and 
negotiate with the claiming party at Yokogawa’s cost and expense and be responsible for the final settlement or judgment granted to the claiming party in the preceding 
Paragraph 5.1.

5.3	 When any assertion or allegation of the infringement of the third party’s rights defined in Paragraph 5.1 is made, or when at Yokogawa’s judgment there is possibility of 
such assertion or allegation, Yokogawa will, at its own discretion, take any of the following countermeasures at Yokogawa’s cost and expense.
a)	 To acquire the necessary right from a third party which has lawful ownership of the right so that the Licensee will be able to continue to use the Licensed 

Software;
b)	 To replace the Licensed Software with an alternative one which avoids the infringement; or
c)	 To remodel the Licensed Software so that the Licensed Software can avoid the infringement of such third party’s right.

5.4	 If and when Yokogawa fails to take either of the countermeasures as set forth in the preceding subparagraphs of Paragraph 5.3, Yokogawa shall indemnify the Licensee 
only by paying back the price amount of the Licensed Software which Yokogawa has received from the Licensee. 

	 THE FOREGOING PARAGRAPHS STATE THE ENTIRE LIABILITY OF YOKOGAWA AND ANY THIRD PARTY LICENSING THIRD PARTY SOFTWARE TO YOKOGAWA 
WITH RESPECT TO INFRINGEMENT OF THE INTELLECTUAL PROPERTY RIGHTS INCLUDING BUT NOT LIMITED TO, PATENT AND COPYRIGHT.

Article 6 (Liabilities)
6.1	 If and when the Licensee should incur any damage relating to or arising out of the Licensed Software or service that Yokogawa has provided to the Licensee under 

the conditions herein due to a reason attributable to Yokogawa, Yokogawa shall take actions in accordance with this Agreement. However, in no event shall Yokogawa 
be liable or responsible for any special, incidental, consequential and/or indirect damage, whether in contract, warranty, tort, negligence, strict liability, or otherwise, 
including, without limitation, loss of operational profit or revenue, loss of use of the Licensed Software, or any associated products or equipment, cost of capital, loss 
or cost of interruption of the Licensee’s business, substitute equipment, facilities or services, downtime costs, delays, and loss of business information, or claims of 
customers of Licensee or other third parties for such or other damages. Even if Yokogawa is liable or responsible for the damages attributable to Yokogawa and to the 
extent of this Article 6, Yokogawa’s liability for the Licensee’s damage shall not exceed the price amount of the Licensed Software or service fee which Yokogawa has 
received. The Licensee agrees that Yokogawa shall be released or discharged from part or all of the liability under this Agreement if the Licensee modifies, remodels, 
combines with other software or products, or causes any deviation from the basic specifications or functional specifications, without Yokogawa’s prior written consent.

6.2	 All causes of action against Yokogawa arising out of or relating to this Agreement or the performance or breach hereof shall expire unless Yokogawa is notified of the 
claim within one (1) year of its occurrence.

6.3	 In no event, regardless of cause, shall Yokogawa assume responsibility for or be liable for penalties or penalty clauses in any contracts between the Licensee and its 
customers.

Article 7 (Limit of Export)
Unless otherwise agreed by Yokogawa, the Licensee shall not directly or indirectly export or transfer the Licensed Software to any countries other than those where Yokogawa 
permits export in advance.

Article 8 (Term)
This Agreement shall become effective on the date when the Licensee receives the Licensed Software and continues in effect unless or until terminated as provided herein, 
or the Licensee ceases using the Licensed Software by itself or with Yokogawa’s thirty (30) days prior written notice to the Licensee. When aforesaid termination or cease is 
occurred, the Licensee shall immediately destroy and/or eliminate the Licensed Software and related documents without retaining any copies or extracts thereof. However, 
upon specifically instructed by Yokogawa, they shall be returned to Yokogawa or its designated third party.

Article 9 (Injunction for Use)
During the term of this Agreement, Yokogawa may, at its own discretion, demand injunction against the Licensee in case that Yokogawa deems that the Licensed Software is 
used improperly or under severer environments other than those where Yokogawa has first approved, or any other condition which Yokogawa may not permit.

Article 10 (Termination)
Yokogawa, at its sole discretion, may terminate this Agreement without any notice or reminder to the Licensee if the Licensee violates or fails to perform this Agreement. 
However, Articles 5, 6, and 11 shall survive even after the termination.

Article 11 (Jurisdiction)
Any dispute, controversies, or differences between the parties hereto as to interpretation or execution of this Agreement shall be resolved amicably through negotiation 
between the parties upon the basis of mutual trust. Should the parties fail to agree within ninety (90) days after notice from one of the parties to the other, both parties hereby 
irrevocably submit to the exclusive jurisdiction of the Tokyo District Court (main office) in Japan for settlement of the dispute to the fullest extent allowed by applicable law.

Article 12 (Governing Law)
This Agreement shall be governed by and construed in accordance with the laws of Japan. The Licensee expressly agrees to waive absolutely and irrevocably and to the 
fullest extent permissible under applicable law any rights against the laws of Japan which may have pursuant to the Licensee’s local law.

Article 13 (Severability)
In the event that any provision hereof is declared or found to be illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void with respect to 
the jurisdiction of that court or tribunal and all the remaining provisions hereof shall remain in full force and effect.

Terms and Conditions of the Software License
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How to Use This Manual

Structure of the Manual
This manual consists of the following five chapters and index.
Chapter Title Content
1 Before Using the 

DAQStudio 
Explanation of the function outline for DAQStudio. Sample 
images of screens which actually produced are shown. 

2 Creating a Monitor 
Screen with 
DAQStudio

Explanation of the operation method for creation of an 
original monitor screen. Explanation of the operation 
methods for efficient creation and the methods for saving 
and opening created display data.

3 Detailed Information for 
Attributes of Screens 
and Components

Detailed explanation of the individual attributes of screens 
and parts.

4 Communication with 
the DX Recorder 

Explanation of the methods for receiving custom display 
screen data from the DX1000/DX1000N/DX2000 recorder 
and for sending display data which have produced/edited by 
DAQStudio to the DX1000/DX1000N/DX2000 recorder via 
Ethernet.

5 Messages, Handling 
Methods, and Version 
Information 

Message list and explanation of the confirmation method for 
the DAQStudio version. Also explains the correspondence 
between DX recorders that can be connected and the 
screen version of this software.

Index Gives a list of important terms used in this manual.

Scope of the Manual
This manual does not explain the basic operations of your PC’s operating system (OS). 
For information regarding the basic operations of Windows, see the user’s guide that 
came with Windows.

Conventions Used in This Manual
Unit
K	 Denotes 1024			  Example: 100 KB
M	 Denotes 1024K		  Example: 10 MB
G	 Denotes 1024M		  Example: 2 GB

Bolded Items
Items set in boldface mainly refer to on-screen interface elements such as menus, 
commands, dialog boxes, attributes, buttons, or keys on the keyboard.

Markings
►	This mark is used to indicate a reference to a related procedure or explanation.
	 Example : ►Section 4.1

Symbols used in operational explanation
In the pages explaining operation (chapter 1 to 4), the following symbols are used to 
distinguish the descriptions.

		

Procedure This subsection contains the operating procedure used to carry out
the function described in the current section. All procedures are
written with inexperienced users in mind; experienced users may
not need to carry out all the steps.

		  Explanation Explanation gives information such as limitations related the 
procedure.

		  Note Calls attention to information that is important for proper operation 
of the instrument.
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Manual Revision History

Document name:		  DXA170 DAQStudio User’s Manual
Document number:		 IM 04L41B01-62EN

Edition Revised Description of Revisions and DAQStudio Software Version
1st January, 2009 New, R1.01
2nd            April 4, 2009 Corrections, new software display languages added (Chinese, 

German, French, Russian, Korean), R1.02
3rd March, 2010 Added components, changed screens, and added/changed 

component attributes to support DXAvanced R4, R2.01.01
Components added: �Group name, System icon, Memory bar, 

Time label, Batch group number, Batch 
name, and Modbus In. 

Component attribute name change: �Batch number --> Batch 
group number

4th August, 2010 Added component attributes to support DXAvanced firmware 
version 4.11, R3.01.01
Component attribute added: �Batch name components, 

Communication input components, 
Modbus in components
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1.1	 Overview

DAQStudio is the software for the creation original monitor screens displaying measuring 
data of DX1000/DX1000N/DX2000 (hereinafter called DX). For monitoring of measuring 
data, it is possible to assign channels to digital parts, trend parts, etc., and diagram 
components can be used to create monitor screens matched to site images. 
Created monitor screens can be displayed by custom display function of the DX recorder.
It is also possible to receive custom display screen data from the DX recorder and to 
edit them or to send display data created with DAQStudio to the DX recorder. Data 
transmission and reception can be performed via Ethernet or external storage media (CF 
cards). 

		

Ethernet

PCDX(Installing a CF Card)

CF Card

DAQStudio

Receiving display data, settings files, 
and bitmap files

Sending display data and bitmap files

Saving display data and 

bitmap files

Reading display data, settings 

files, and bitmap filesSav
ing disp
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Internal1.CDC to Internal3.CDC
External1.CDC to External25.CDC
Bitmap file (.bmp)
Settings file (Setting.CDS)

Internal1.CDC to Internal3.CDC
External1.CDC to External25.CDC
Bitmap file (.bmp)
Settings file (Setting.CDS)

Settings files contain DX recorder settings that have been converted to data. When 
receiving screen data from the DX recorder, screen data and bitmap files are received 
together. By receiving settings files, the DX recorder’s setups can be reproduced on 
DAQStudio.

Monitor Screen Creation Examples 

		  	

A screen is composed of multiple parts, and background setting and display of static 
bitmap images also can be done. 
Multiple parts can be related to each other, and parts can be combined with other parts. 
Measuring channels are allotted to parts. Size, character font, color, unit, group control, 
and other attributes are set for each created part. 
Parts can be laid out freely in the screen display area at screen grid intervals.

Chapter 1	 Before Using the DAQStudio
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Note
•	 Monitor screens are displayed correctly only when the language kind of the DX recorder and 

the language kind of DAQStudio are the same.
•	 As screens being created with DAQStudio cannot display measuring values, the display 

differs from the custom display execution screen of the DX recorder. 
•	 DAQStudio cannot open a connection with the DX recorder if the DX is already 

communicating with another software program. 

Creating and Saving Screens
An original monitor screen can be created newly or it can be created by receiving display 
data from the DX recorder and editing them with DAQStudio. The display data from the 
DX recorder can be retrieved via Ethernet or display data of the DX recorder saved to 
external storage media (CF card) can be read in. 
Edited or created display data are stored on the hard disk of the computer or external 
storage media (CF card) and are sent to the DX recorder.

1.1  Overview
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Monitor Screen Creation Flow
The monitor screen creation flow is shown below. 

		

Receiving display data from 
DX recorder

Opening display data

Editing

Starting DAQStudio

Sending display data to 
the DX recorder

Exiting DAQStudio

Selecting the DX recorder type, 
firmware version, and batch 
function

Setting the parts movement interval

Creating parts

Copying or deleting parts

Setting parts attributes

Changing parts arrangement and 
background

Assigning channels, alarms, 
groups, batch groups, and 
bitmaps to components. 

Saving display data

For creating a new display dataFor editing of existing display data

►Section 2.1

►Section 2.4

►Section 2.4

►Section 2.7

►Section 2.10

►Section 2.12

►Section 2.9

►Section 2.11, 2.12

►Section 2.12

►Section 4.2

►Section 2.1

►Section 4.1

►Section 2.5

1.1  Overview
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1.2	 PC System Requirements

PC System
•	 Supported Operating Systems (OS)
	 Run DAQStudio under any of the following operating systems.

•	 Windows XP Home Edition SP3
•	 Windows XP Professional SP3 (excluding Windows XP Professional x64 Edition)
•	 Windows Vista Home Premium, SP1, SP2 (excluding the 64-bit edition)
•	 Windows Vista Business, SP1, SP2 (excluding the 64-bit edition)
•	 Windows 7 Home Premium (32-bit and 64-bit editions)
•	 Windows 7 Professional (32-bit and 64-bit editions)

	 The language displayed by the software under different language versions of the OS 
are as follows.
OS Language Software Language
Japanese Japanese
English English
Chinese Chinese
German German
French French
Russian Russian
Korean Korean

•	 PC
	 Machine type
	 A PC that runs one of the OS above, and that meets the following CPU and memory 

requirements.
	 CPU and main memory capacity
	 When Using Windows XP
	 Pentium 4, 1.6 GHz or faster Intel x64 or x86 processor
	 512 MB or more of memory 
	 When Using Windows Vista
	 Pentium 4, 3 GHz or faster Intel x64 or x86 processor
	 2 GB or more of memory
	 When Using Windows 7
	 32-bit edition: Intel Pentium 4, 3 GHz or faster x64 or x86 processor,	 2 GB or more of 

memory
	 64-bit edition: Intel x64 processor that is equivalent to Intel Pentium 4, 3 GHz or faster 

, 2 GB or more of memory

•	 Hard disk
	 Free disk space: 100 MB or more

•	 CD-ROM Drive (for Use during Installation)

•	 Mouse
	 Mouse supported by the OS

•	 Monitor
	 A video card that is recommended for the OS and a display that is supported by the 

OS, has a resolution of 1024×768 or higher, and that can show 65,536 colors (16-bit, 
high color) or more.

•	 Communication Port
	 Ethernet port (10Base-T) supported by the OS. Also, TCP/IP protocol is required to be 

installed.
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2.1	 Starting/Exiting DAQStudio

Starting DAQStudio
Procedure

From the Start menu select All Programs > DAQStudio > DAQStudio. 
The main screen of DAQStudio appears. 

Display list 
area

Work area
Channel list
Batch/group list
Bitmap list

Tool bar
Menu bar

Screen sizeArrangement bar

Components bar
Display name

Screen construction area

Attribute area

List area 
spreader

Screen version

Mouse coordinates

Status area

 

Explanation
The Main screen is composed of Menu bar, Tool bar, Display list area, Channel/Alarm list 
area, Components bar, Attribute area, Arrangement bar, and Screen construction area. 
The main screen size is fixed. The DX2000 screen is displayed as the initial value. Refer 
to Section 2.2 for details of each component in the Main screen. ►Section 2.2

The following settings are active upon startup. 
•	 Batch function is OFF
•	 Channel/Alarm list page displayed
•	 The Group list page is displayed, but not the Batch/Group list page
For the display when receiving screen data from the DX recorder ►Section  4.1

When creating a new screen, you can set the DX recorder version and batch. ►Section 2.4

Chapter 2	 Creating a Monitor Screen with DAQStudio
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Exiting DAQStudio
Procedure

1.	 Select File > Exit from the menu bar or click the “×” mark at the right top of the 
Main screen. 

					      

2.	 Exit from DAQStudio is made when there is no screen being edited. 
If there is a screen being edited, a dialog message confirming whether the screen is to be 
saved or not is displayed. 

					      

3.	 Click [Yes] or [No]. (Exit operation is cancelled when [Cancel] is clicked.)

2.1  Starting/Exiting DAQStudio
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2.2	 Explanation of the Main Screen of DAQStudio

The configuration of the Main screen of DAQStudio is shown below.

Display list 
area

Work area
Channel list
Batch/group list
Bitmap list

Tool bar
Menu bar

Screen sizeArrangement bar

Components bar
Display name

Screen construction area

Attribute area

List area 
spreader

Screen version

Mouse coordinates

Status area

 

The icon names of each bar are shown below. Refer to Section 2.3 for the icon functions 
and the shortcut keys.

Menu bar 
This is composed of File, Edit, View, Screen, Communication, and Help. 

		

Tool bar 

		

New
Open

Save
Add display

Cut
Copy

Past
Undo

Redo

Receive
Send

Version

 



2-4 IM 04L41B01-62EN

Component bar
The components that are available change when you switch the screen version. 

Comm. In
Group name*

System icon*
Memory bar*

Time label*
Batch group number*

Batch name*
Modbus In*

*Not displayed with screen version 3. 

Edit
Line

Rectangle
Circle

Label
Simple digital

Digital
Simple bar

Bar
Trend

Unit
SpanU

SpanL
Alarm indicator

Comment box

TagNo.

TagComment

Message list

Bitmap
Alarm list

Comment block
Switch
Push button

 

Arrangement bar

		

Distribute vertically
Distribute horizontally

Left
Horizontal Center

Right

Bottom
Vertical Center

Top To Bottom

To Back
To Front

High
Wide

To Top

 

2.2  Explanation of the Main Screen of DAQStudio
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Display list area

		

List of display names displayed at the time of start

Displays display names from No. 4 to No. 28 
When a display name is clicked, the display 
of the Screen construction area changes. 

 

When a display name in the list is clicked or the up and down arrow keys (↑, ↓) of 
the keyboard are pressed to select a screen, the screen is displayed in the screen 
construction area. 
When a display name is selected, display editing (Copy, Cut, Paste, Delete) can be done 
in the display list area. 
When a location outside the Display list area is selected, editing of the Screen 
construction area becomes possible. 
Refer to Section 2.10 for the operation procedure. 
The initial setting at the time of start is for display of blank data for the display names 
Display1 to Display3. 

Work area
The work area contains the tabs below. When screen data is received from the DX 
recorder, the lists that are displayed vary depending on the information in the settings 
file. 
•	 Channel/Alarm list
	 Channels or alarms can be assigned to components for channel assignment. 

		

List area spreader

The alarm information is displayed when clicked.
Channel No., Tag No. or Tag comment

Alarm information
The alarm information is hidden when clicked.

Status without Alarm setting (Gray)

Status with Alarm setting (Green)

 

The Channel/Alarm information set at the DX recorder is displayed as Channel No., Tag 
No. or Tag Comment. At this time, the alarm information is included. 
Switching of the display format can be selected from the View menu. 
When the mouse pointer is placed onto the list area spreader, the mouse pointer 
changes to an arrow shape. By dragging, the View area can be increased or decreased 
vertically. 
The initial settings for the Main screen at the creating a new screen are shown below. 
In case of DX1000: 	�Channels “CH001” to “CH012” and calculation channels “CH101” to 

“CH124” are displayed. 
In case of DX2000: 	�Channels “CH001” to “CH048”, calculation channels “CH101” 

to “CH160”, and expansion channels “CH201” to “CH440” are 
displayed.

2.2  Explanation of the Main Screen of DAQStudio
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Batch/Group list, or Group list
	 Shows the batches and groups, and enables assignment of batch or group to 

components. If MultiBatch is On on the DX recorder the Batch/Group list is displayed, 
and if Batch is turned Off or On, the Group list is displayed. 
	 Components to which batch items can be assigned:	� Alarm list, Message list, 

Batch group number, 
Batch name, Memory bar

	 Components to which groups can be assigned:		 Trend, Scale, Group name

				  

Batch/Group list Group list

Click to hide the batch group numbers

Drag onto a component to assign

Click to show the batch group numbers

Batch group numbers used

Groups used
Drag onto a component 
to assign

Batch and Group display range
Type Batch Group
DX1000 [Batch 01] to [Batch 06] [Group 01] to [Group 06]
DX2000 DX2000 [Batch 01] to [Batch 12] [Group 01] to [Group 12]

The maximum batch number is the number of multibatches recorded in the DX recorder 
settings file. 

Group display range
Type Group
DX1000 [Group 01] to [Group 10]
DX2000 [Group 01] to [Group 36]

2.2  Explanation of the Main Screen of DAQStudio



2-7IM 04L41B01-62EN

1

2

3

4

5

Index

C
reating a M

onitor Screen w
ith D

A
Q

Studio

•	 Bitmap list
	 Displays data from the bitmap folder in a list. Bitmaps can be assigned to bitmap 

components and scale components. 
	 Bitmap folder:	  �Bitmap files used by DAQStudio must be placed in a single location. 

This specific folder is called the bitmap folder. 
	 Components to which bitmaps can be assigned:	  �Bitmap, scale

				  

Drag the bitmap onto a component to assign

Bitmap file name

	 Only data that can be displayed by DX recorder is shown in the bitmap list. Only 
bitmaps meeting the following criteria can be displayed by the DX recorder.
•	 640 x 480 dots (WxH) or less. 
•	 256 colors or less, uncompressed. 
•	 The name of the bitmap file, including extension, may not exceed 51 characters. 

	 The list is sorted in order by the character code of the bitmap file name. Immediately 
after starting DAQStudio, creating a new screen, or receiving screen data from the DX 
recorder, the bitmap folder is placed in the following location. 
Windows XP

[Drv]:\Documents and Settings\[user name]\Application Data\DAQStudio 
Windows Vista or Windows 7

[Drv]:\Users\[user name]\AppData\Roaming\DAQStudio.
Where [Drv] is the drive on which the OS was installed. 
Where [user name] is the name of the user who is using the OS.

	 Immediately after a file is saved, or immediately after a file is opened, the bitmap 
folder becomes the target folder for saving screen construction files. 

	 Immediately after startup, or immediately after a new file is created, the bitmap folder 
is cleared. 

	 Updating the bitmap list 
	 The bitmap list is updated immediately after startup, immediately after a new file 

is created, immediately after opening a file, immediately after saving a file, and 
immediately after receiving screen data from the DX recorder. 

	 Also, if you specify a folder and bitmap in the attributes of bitmap components and 
scale components, the specified data is copied to the bitmap folder. Immediately 
thereafter, the bitmap list is updated. 

2.2  Explanation of the Main Screen of DAQStudio
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Screen Construction Area
In the screen construction area, there is a Version 3 screen, a Version 4.01 screen and a 
Version 4.11 screen.
In the Version 4.01 screen and the Version 4.11 screen, the screen construction area is 
larger if the status area is set to No display.

Screen size
DX1000: 320 x 240 pixels
DX2000: 640 x 480 pixels

X-coordinate

Y-
co

or
di

na
te

DX1000 (320, 240)
DX2000 (640, 480)

Screen construction area
When the status area is set 
to No display, the screen 
construction area becomes 
larger.

Screen version
Status area

Mouse pointer coordinate

Coordinate origin (0,0). In Version 4.01 and Version 4.11, this is the starting point 
for plotting when the status area is set to No display.

DX1000 (0, 24)
DX2000 (0, 40)

 

The initial setting at the time of start is display of the DX2000 screen. 

2.2  Explanation of the Main Screen of DAQStudio
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2.3	 Explanation of Menus, Icons, and Shortcut 
Keys

Menu bar contents, icons, and shortcut keys are shown in a list. 
The icons are arranged on the Tool bar and on the Arrangement bar. 

File menu
Menu name Icon Shortcut keys Explanation
File – – –
New  Ctrl+N All present screens are discarded and a new screen is 

created. 
Open  Ctrl+O A screen construction file is loaded.

Save  Ctrl+S A screen construction file is saved to the save folder by 
overwriting. 

Save as – – A save folder is specified and the screen construction file is 
saved to that folder. 

Exit – – The application is exited. 

Edit menu
Menu name Icon Shortcut keys Explanation
Edit – –
Undo Ctrl+Z Undoes the previous edit operation. 
Redo Ctrl+Y Redoes the undone edit operation. 
Cut  Ctrl+X The object is moved to the clipboard. 

Copy  Ctrl+C The object is copied to the clipboard. 

Past  Ctrl+V The object is copied from the clipboard and moved to the 
specified location. 

Select All – Ctrl+A All components in the Screen construction area are selected.
Delete – Delete The object is deleted. 
Add Display – – A new screen is added to the display list 

View menu
Menu name Icon Shortcut keys Explanation
View – – –
Channel – – The Channel No. is displayed in the Channel list. 
TagNo. – – The Tag No. is displayed in the Channel list. 
TagComment – – The Tag Comment is displayed in the Channel list.
Grid – – The Grid interval is displayed.

View – Grid menu
Menu name Icon Shortcut keys Explanation
1Dot – – The screen grid interval is set to 1 dot. 
5Dot – – The screen grid interval is set to 5 dots. 
10Dot – – The screen grid interval is set to 10 dots. 
20Dot – – The screen grid interval is set to 20 dots. 
50Dot – – The screen grid interval is set to 50 dots. 

Screen menu
Menu name Icon Shortcut keys Explanation
Screen – – –
Version 3(3) – – Sets the screen version to Version 3.
Version 4.01(0) – – Sets the screen version to Version 4.01.
Version 4.11(1) – – Sets the screen version to Version 4.11.
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Arrangement menu
Menu name Icon Shortcut keys Explanation
Arrangement – – –
Left

 
– The left edge of the selected component is arranged aligned 

with the left edge of the reference component. 
Horizontal 
Center  

– The center in horizontal direction of the selected component 
is arranged aligned with the center in horizontal direction of 
the reference component.

Right
 

– The right edge of the selected component is arranged aligned 
with the right edge of the reference component. 

Top
 

– The top edge of the selected component is arranged aligned 
with the top edge of the reference component. 

Vertical Center
 

– The center in vertical direction of the selected component is 
arranged aligned with the center in vertical direction of the 
reference component.

Bottom
 

– The bottom edge of the selected components are aligned with 
the reference component.

Distribute 
horizontally

– The selected components are distributed proportionally in the 
horizontal direction. 

Distribute 
vertically

– The selected components are distributed proportionally in the 
vertical direction. 

Height
 

– The height of the selected component is matched to the 
height of the reference component.

Width
 

– The width of the selected component is matched to the width 
of the reference component.

To Top
 

– The selected component is arranged for display on the 
foremost plane. 

To Bottom
 

– The selected component is arranged for display on the 
rearmost plane. 

To Front
 

– The selected component is arranged for display one plane to 
the front. 

To Back
 

– The selected component is arranged for display one plane to 
the rear. 

Communication menu 
Menu name Icon Shortcut keys Explanation
Communication – – –
Receive  – A screen construction file is received from the DX recorder. 

Send  – A screen construction file is sent to the DX recorder. 

Help menu
Menu name Icon Shortcut keys Explanation
Help – – –
User’s manual (I) – F1 Displays the user’s manual.
About  – The About dialog is displayed. 

2.3  Explanation of Menus, Icons, and Shortcut Keys
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2.4	 Creating New Screens, Setting the Grid 
Interval, and Switching the Screen Version

When creating a new screen, you can set the DX recorder type, screen version, and 
batch, and set the grid interval. The DX recorder settings that can be entered when 
creating a new screen are limited to the type, DX recorder version, and batch. Because 
the DX recorder settings file is also received when receiving custom display screen data 
from the DX recorder, you can edit and create screens starting from the setting conditions 
of the DX recorder to which you connect. 

Specifying the type, DX recorder version, and batch
Specify DX1000 or DX2000 as the target type for the screen data, specify the DX 
recorder version, and specify a batch setting of On, Off, or MultiBatch.

Procedure
1.	 Select File > New from the menu bar or click the New icon. 

The New dialog box appears.  
The initially set screen is “DX2000.”
The initially set screen is [DX2000], [Version 4.11], and [Batch Off]. 

					      

2.	 Select the type, DX recorder version, and batch, then click [OK].
OK: 	� The displayed display data are discarded and a new screen is created. 

The size of the screen construction area for the selected model is dis-
played. 

Cancel: 	 Return to the Main screen. 

Explanation
When creating a new screen, specify the type, DX recorder version, and batch. The 
version of the DX recorder you can connect to differs depending on the recorder version 
set here. See “Switching the Screen Version” in this section. When creating a new 
screen, the Channel/Alarm list page appears in the work area. When creating a new 
screen, if MultiBatch is selected under Batch, the Batch/Group list page appears in the 
work area, and the Group list page is not displayed. When creating a new screen, if On 
or Off is selected under Batch, the Group list page appears in the work area, and the 
Batch/Group list page is not displayed.
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Grid setting
Procedure

1.	 Select View > Grid from the menu bar.

2.	 Specify the screen grid.

					      

Explanation
Components can be moved in grid intervals. When components are moved, they can be 
arranged in a condition with the left apex contacting the grid.

The screen construction area

Screen size
DX1000: 320 x 240 pixels
DX2000: 640 x 480 pixels

X-coordinate

Y-
co

or
di

na
te

DX1000 (320, 240)
DX2000 (640, 480)

Screen construction area
When the status area is set 
to No display, the screen 
construction area becomes 
larger.

Screen version
Status area

Mouse pointer coordinate

Coordinate origin (0,0). In Version 4.01 and Version 4.11, this is the starting point 
for plotting when the status area is set to No display.

DX1000 (0, 24)
DX2000 (0, 40)

2.4  Creating New Screens, Setting the Grid Interval, and Switching the Screen Version
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Switching the screen version
Procedure

1. On the menu bar, click Screen > Version3, Version 4.01, or Version 4.11
The screen version switches accordingly. 

				  

Explanation
The version of the DX recorder you can connect to differs depending on the DAQStudio 
screen version. See the table below. 
Screen version and DX recorder release number
Screen version Version number of compatible DX recorder 
Version 3 3.01, 3.02, 3.03, 3.04
Version 4.01 4.01, 4.02
Version 4.11 4.11

Please take note that switching the screen version between Version 3, Version 4.01, 
and Version 4.11 can result in incompatible component attribute settings or unsupported 
components. If switching from a Version3 screen to a Version 4.01 screen, or a Version 
4.11 screen, and switching from a Version 4.01 screen to a Version 4.11 screen, the 
number of setting items for component attributes increases. The added component 
attributes are set to their defaults. 
►Section 5.3

2.4  Creating New Screens, Setting the Grid Interval, and Switching the Screen Version
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Screen version and DX recorder version data compatibility
DAQStudio R3.01.01 is compatible with screen construction files from DX recorder 
versions 3.01, 3.02, 3.03, 3.04, 4.01, 4.02, and 4.11 
•	 Communication with an 3.01, 3.02, 3.03, and 3.04 DX recorder is only available when 

displaying Version3 screens. 
•	 Writing to a Version 3 screen construction file is only possible when displaying Version 

3 screens. 
•	 Communication with an 4.01 or 4.02 DX recorder is only available when displaying 

Version 4.01 screens. 
•	 Writing to a Version 4.01 screen construction file is only possible when displaying 

Version 4.01 screens. 
•	 Communication with an 4.11 DX recorder is only available when displaying Version 4.11 

screens. 
•	 Writing to a Version 4.11 screen construction file is only possible when displaying 

Version 4.11 screens.

		

Send/Write

Send/Write

Receive

Receive

DAQStudio DXAdvanced 3.01, 3.02, 

                       3.03, 3.04

DXAdvanced 4.01, 4.02
Switch

Screen data

Screen data

Screen data and 
settings files

Screen data and 
settings files

DXAdvanced 4.11Screen data

Screen data and 
settings files

Send/Write

Receive

Switch

Switch

2.4  Creating New Screens, Setting the Grid Interval, and Switching the Screen Version
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2.5	 Open/Save a File

Open a file
Procedure

1.	 Select File > Open from the menu bar or click the Open icon.
The Open dialog box appears.

					      

2.	 Specify the file location and the file name and click [Open].
When a screen being created is displayed, the following message appears. 

					      

3.	 Click [OK] if it is OK to discard the present screen. 
The screen construction data are displayed. 

	 Click [Cancel] if you do not want to discard the present screen. 
File opening is cancelled and return is made to the Main screen.  

Explanation
The file names handled by this software are “Internal1.cdc” to “Internal3.cdc” and 
“External1.cdc” to “External25.cdc.” 
When a file is specified, all files with the above names are opened in the folder where 
that files is located. 
When a file is opened, the display name of the opened file is displayed in the display list 
area. The display name can be changed on the attribute of the display (►Section 3.1).
When a display data is received from a DX recorder (►Section 4.2), the display name 
defined on the DX recorder is displayed in the display list area. 

The save destination folder of the opened file becomes the save object folder. When a 
different file is opened, the save object folder becomes the folder of the opened file. 
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Save a file
Procedure

Saving a file by specifying a folder
1.	 Select File > Save as from the menu bar. 

The Browse for Folder dialog box appears.

					      

2.	 Specify a folder or click the [New folder] button to create a folder. 

	 If the [New folder] button has been clicked, enter a name for the new folder. 

Note
•	 Network folders or compressed folders cannot be specified at the time of saving a display 

data.
•	 Newly created display data must be saved. Bitmap files assigned for components need to 

be saved in the same folder that the display data will be saved.
•	 The display data or bitmap file must be saved every time they have been received from DX 

recorder.

3.	 Click [OK]. 
The data are saved.

Saving a file by overwriting
	 Select File > Save from the menu bar or click the Save icon.

In an already existing folder, the data will be saved by overwriting. If a new folder is 
specified, the new folder becomes the target folder for saving files. 

Explanation
When the file save folder is specified, the entire information of the Display list area is 
saved. The file name at the time of saving is as shown below.

Display names in the Display list area at the initial setting* The file name when 
the file was saved 

Display1 INTERNAL1.cdc
Display2 INTERNAL2.cdc
Display3 INTERNAL3.cdc
-4- �(Display4: when adding a new data, “Copy”+ display name: of the copy source) EXTERNAL1.cdc
-5- �(Display5: when adding a new data, “Copy”+ display name: of the copy source) EXTERNAL2.cdc
• • • • • •
-27- �(Display27: when adding a new data, “Copy”+ display name: of the copy source) EXTERNAL24.cdc
-28- �(Display28: when adding a new data, “Copy”+ display name: of the copy source) EXTERNAL25.cdc

*	 The display name can be changed on the attribute of the display (►Section 3.1). When a 
new display data is added (►Section 2.6) or copied from an existing display data (►Section 
2.10), the display data file is saved to the list item number 4 or later.

If the file name is changed to file name other than shown above, the display data cannot 
be sent to the DX recorder. 

2.5  Open/Save a File
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2.6	 Adding a Display

Procedure
1.	 Click the Display name in the display list area. 

Now the Add Display icon of the Tool bar can be selected. 

 

2.	 Select Edit > Add Display from the menu bar or click Add Display icon. 

					      

The screen for DX1000 or DX2000 is displayed. 

 

3.	 Specify DX recorder firmware version (►Section 2.4), and create the screen.

Note
The screens in the display list cannot be of different screen versions. If you switch the screen 
that you have added (or another screen on the display list) to an earlier version, all the screens 
on the display list will be switched to the earlier version. Any components that are not supported 
by the earlier screen version will be deleted.
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2.7	 Creating Components

Procedure
1.	 On the Components bar, click the icon for the component to be created.

2.	 Place the mouse pointer in the screen construction area and drag it. 
A component with the dragged size is created. 

					   

3.	 Click the component.
The attributes of the selected components are displayed in the Attribute area. 

					   

ID numbers are allotted in the order 
of creation. 
The ID number differs depending 
on the kind of component. 
(Refer to Section 3.2.) 

Component type

 

4.	 Set each attribute item. 

	 For details, refer to Chapter 3. 
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Explanation
Notes on Creating Components

After creating components aligned to the grid, if placed adjacent to each other they 
overlap by 1 dot even though they do not appear to overlap. Separate components from 
each other by at least 1 dot. 

Display When Components Overlap on the Execution Screen
Limitations (A, B, and C) apply when components overlap on the execution screen. If 
components with the same overlap restriction are overlapping, components placed under 
the front component (i.e., in the background) are not displayed.

Overlap 
restriction

Component name (attribute conditions)

None Digital, bar, scale (kind: OFF), label, tag No., tag comment, simple digital, simple 
bar graph, alarm mark, units, alarm indicator, span lower limit, span upper limit, 
line, rectangle, circle, push button, switch, comment box, comment block, Comm 
In, Group name, System icon, Memory bar, Time label, Batch group number, 
Batch name, Modbus In 

A Scale (kind: ON)
Alarm list
Message list

B Scale (kind: bitmap), bitmap
C Trend

For example, if two components with Overlap restriction A are overlapping on the builder 
screen, only the front component is displayed on the custom display execution screen of 
the DX recorder.

		
FrontBack

2.7  Creating Components
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Explanation of the Components 
The icons of the component bar are explained. 

Component type Component name Icon Explanation
– Edit  When the Edit icon is clicked, the components of the Screen 

construction area can be selected. 
Diagram components Line  Create a straight line connecting any two points. 

Rectangle  Create a rectangle with any dragged points at opposite 
corners. 

Circle  Create a circle in a square with any dragged points at 
opposite corners. 

Components for 
channel assignment

Simple digital  Create simple digital components displaying digital values 
of specified channels. 

Digital  Create components displaying digital values with Tag 
Comment/Tag No./Channel No., Unit, and Alarm indicator.

Simple bar
 

Create simple bar components displaying a bar of a 
specified channel.

Bar
 

Create components with tag comment, tag/tag No./channel 
No., unit, and digital value added to a simple bar. 

TagNo.
 

Create a component displaying the tag No. of a specified 
channel. 

TagComment
 

Create a component displaying the tag comment of a 
specified channel.

Unit  Create a component displaying the unit of a specified 
channel. 

SpanU
 

Create a component displaying the upper limit value for the 
span of a specified channel. 

SpanL
 

Create a component displaying the lower limit value for the 
span of a specified channel. 

Alarm indicator  Create a component displaying the alarm level of a specified 
level, a specified channel.

Status display 
component

Group name Create a component displaying a group name.

System icon Create a component displaying a system icon.
The kinds of system icon are: Memory sample, Alarm, 
CF card, Math, Key lock, Email, Status, Key lock & email, 
UserLock, and UserLock & status. 

Memory bar Create a component displaying the progress of memory 
sampling. 

Time label Create a component displaying the current date and time. 

Batch group number Create a component displaying the MultiBatch batch group 
number. 

Batch name Create a component displaying the batch name. 

Label components Label  Create a label displaying an arbitrary text string. 

Components with 
action functions

Push button  Create a push button. 

Switch display
 

Create a switch component displaying the state of an 
internal switch and performing ON/OFF switching of the 
internal switch by operation.

Comm In  Create a component displaying the value of specified 
communication input data and writing values as 
communication input data.

Modbus In Create a component that displays the input value of the 
communication channel set by the specified send command 
number, or that writes temperature controller and other SP 
values.

Continued on the next page

2.7  Creating Components
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Component type Component name Icon Explanation
Components for 
comment display

Comment box  Create a component displaying a text string set at the DX 
recorder.

Comment block
 

Create a component displaying a comment block text string 
set at the DX recorder

Components for list 
display

Alarm list
 

Create a component displaying an alarm list. 

Message list
 

Create a component displaying a message list.

Scale components Scale
 

Create a scale component displaying a scale plate used 
together with trend display.

Components for trend 
display

Trend
 

Create a trend component displaying the trend of a specified 
group.

Components for static 
image display

Bitmap  Create a component displaying a static screen in bitmap 
format.

Component attributes
Refer to Chapter 3 for the creation number of components, the setting contents of 
attributes, and the initial values. 

2.7  Creating Components
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2.8	 Components Explanation and Creation 
Examples

This section shows creation examples for components. Components created with 
DAQStudio and components of the custom display execution screen of the DX recorder 
differ in the display of measuring data, alarm display, etc. The components creation 
examples are a mix of components created with DAQStudio and those of the custom 
display execution screen of the DX recorder. 

For components other than lines, the upper left apex of the component is the origin for 
positioning on the grid, and the lower right apex is positioned at (origin - 1 dot).
For components that enable text label entry, any characters entered exceeding the 
maximum allowed number are deleted. 

Diagram Components
Line

		
You can draw a line going in the left/right or up/down direction from an origin.Origin

 

If the start and end points overlap, 1 dot of space along the X axis is inserted. Start and 
end points are positioned on the grid. 

Rectangle

		

Origin

You can draw a rectangle from an origin toward the lower right.

Background color  

Circle
Origin

A circle contacting a square 
from the inside is drawn.

Background color

A circle is drawn by dragging from a point of origin.

Even when a rectangle is specified, 
a circle is drawn, but an ellipse 
cannot be drawn.  

Components for Channel Assignment
Restrictions on channel assignments
The measured value of the assigned channel is displayed in the DX recorder execution 
panel.
With the Math (/M1) and PROFIBUS-DP (/CP1) options, PROFIBUS-DP always uses the 
communication input channels in the table below. The channels in the table below cannot 
be assigned using DAQStudio. 

Channels used with the /M1 and /CP1 option
Type Communication input channels used
DX1000 C01 to C24 (all)
DX2000 C01 to C32

Simple digital 
The digital value of the specified channel is displayed. 

		  Digital value 
***** is displayed with DAQStudio. 

Simple digital display area (Frame: Sunken)
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Digital
Tag comment/tag No./channel No. of the measuring channel, unit, alarm indicator, and 
digital value are displayed.

		

Unit

Alarm display mark

Digital value 
***** is displayed with DAQStudio. 

Tag No. / Tag (Tag comment) / Channel No.

 

Simple bar graph
Bar graph and alarm mark are displayed.

		

Direction: Vertical

Direction: Horizontal

Background
color: White

 

Bar graph
Bar graph, tag comment/tag No./channel No., alarm indicator, span, tag comment, alarm 
mark, unit, and digital value are displayed.

		

Direction: Vertical

Direction: Horizontal

Digital value (only vertical)
Measured data is displayed on a custom display execution 
screen of a DX recorder.

Unit (only vertical)

Alarm set-point mark

Span value

Alarm display mark (only vertical)

Tag comment (only vertical) (Tag No.: On)

Tag / Channel No. (only vertical) (Tag No.: Off)
Tag No. / Channel No. (only vertical) (Tag No.: On)

 

2.8  Components Explanation and Creation Examples
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Tag No. 
The tag No. of the specified channel is displayed.

		

Vertical display 
(can be set only in Version 4.01 screen
                         and Version 4.11 screen)Tag No. display area

Tag No. (string)
 

Tag comment 
Display of the tag comments of the specified channel 

		

Vertical display 
(can be set only in Version 4.01 screen
                         and Version 4.11 screen)Tag comment display area

Tag comment (string)
 

Unit 
The unit of the specified channel is displayed.

		
Unit display area

Unit (string)

Vertical display 
(can be set only in Version 4.01 screen
                         and Version 4.11 screen)

 

SpanU, SpanL 
The upper/lower limit value of the specified channel are displayed.

		

Vertical display 
(can be set only in Version 4.01 screen
                         and Version 4.11 screen)Span display area

Span lower limit / 
Span upper limit (string)

 

Alarm indicator 
The alarm status of the specified channel is displayed. Refer to the User’s Manual (IM 
04L41B01-01E or IM 04L42B01-01E) of the DX recorder for the alarm status matching 
text and display color. 

		
Alarm indictor display area

Alarm kind display
 

2.8  Components Explanation and Creation Examples
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Status display components (can only be set with a Version 4.01 screen and a 
Version 4.11 screen)

Group name
This component displays the group name corresponding to the specified group number. 
You can create this group name component when you want to display components from 
multiple groups, or if setting the status area to No display eliminates the group name. 

		

Group name

Component area

If you set Change group to On in the attribute 
settings, the group name changes when you press 
the left/right arrow keys on the execution panel. 

Vertical display

System icon
Creates a system icon for display in the status area. You can create icons that display 
only the items you wish in the screen, for use when not displaying the status area.

		

Component frame

The size of the icon 
component frame is set 
under Icon size in the 
attribute settings. 

Memory sample
Alarm

CF card
Math

Key Lock

Email
Status

Key lock & email
User Lock

UserLock & status

Memory bar
This component appears in the status area and shows the progress of memory sampling. 
The width of the memory bar component frame represents the file save interval (display 
data) or data length (event data), and shows the remaining time for memory sampling. 

		

File save interval (for display data), 
or data length (for event data)

Background
Bar

Remaining memory sample time 
For event data, the status is displayed as a text label. 
This is not displayed on DX recorders with the /AS1 option.

Time label
This component displays the current date and time. 
You can create this Date and time component if setting the status area to No display 
eliminates the date and time. 

		  Time

Background

Date

Vertical display

2.8  Components Explanation and Creation Examples
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Batch group number
This component displays the batch group number for MultiBatch. 
You can create this Batch group number component if setting the status area to No 
display eliminates the batch group number. The Batch group number component can 
only be created when the DX recorder is set to use the MultiBatch feature.

		
Batch group number

Background
Vertical display

Batch name
This component displays the batch name. 
You can create this Batch name component if setting the status area to No display 
eliminates the batch name. 
The component displays the batch name, batch number, and lot number separated 
by hyphens. When the width of text exceeds component width, the text wraps at the 
component width. 
The batch and lot numbers shown in the component are the ones in the dialog box that 
appear on the DX recorder when you press the FUNC key followed by the Batch soft 
key. 
When Batch is Off, batch name components cannot be created and their attributes 
cannot be edited. 

		

Vertical displayBatch name

Background

Lot number
Batch number

Label components
Label 
Display text.
You can double-click a component to directly input a text label. After directly inputting a 
text label, press the Enter key or click anywhere outside the component. 
The width of the text label entry is the same as that of the component. 

		

Label display area
Vertical display 
(can be set only in Version 4.01 screen
                         and Version 4.11 screen)

Label (string)

Text label direct input

 

Note
Text may be displayed as blank (space), depending on the font setting. Refer to Section 3.3 for 
the character types provided for each font (character size).

2.8  Components Explanation and Creation Examples
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Components with action functions
Action functions operate on the custom display execution screen of the DX recorder.

Push button
Display a push button. This has no action function on the builder screen of the DX 
recorder, and on the custom display execution screen it functions as a push button. (select 
the event switch number in the component attributes.)
When a component is selected on the execution screen of the DX recorder by pressing 
the up and down arrow keys and then the DISP/ENTER key is pressed, the set action 
is executed. 
You can double-click a component to directly input a text label. After directly inputting a 
text label, press the Enter key or click anywhere outside the component. 
The width of the text label entry is the same as that of the component. 

		   

Background color

String

Event edge switch
1

0
Action execution

Text label direct input

Switch
Display switch. The display format of a switch is selected by the item “Style” of the 
attributes. 
This has no action function on the builder screen of the DX recorder, and switch ON/OFF 
switching is possible on the custom display execution screen.
You can enter a text label directly by double-clicking the text label in the component. 
After directly inputting a text label, press the Enter key or click anywhere outside the 
component. 
The width of the text label entry is the same as that of the component. 

		

Text label direct input

Selector Seesaw Lever SlideX SlideY Push Power Connector Toggle

Switch On (DX recorder’s execution panel)

Switch Off

Off string

On string

String display Off

 

2.8  Components Explanation and Creation Examples
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Communication input 
This has no function on the builder screen of the DX recorder, and on the custom display 
execution screen, the value of the specified communication input data can be displayed 
and values can be entered to communication input data. 

		
Communication input value

Background color
 

Modbus In (can only be set with a Version 4.01 screen and a Version 4.11 
screen)
Displays the input value of the communication channel set using the specified send 
command number. If an action function is executed, numerical values can be entered 
from a DX recorder custom display, and the values can be written to the write destination 
(such as a temperature controller SP) set using the specified command number. 

		
Background

Modbus In value

Components for comment display
Comment box
The text corresponding to the comment box No. of the DX recorder is displayed.

		
Strings

Background color

 

Comment block
The text corresponding to the comment block No. of the DX recorder is displayed. 

		
Strings

Background color
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Components for list display 
Alarm list 
An alarm summary is displayed. 
Only the header is displayed on the builder screen of the DX recorder.

		

Header (quantity, title)

Alarm level and type
Tag comment, Tag No. or Channel No.
Alarm event type (mark and string)

 

Message list
A message summary is displayed. 
Only the header is displayed on the builder screen of the DX recorder.

		

Header (quantity, title)

Message string
Message mark

 

Components for trend display
Trend
The trend of the specified group is displayed. 
Only the grid is displayed on the builder screen of the DX recorder. 
When the time grid display is Off, the trend component time grids are not displayed. If 
margins are On, a margin of 3% of width is maintained on both sides of the component. 

		

Message mark

GRID time

Direction: Horizontal Direction: Vertical

Time interval: EveryGridTime interval: Alternate

Margin OnMargin Off 

Margin

 

2.8  Components Explanation and Creation Examples
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Scale display components
Scale
The scale of the specified group is displayed. 
Scale plate, scale value, and unit are displayed. 
The present value mark is displayed on the custom display execution screen of the DX 
recorder. 

		

Direction: Horizontal
Type: On

Direction: Vertical
Type: Off

Current position marks
Scale value

Unit
Scale
(Type: On)

Direction: Vertical
Type: On

Indicator type

Micro
Normal

Small
Balanced

No scale margin

With scale margin

Margin

 

Bitmap components can be assigned to scale components. 
If bitmap components overlap with scale components that display bitmap components, 
only the bitmap of the component in front is displayed. 
If alarm marks overlap, the alarm of highest level is brought to the front and displayed. 
If a bitmap file that is not supported by the DX recorder is specified for a scale 
component, an X appears in the component. 
If margins are On, a margin of 3% of width is maintained on both sides of the component. 

2.8  Components Explanation and Creation Examples
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Components for static image display
Bitmap
This component displays a bitmap file. 
If bitmap components overlap, only the one in front is displayed. 
If a bitmap file that is not supported by the DX recorder is specified, an X appears in the 
component. 

		

Bitmap display area

If the size of bitmap file read 
goes over the display area, 
the images out of the area 
will not be displayed.

 

Note
Conditions for bitmaps which can be read in 

•	 A format with up to 256 colors (even when less than 256 colors are used, they may not 
be read in depending on the format). 

•	 A size within 640 (width) x 480 (height) pixels (the file will not be read in even when only 
one dimension is exceeded). 

2.8  Components Explanation and Creation Examples
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2.9	 Assigning Channels, Alarms, Groups, Batch 
Groups, and Bitmaps to Components

Assigning a channel to a component
Procedure

1.	 Select the channel to be assigned in the channel/alarm list, drag it to the 
component, and drop it there. 
If a channel cannot be set, the mouse pointer displays “  .”

					      

If a channel can be set, the mouse pointer displays “  .”

					      

Explanation
Channel assignment is possible only for components for channel assignment.

Assigning an alarm to a component 
Procedure

1.	 Select the channel to be assigned in the channel/alarm list. 
The alarm level kind is displayed.

2.	 Select an alarm level. 

3.	 Drag the alarm to the object to which it is to be assigned and drop it there. 
The alarm is assigned.  
When an alarm is dragged to an object to which an alarm cannot be assigned, the mouse 
pointer displays “  .”

					   

When this is green, alarm On is set for the DX recorder. 

 

If an alarm can be set, the mouse pointer displays “  .” 

					      

Explanation
Alarms can be assigned only to alarm indicator components. 
Channel alarm numbers for measuring channels of the DX recorder with alarm set to On 
when custom display screen data are received from the DX recorder are green. 
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Assigning group numbers to components
Procedure

1.	 Drag the group you wish to assign from the Group list onto a component. Or, you 
can display the Group list within a batch group on the Batch list, then drag a group 
from that list onto a component. 
If a group cannot be set, [  ] appears next to the pointer. 

					   

					   

Click here to display a list of group names. 

If a group can be set, [  ] appears next to the pointer. 

					   

Explanation
Groups can be assigned to trends, scales, and group names. 

Assigning batch numbers to components (when MultiBatch is On)
Procedure

1. 	 On the Batch list, select a non-assigned batch
The batch group numbers are displayed in the list. 

2. 	 Select a desired group number, and drag it onto a component. 
If a group cannot be set, [  ] appears next to the pointer. 

					   

If a group can be set, [  ] appears next to the pointer. 

					   

Explanation
Batch group numbers can be assigned to Message lists, Alarm lists, Memory bars, Batch 
group numbers, and Batch names. 

2.9  Assigning Channels, Alarms, Groups, Batch Groups, and Bitmaps to Components
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Assigning bitmaps to components
Procedure

1.	 Drag a bitmap from the bitmap list

					   

2.	 Drop the bitmap onto a bitmap or scale component in the screen construction 
area. 
If the bitmap cannot be set, [  ] appears next to the pointer. 
If the bitmap can be set, [  ] appears next to the pointer. 

					   

For bitmap components, bitmaps assigned when [Disp. on editing] was set to On are 
displayed. 

					   

If the bitmap cannot be assigned to the component, an X appears in the component. 

					   

Explanation
Restrictions on assigning bitmaps to components
A maximum of 200 bitmap files can be displayed in the Bitmap list. When assigning 
bitmap components and scale components, only 200 bitmaps are shown no matter how 
many bitmap files you copy to the bitmap folder. 

Note
Bitmap file names created on a PC can become garbled when displayed on the DX. 
Supported characters ►Section 3.3

2.9  Assigning Channels, Alarms, Groups, Batch Groups, and Bitmaps to Components
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2.10	 Editing Components and the Screen

Selection and deselection of components, movement, magnification/contraction
Procedure

Selecting one component 
1.	 Click the Edit icon on the Components bar. 

2.	 Click a component to be selected.
The component becomes selected. A gray anchor point is displayed on the component. 

					   

Component
selection

Anchor point 

 

Selecting multiple components
1.	 Click the Edit icon on the Components bar. 

2.	 Click multiple components to be selected while depressing the SHIFT key or the 
Ctrl key. You can also drag the screen construction area and create a rectangle 
with a size to include all components to be selected. 
Multiple components are selected. A white and a gray anchor point are displayed on the 
component. A gray anchor point is displayed on the reference component.

				  

Anchor point of reference components

Anchor point of selected components

 

Cancellation of component selection
	 Click a selected component with the Shift key depressed. 

The anchor point of the component disappears and the selected status is cancelled. 

Making a component a reference component 
	 Click a component with a displayed white anchor point out of a group of selected 

components while keeping the Ctrl key pressed. 
The reference component is switched. 

Note
For circle and rectangle components, if the background attribute (►section 3.31 and 3.32) is 
set to [None], drag the component’s outline to move it. 
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Moving parts
1.	 Select one or several parts to be moved. 

2.	 Press the arrow keys (←↓→↑) on the keyboard to move them by one grid each. 
Selected components also can be moved by dragging them with the mouse 
pointer. 

					      

Magnifying/contracting components 
1.	 Click the Edit icon and then select a component. 

2.	 Move the mouse pointer onto the square anchor point displayed on the 
circumference of the selected component. 
The mouse pointer changes to an arrow. 

					      

3.	 Drag in direction of the arrow. 
The component is magnified/contracted. 

Note
Component magnification/contraction is not possible when multiple components are selected. 

2.10  Editing Components and the Screen
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Explanation
Reference component 
The anchor point of a reference component is displayed in gray. 
When multiple components are selected, the attributes of the reference component 
are displayed in the attribute area. This becomes the reference for rearrangement of 
components. 
When only one component is selected, that component becomes the reference 
component. When multiple components are selected, the component with the left top 
apex coordinates arranged most to the top left becomes the reference component (the 
Y-coordinate has priority). When the left top apex coordinates of components are the 
same, the component on the top plane becomes the reference component. 

		   

When the reference component of multiple selected components is deleted or the 
selection is cancelled, the anchor point of the component which becomes the reference 
component according to the above rule becomes gray. 

Moving components
If the reference component is a line component
The selected component cannot be moved beyond the border of the screen construction 
area. 
The upper left apex of a rectangle joined to a line component moves along the grid, but 
the other selected components retain their positions relative to the reference component 
as they move. 

If the reference component is not a line component
The selected component cannot be moved beyond the border of the screen construction 
area. 
The upper left apex of the reference component moves along the grid, but the other 
selected components retain their positions relative to the reference component as they 
move. 

Moving components with the keyboard arrow keys
After selecting a component with the mouse, you can press arrow keys on the keyboard 
to move the component within the screen construction area by grid intervals. (Not limited 
to being on the grid.)

Restrictions on zooming in/out on components
For line components
If the start and end points overlap, the end point is placed 1 dot along the X axis away 
from the start point. 

For components other than lines
The component’s minimum height and width is 2 dots. 
The upper left apex of the component is placed on the grid, and the lower right apex is 
positioned at (grid - 1). 

Display/No display of the status area
When switching the status area from [No display] to [Display], components overlapping 
the status area move into the screen display area. Also, if the height of a component 
exceeds the maximum value for the screen construction area, the height is changed to 
the maximum value. 

2.10  Editing Components and the Screen
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Copy/Cut/Paste/Delete/Add for components and screens
After components or display data have been created, Copy, Cut, Paste, Delete, and Add 
can be performed for efficient creation of monitor screens.

Procedure
Component Copy and Paste 

1.	 Click the Edit icon of the Components bar and click the component to be copied. 

2.	 Select Edit > Copy from the menu bar or click the Copy icon. 
The component is copied to the clipboard. 

3.	 Select Edit > Paste from the menu bar or click the Paste icon.
The component is pasted to a location moved by (10, 10) from the coordinates of the copied 
component. With the second paste operation, the component is pasted to a location moved 
by (10, 10) from the previously copied component. 
When coordinates are specified where a part of the components no longer is displayed 
on the screen construction area, the component is arranged so as to fit into the screen 
construction area. 

		
Paste

Copy with movement by (10, 10).

Copy to fit into the screen 
construction area.

 

Screen Copy and Paste
1.	 Click the display name to be copied in the display list area. 

2.	 Select Edit > Copy from the menu bar or click the Copy icon. 
The screen is copied to the clipboard. 

3.	 Click any location (copy destination) on the Display list area. 

4.	 Select “Paste” from the Edit menu or click the Paste icon. 
The display data are copied. The file name becomes “Copy” + “Display name of the copy 
source.” 

Select the copy source. Specify the copy destination. Paste.

Display name with 
copying of Display2

 

Component Cut and Paste
1.	 Select one or several components.

2.	 Select Edit > Cut from the menu bar or click the Cut icon.
The component is moved to the clipboard.

3.	 Select Edit > Paste from the menu bar or click the Paste icon.
The component is pasted into its original position.

2.10  Editing Components and the Screen
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Screen Cut and Paste
1.	 Select a Display name from the Display list. 

2.	 Select Edit > Cut from the menu bar or click the Cut icon. 
The display data are moved to the clipboard.  
An item No. is displayed for the display name at the movement source. 

3.	 Select Edit > Paste from the menu bar or click the Paste icon.
The following message is displayed. 

					      

4.	 Click [OK]. 
The display data is pasted.
The display name becomes “Copy” + “Display name of the copy source.” 

Note
Display names from the top through the third in the display list area cannot be cut. 

Deleting a component/screen 
1.	 Select the component or display name to be deleted. 

2.	 Select Edit > Delete from the menu bar. 
The component is deleted.  
When display data are deleted, the following message is displayed.

					   

3.	 Click [OK]. 
The display data are deleted.

Note
Display names from the top through the third in the display list area cannot be deleted. 

Adding a screen
1.	 Select the position (item No.) in the Display list where a screen is to be added. 

2.	 Select Edit > Add Display from the menu bar or click the Add Display icon. 
The display name of “Display” + “Item No.” is displayed in the display list. The data are 
blank.  
Copied or cut display data can be pasted. 

2.10  Editing Components and the Screen
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Undo/Redo of a screen or component editing operation
You can undo an edit made to a component or screen. Also, if you undo an edit, you can 
redo it. 
Editing operations also include section 2.11, “Arranging Components.” 

Procedure
Undo

1.	 On the tool bar, click the [Undo] button, or on the menu bar, click Edit > Undo. 

					   

Click here

The most recent edit operation is undone. 

Redo
2.	 On the tool bar, click the [Redo] button, or on the menu bar, click Edit > Redo. 

				  

Click here

The edit operation is redone. 

Explanation
If a component is selected in a screen that is being edited and you switch to a different 
screen, the component is no longer selected when you return to the original screen. 
However, the display and functioning of the [Redo] and [Undo] buttons is not affected. 

2.10  Editing Components and the Screen
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2.11	 Arranging Components

Use the icons of the Arrangement bar to change the arrangement and the size of 
components.

Procedure
Arranging components aligned with the left edge

1.	 Select multiple components. 

2.	 Select Arrangement > Left from the menu bar or click the Left icon on the 
Arrangement bar. 
The selected components are arranged with the left edge of the reference component as 
reference.

					      

Arranging components at the center of the horizontal direction
1.	 Select multiple components. 

2.	 Select Arrangement > Horizontal Center from the menu bar or click the 
Horizontal Center icon on the Arrangement bar.
The selected components are arranged with the center in X-axis direction of the reference 
component as reference.

					      

Arranging components aligned with the right edge 
1.	 Select multiple components. 

2.	 Select Arrangement > Right from the menu bar or click the Right icon on the 
Arrangement bar. 
The selected components are arranged with the right edge of the reference component as 
reference. 
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Arranging components aligned with the top edge
1.	 Select multiple components. 

2.	 Select Arrangement > Top from the menu bar or click the Top icon on the 
Arrangement bar.
The selected components are arranged with the top edge of the reference component as 
reference. 

					      

Arranging components aligned with the center in vertical direction.
1.	 Select multiple components.

2.	 Select Arrangement > Vertical Center from the menu bar or click the Vertical 
Center icon on the Arrangement bar.
The selected components are arranged with the center in Y-axis direction of the reference 
component as reference.

					      

Arranging components aligned with the bottom edge 
1.	 Select multiple components. 

2.	 Select Arrangement > Bottom from the menu bar or click the Bottom icon on 
the Arrangement bar.
The selected components are arranged with the bottom edge of the reference component 
as reference.

					   

2.11  Arranging Components
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Proportional horizontal distribution of components
1. Select multiple components. 
2. 	 On the Arrangement menu, click [Distribute horizontally], or click the distribute 

horizontally icon on the arrangement bar. 
The selected components are arranged with proportional horizontal spacing. 
If the X coordinate of multiple selected components is the same, components are arranged 
to the right in order starting from the component in front. 
When distributing components horizontally, spacing errors of 1 dot can occur. 

					   

A1

A2

A2

A1

When components do not overlap

When components overlap

When the left-most and right-most edges 
belong to the same component

Align component centers horizontally

	

2.11  Arranging Components
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Proportional vertical distribution of components

1. Select multiple components. 
2.	 On the Arrangement menu, click [Distribute vertically], or click the distribute 

vertically icon on the arrangement bar. 
The selected components are arranged with proportional vertical space between them. 
If the X coordinate of multiple selected components is the same, components are arranged 
to the right in order starting from the component in front. 
When distributing components vertically, spacing errors of 1 dot can occur. 

					   

A1

A1

A2
A2

When components do not overlap

When components overlap

When the top-most and bottom-most 
edges belong to the same component

Align component centers vertically

2.11  Arranging Components
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Making the width of components the same as that of the reference 
component 

1.	 Select multiple components. 

2.	 Select Arrangement > Width from the menu bar or click the Width icon on the 
Arrangement bar. 
The width of the selected component is made the same as that of the reference component. 

					      

For a line component, keep the start point fixed and adjust the end point to the left or right. 

					   

Starting point A1

A1

A1 A1

Making the height of components the same as that of the reference 
component

1.	 Select multiple components. 

2.	 Select Arrangement > Height from the menu bar or click the Height icon on the 
Arrangement bar. 
The height of the selected components becomes the same as the height of the reference 
component. 

					   

For a line component, keep the start point fixed and adjust the end point up or down. 

					   

Starting point

Starting point

A

A A

A

 

2.11  Arranging Components
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Arranging components to the Top plane
1.	 Select one or several components. 

2.	 Select Arrangement > To Top from the menu bar or click the To Top icon on the 
Arrangement bar. 
The selected components are arranged on the top plane. When multiple components have 
been selected, the display sequence of the components is arranged to the top as it is. 

	 Arranging one component to the top plane

				     

	 Arranging multiple components to the top plane

				     

Arranging components to the Bottom plane
1.	 Select one or several components. 

2.	 Select Arrangement > To Bottom from the menu bar or click the To Bottom icon 
on the Arrangement bar.
The selected components are arranged on the bottom plane. When multiple components 
have been selected, the display sequence of the components is arranged to the bottom as it 
is.

	 Arranging one component to the bottom plane

				     

	 Arranging multiple components to the bottom plane

				     

2.11  Arranging Components



2-47IM 04L41B01-62EN

1

2

3

4

5

Index

C
reating a M

onitor Screen w
ith D

A
Q

Studio

Arranging components to the Front 
1.	 Select one or several components. 

2.	 Select Arrangement > To Front from the menu bar or click the To Front icon on 
the Arrangement bar. 
The selected components are arranged one plane to the front. When multiple components 
have been selected, each component is arranged one plane to the front. 

	   Arranging one component one plane to the front 

					      

	   Arranging multiple components each one plane to the front

					      

Arranging components one plane to the back 
1.	 Select one or several components. 

2.	 Select Arrangement > To Back from the menu bar or click the To Back icon on 
the Arrangement bar. 
The selected components are arranged one plane to the back. When multiple components 
have been selected, each component is arranged one plane to the back.

	   Arranging one component one plane to the back 

					      

	   Arranging multiple components each one plane to the back

					      

2.11  Arranging Components
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2.12	 Setting Attributes

Setting screen attributes 
Procedure

1.	 Click the background part (a place with no components) of the screen construction 
area. 
The attributes of the screen being created are displayed in the attribute area.

					      

2.	 The screen name can be changed, and the settings for base color and screen 
menu at the time of execution can be selected from a list box. 
Refer to Chapter 3 for details of the setting items.

Setting component attributes 
Procedure

1.	 Select a component. 
The attributes of the selected component are displayed in the attribute area.

					      

2.	 Values can be entered directly or a list box can be displayed and settings can be 
changed. 
Refer to Chapter 3 for details of the setting items. 
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Chapter 3	 Detailed Information for Attributes of Screens and Components

3.1	 Screen Attributes

		   

Attribute name Set value/choice
(Underlined items are initial 
set values)

Description

Display name Up to 16 single-byte 
characters

Changes the Display name displayed in the Display list area. This is 
displayed below the Components bar on the Main screen.

Base color [Light gray], [Light blue], 
[L orange], [Aquamarin], 
[Dark gray], [Dark blue], 
[Dark green], [White], [Black]

Set the background color of the screen. Components not having a 
background color are painted with the color set here.

Runtime menu [Off], [On] Select display/hide for the soft-key menu of the custom display 
execution screen of the DX recorder.
On: Display the soft-key menu. 
Off: Hide the soft-key menu.

Status area (can only 
be set with a Version 
4.01 screen and a 
Version 4.11 screen)

[Off], [On] Select Display/No display for the status area. When set to [Off], the 
screen construction area becomes larger. The following occurs when 
switching the status area from No display to Display. 
When components overlap the status area, they move into the screen 
display area. Also, if the height of a component exceeds the maximum 
value for the screen construction area, the height is changed to the 
maximum value. 

Continued on the next page
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Attribute name Set value/choice
(Underlined items are initial 
set values)

Description

Batch group number Setting range:  1 to multi-
batch number set by the 
basic settings of the DX 
recorder
DX1000: [1] to [6]
DX2000 standard memory: 
	 [1] to [6]
DX2000 expanded memory: 
	 [1] to [12]

This is the batch group number that can be selected within the range 
of the number of multibatches set in the basic settings on the DX 
recorder. 
This item cannot be set if MultiBatch is turned Off.  

Display Grp no When multi-batch is Off 
DX1000: [1] to [10]
DX2000: [1] to [36]
When multi-batch is On 
DX1000: [1] to [6]
DX2000: [1] to [12]

Group control is performed for components. Display groups can be 
switched with the left and right arrow keys on the execution screen of 
the DX recorder. 
Display on the builder screen of the DX recorder is made as “Group 
No.”. 
For components having a group No. in the attributes (trend and scale), 
the group No. is switched. 
For components having only a channel No., the channel No. is switched.

Display group 
switching(can only 
be set with a Version 
4.01 screen and a 
Version 4.11 screen)

[Off], [On] Sets whether or not to switch display groups. 
Off: Display groups not switched
On: Display groups switched

Note
If the status area is set to No display, components move or their heights change.  To restore 
positions, click the [Undo] icon on the tool bar. Only one level of Undo is available in this case. 
If the status area is set to No display and even just one edit is made to the screen, you cannot 
return to state before the status area was set to No display. Please be aware of this.

3.1  Screen Attributes
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3.2	 Component ID No. and Number of Components 
which can be Created on one screen

When a component is selected in the screen construction area, the setting items of 
the selected component are displayed in the attribute list. The items which can be set 
depend on the selected component. The setting items of the attribute area corresponding 
to each component are explained in the following sections. 
Component ID numbers are assigned separate by component kind in order of creation. 
Also, assignment is made to different ranges by component kinds. The number of 
components which can be created on one screen is the same as the number of ID 
numbers which can be assigned, Please refer to the following table. 
(The number of components which can be created on the screen is the same as the 
number of IDs.)

Component type Component name Update cycle ID number Number of 
components which 
can be created on 
one screen

Components for 
channel assignment

Simple digital
Digital
Simple bar
Bar
TagNo.
TagComment
Unit
SpanU
SpanL
Alarm indicator

1 sec.
1 sec.
1 sec.
1 sec.
None
None
None
None
None
1 sec

0 to 79 80

Status display 
component

System icon
Memory bar
Time label
Batch group number
Batch name
Group name

1 sec
1 sec
1 sec
None
None
None

Label components Label None
Components with 
action functions

Push button
Switch
Comm. In
Modbus In

None
1 sec
1 sec
1 sec

Components for 
comment display

Comment box
Comment block

1 sec
1 sec

Components for list 
display

Alarm list
Comm In

1 sec
1 sec

8 to 83 4

Components for trend 
display

Trend Trend update 
cycle

84 to 87 4

Scale components Scale Measurement 
interval

88 to 91 4

Diagram components Line
Rectangle
Circle

None
None
None

92 to 131 40

Components for static 
image display

Bitmap None 132 to 133 2

* �The update cycle is the period in which the display updates when data acquisition begins on 
the DX recorder.  
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3.3	 Common Attributes of Components

The attributes which can be set for each component have items which are common for 
multiple components. 
This section explains the set values of common attributes, the choices, and the 
conditions.

Explanation of choices and set values
SET (Set values)
The “SET” displayed for choices are the values which can be set with the setting menu of 
the DX recorder.
When setting X, Y, width, height, start point X, start point Y, end point X, end point Y, or 
size, if the setting is invalid it is adjusted automatically. 

Font
The following character types are available.
Font (character size) Description
Font 5

English one-byte characters. 
ISO8859-1 (Some symbols are not available.)

Font 6
Font 8
Font 12
Font 16
Font 32

Special display font
With some fonts, characters appear differently when entering text labels for setting 
attributes than they do in the screen construction area. This is also true when entering 
characters directly into components in the screen construction area. 
When entering 
characters in attribute 
settings

Display in the screen 
creation area

Related languages

\ English, German, French, Chinese, 
Russian, and Korean

^ °
English, Japanese, German, French, 
Chinese, Russian, and Korean

{ μ
| Ω
} Half-width space (blank)
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Explanation of common attributes
Attribute Set value/choice

(Underlined items are initial 
set values)

Description, conditions

Depend ID [None], [Component ID] This is the ID of the component on which the component depends. 
None: There are no components on which this component depends. 
Component ID: �This is the ID of the component on which the 

component depends.
Visible [Off], [On] Change is not possible in case of dependence on other components. 

Change is possible when Depend ID is [None]. 
Off: �Not displayed on the execution screen of the DX recorder (always 

displayed on the builder screen) 
On: Displayed on the execution screen of the DX recorder

Channel DX1000: �[CH001] to [CH012], 
[CH101] to [CH124]

DX2000: �[CH001] to [CH048], 
[CH101] to [CH160], 
[CH201] to [CH440]

Set the assigned channel No. Setting is possible when Group control is 
[None].

Frame [None], [Black], [White], 
[Raised], [Sunken]

This is the component frame kind. 
None: No frame 
Black: Black frame with a solid line with the width of 1 dot 
White: White frame with a solid line with the width of 1 dot 
Raised: �Frame with a solid line with the width of 1 dot, appearing raised 
Sunken: �Frame with a solid line with the width of 1 dot, appearing 

sunken
The following are the default settings by component. 
[None]: �Label, Simple digital, Tag No., TagComment, Unit, SpanL, 

SpanU, Group Name, System icon, Time label, Batch group 
no., Batch Name

[Black]: Comment box, Comment block
[Raised]: Digital, Bar, Alarm indicator, Switch, Alarm list, Message list
[Sunken]: Memory bar

Group control [None],  
[GrpCtrl1], [GrpCtrl2], 
[GrpCtrl3], [GrpCtrl4]

Indicates group control status. 
None: No group control 
GrpCtrl1 to 4: indicates group control for group control 1 to 4.

Gr. Ctrl order DX1000: [1] to [6]
DX2000: [1] to [10]

Indicates the group control order. 
Setting is not possible when Group control is [None].

Example of Depend ID
For example, if you have the following components whose IDs are 0 to 3 on the [Builder 
screen], the IDs you will be able to configure are shown in the below table.

		

0ID

Depend on 1 Depend on 2

1 2 3 ID
0
1
2
3

None
None
None
None

1
2
3
0

Configurable ID
2
3

1

3

2

 

Example of Frames

		
None Black White Raised Sunken

 

3.3  Common Attributes of Components
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Group control and Gr.Ctrl order (Group control order)
Group control displays or sets the control status of the display group. The group control 
order cannot be set when Group control is set to [None]. 
When the number of registrations for the Group Control order at the DX recorder 
has reached 10, that group control order cannot be displayed. When the number of 
registrations for all group control orders has reached 10, that group control order cannot 
be displayed. 

Sync act (Synchronize action)
Attribute Set value/choice

(Underlined items are initial 
set values)

Description, conditions

Synchro attribute [None], [Visible], [2nd span] These are attributes which change with synchronization. 
None: No synchro attribute 
Visible: Visible attributes are synchronized.
2nd span is available for trend components and scale components 
only. Refer to “2nd span” in the following.

Value (switch On) [Off], [On] This is the attribute value when the synchronization switch is ON.
Synchro target [Alarm], [Switch] This is the object to be synchronized with the component. 

Alarm: The attribute is synchronized with an alarm. 
Switch: The attribute is synchronized with a switch.

Channel or Switch no When the synchro target is 
[Alarm]:
DX1000: �[CH001] to [CH012], 

[CH101] to [CH124]
DX2000: �[CH001] to [CH048], 

[CH101] to [CH160], 
[CH201] to [CH440]

When the synchro target is 
[Switch]: 
Internal switch No. [1] to [30]

When the synchro target is an alarm: 
This is the object for attribute synchronization. 
When the synchro target is [Alarm]: Channel No. to which the attribute 
is synchronized 
When the synchro target is [Switch]: Internal switch No. to which the 
attribute is synchronized

Alarm level [1], [2], [3], [4], [All] When the synchro target is [Alarm], the alarm level is specified. 
1 to 4: Alarm level 
All: Synchronization to all alarm levels

2nd span
This is the attribute available with trend components and scale components only. You 
can enlarge the display of trend and scale by synchronizing the On/Off settings of alarm 
or internal switch. To validate the 2nd span, configure [2nd span] at the synchro attribute 
field. Scale and trend shown in the below figure are an example of displaying the 2nd 
span when the alarm is set to On.
(Example of settings)
•	 2nd span: On; 2nd span Lower: 85.0%, 2nd span Upper: 100.0%
•	� Synchro attribute: 2nd span; Value (switch On): On; Synchro target: alarm,  

Channel no: 1; Alarm level: 1

Configured span

Alarm set

2nd span

If a measured value exceeds the alarm set, screen shows 
the enlarged image of this span as the 2nd span.

 

3.3  Common Attributes of Components
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3.4	 Attributes of Simple Digital Components

		   

The following limitations exist for setting the attributes of simple digital components.
•	 Setting to Visible is possible only when Depend ID is [None].
•	 Transparent backgrounds can only be turned ON when simple digital components are 

completely overlapped by trend components. If the trend component falls outside of 
the frame, the ON setting becomes invalid.

List of Settings
Refer to Section 3.3 for attributes without explanations in the list of settings.

Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

X DX1000: 0 to 318
DX2000: 0 to 638

This is the X-coordinate of the left side of the component.
X = 0 for X < 0
X = (Max. width*1 – Width) for (X + Width) > Max. width*1

Y DX1000: 24(0) to 238 
DX2000: 40(0) to 478 
(   ) = Status area set to No 
display

This is the Y-coordinate of the upper side of the component.
Y = Min. Y*2 for Y < Min. Y*2

Y = (Min. Y*2 + Max. height*3 – Height) for (Y + Height) > (Min. Y*2 + 
Max. height*3)

Width DX1000: 2 to 320
DX2000: 2 to 640

This is the component width.
Width = 2 for width < 2 
X = (Max. width*1 – Width) for width < Max. width*1 and (X + Width) > 
Max. width*1

Width = Max. width*1, X = 0 for width ≥ Max. width*1

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display
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Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

Height DX1000: 2 to 216(240)
DX2000: 2 to 440(480)
(   ) = Status area set to No 
display

This is the component height.
Height = 2 for height < 2
Y = (Min. Y*2 + Max. height*3 – Height) for height < Max. height*3 and (Y 
+ Height) > (Min. Y*2 + Max. height*3)
Height = Max. height*3, Y = Min. Y*2 for height ≥ Max. height*3

Font [Font5], [Font6], [Font8], 
[Font12], [Font16], [Font32]

This is the character size for the digital value of a component.
The initial setting is [Font6] for DX1000 and [Font8] for DX2000.

Color [Red], [Green], [Blue], 
[B.violet], [Brown], [Orange], 
[Y.green], [Light blue], [Violet], 
[Gray], [Lime], [Cyan], [Dark 
blue], [Yellow], [Light gray], 
[Purple], [Pink], [L.brown], 
[L.green], [Dark gray], [Olive], 
[Dark cyan], [S.green], 
[Black], [White], [BASE], 
[CHANNEL]

Color of the digital value
BASE: Base color (background color of the screen) 
CHANNEL: The color set to the specified channel

Alarm color Color choice, [Alarm color] This is the display color for the digital value at the time of occurrence 
of an alarm. 
Alarm color: This is the alarm display color set for each alarm level. 

Background color Same choice as for “Color” This is the background color of the digital value area. 
The initial setting is [BASE].

BG transparent [Off], [On] Select display/no display for transparent background. 
When this is On, the background color of the execution screen 
becomes transparent (on the execution screen of the DX recorder, 
frames are displayed by dotted lines to indicate that background 
transparent display is ON). 

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display

Synchronize action
►Section 3.3

3.4  Attributes of Simple Digital Components
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3.5	 Attributes of Digital Components

		

The following limitations exist for setting of attributes for digital components. 
•	 [Visible] can only be set when [Depend ID] is set to [None]. 
•	 Unit font setting is not possible when Unit display is [Off]. 
•	 When the synchro target is [Switch], alarm level setting is not possible. 
•	 When Group control is [None], the group control order cannot be set. 

List of Settings
Refer to Section 3.3 for attributes without explanations in the list of settings.

Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

X DX1000: 0 to 318
DX2000: 0 to 638

This is the X-coordinate of the left side of the component.
X = 0 for X < 0
X = (Max. width*1 – Width) for (X + Width) > Max. width*1 

Y DX1000: 24(0) to 238 
DX2000: 40(0) to 478  
(   ) = Status area set to No 
display

This is the Y-coordinate of the upper side of the component.
Y = Min. Y*2 for Y < Min. Y*2

Y = (Min. Y*2 + Max. height*3 – Height) for (Y + Height) > (Min. Y*2 + 
Max. height*3)

Width DX1000: 2 to 320
DX2000: 2 to 640

This is the component width.
Width = 2 for width < 2 
X = (Max. width*1 – Width) for width < Max. width*1 and (X + Width) > 
Max. width*1

Width = Max. width*1, X = 0 for width ≥ Max. width*1

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display
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Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

Height DX1000: 2 to 216(240)
DX2000: 2 to 440(480)
(   ) = Status area set to No 
display

This is the component height.
Height = 2 for height < 2
Y = (Min. Y*2 + Max. height*3 – Height) for height < Max. height*3 and (Y 
+ Height) > (Min. Y*2 + Max. height*3)
Height = Max. height*3, Y = Min. Y*2 for height ≥ Max. height*3

Digital font [Font5], [Font6], [Font8], 
[Font12], [Font16], [Font32]

This is the character size for the digital value of a component.
The initial setting is [Font8] for DX1000 and [Font12] for DX2000.

Channel font TagNo./Channel :
  �[Font5], [Font6], [Font8], 

[Font12], [Font16]
TagNo.: �[Font5], [Font12],  

[Font16]

This sets the character size for Tag No., Tag Comment, and Channel 
No.
The initial setting is [Font6] for DX1000 and [Font8] for DX2000.

Unit display [Off], [On] Display/No display is selected for the component unit.
Unit font [Font5], [Font6], [Font8], 

[Font12], [Font16]
This is the character size for Unit display. Setting is not possible when 
“Unit display” is [Off].
The initial setting is [Font6] for DX1000 and [Font8] for DX2000.

Alarm display [Off], [On] This selects display/no display for the alarm indicator. 
The alarm display marks correspond to level 1, level 2, level 3, and 
level 4 from the top. 
Display is made in the lime color when Alarm is Off and in the color 
set for each level (red, orange, yellow or pink) when Alarm is On.

2 Line display [Off], [On] This selects tag display with division into two lines or no division. 
Off: Display divided into two lines is not made. 
On: Display divided into two lines 

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display

Synchronize action
►Section 3.3

3.5  Attributes of Digital Components
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3.6	 Attributes of Simple Bar Graph Components

		   	  

The following limitations exist for setting of attributes of simple bar graph components.
•	 [Visible] can only be set when [Depend ID] is set to [None]. 

List of Settings
Refer to Section 3.3 for attributes without explanations in the list of settings.
Bar graph tab 
Attribute Set value/choice

(Underlined items are initial 
set values)

Description, conditions

X DX1000: 0 to 318
DX2000: 0 to 638

This is the X-coordinate of the left side of the component.
X = 0 for X < 0
X = (Max. width*1 – Width) for (X + Width) > Max. width*1

Y DX1000: 24(0) to 238 
DX2000: 40(0) to 478 
(   ) = Status area set to No 
display

This is the Y-coordinate of the upper side of the component.
Y = Min. Y*2 for Y < Min. Y*2

Y = (Min. Y*2 + Max. height*3 – Height) for (Y + Height) > (Min. Y*2 + 
Max. height*3)

Width DX1000: 2 to 320
DX2000: 2 to 640

This is the component width.
Width = 2 for width < 2 
X = (Max. width*1 – Width) for width < Max. width*1 and (X + Width) > 
Max. width*1

Width = Max. width*1, X = 0 for width ≥ Max. width*1

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display
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Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

Height DX1000: 2 to 216(240)
DX2000: 2 to 440(480)
(   ) = Status area set to No 
display

This is the component height.
Height = 2 for height < 2
Y = (Min. Y*2 + Max. height*3 – Height) for height < Max. height*3 and (Y 
+ Height) > (Min. Y*2 + Max. height*3)
Height = Max. height*3, Y = Min. Y*2 for height ≥ Max. height*3

Direction [Horizon], [Vertical] This is the bar graph display direction.
The initial setting depends on the aspect ratio when the bar graph 
size has been decided. 
    Height at the time of height ≥ Width 
    Width at the time of height < Width

Color [Red], [Green], [Blue], 
[B.violet], [Brown], [Orange], 
[Y.green], [Light blue], [Violet], 
[Gray], [Lime], [Cyan], [Dark 
blue], [Yellow], [Light gray], 
[Purple], [Pink], [L.brown], 
[L.green], [Dark gray], [Olive], 
[Dark cyan], [S.green], 
[Black], [White], [BASE], 
[CHANNEL]

This is the bar color. 
BASE: Base color (background color of the screen)
CHANNEL: The color set to the specified channel 

Background color Same choice as for “Color”, 
[None]

This is the background color of the bar graph area
The initial setting is [Background color].

Color scale band [Off], [SET] Selection of green band display/no display
Off: No green band display 
SET: Setting of the DX recorder 

Base position [SET], [Normal], [Center], 
[Lower], [Upper]

This is the base position of the bar graph.
SET: Setting of the DX recorder 

Color change [Off], [On] When On, the bar color changes to the specified color when an alarm 
has occurred.

Alarm color Same choice as for “Color”, 
[ALARM]

This sets the bar color when an alarm has occurred.

Scale line [Off], [On] On: A scale line is displayed. 
Off: Only bar and background color are displayed.

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display

3.6  Attributes of Simple Bar Graph Components
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Alarm mark tab

Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

Use Checked, Not checked Checked: Alarm marks are used. 
Not checked: Alarm marks are not used. 

Alarm level [1], [2], [3], [4] 1 to 4: Alarm level
Style [Alarm], [Fixed] This is the alarm mark status.

Alarm: Trapezoid 
Fixed: Triangle 

Position In case of a Vertical Bar 
Graph
[Left], [Right]
In case of a Horizontal Bar 
Graph
[Over], [Under]

This set alarm mark setting at top, bottom, left or right of a bar graph. 
The choices change depending on the bar graph display direction. 
In case of a Vertical Bar Graph
Left: Display on the left side of the bar graph
Right: Display on the right side of the graph bar 
In case of a Horizontal Bar Graph
Over: Display above the bar graph
Under: Display below the bar graph

Mark size [Large], [Small] This is the alarm mark size. 
Large: Large mark 
Small: Small mark

color [Red], [Green], [Blue], 
[B.violet], [Brown], [Orange], 
[Y.green], [Light blue], [Violet], 
[Gray], [Lime], [Cyan], [Dark 
blue], [Yellow], [Light gray], 
[Purple], [Pink], [L.brown], 
[L.green], [Dark gray], [Olive], 
[Dark cyan], [S.green], 
[Black], [White], [CHANNEL]

This is the mark display color. 
CHANNEL: The color set to the specified channel 

Color change [Off], [On] Off: The color does not change at the time of alarm occurrence. 
On: The color of the alarm mark changes when an alarm occurs.

Alarm color Same choice as for “Color”, 
[ALARM]

This is the mark display color at the time of alarm occurrence. 
Setting is not possible when “Color change” is [Off]. 
Alarm color: This is the alarm display color set for each alarm level.

Synchronize action
►Section 3.3

3.6  Attributes of Simple Bar Graph Components
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3.7	 Attributes of Bar Graph Components

		   

The following limitations exist for setting of attributes of bar graph components.
•	 [Visible] can only be set when [Depend ID] is set to [None]. 
•	 Setting of Channel font, Tag font, Digital display, Digital font, Unit display, Unit font, 

and Alarm display is not possible when Style is [Horizontal]. 
•	 Setting of Digital font is not possible when Digital value display is [Off]. 
•	 Setting of Unit font is not possible when Unit display is [Off]. 
•	 Setting of Span font is not possible when Span display is [Off].

List of Settings
Refer to Section 3.3 for attributes without explanations in the list of settings.

Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

X DX1000: 0 to 318
DX2000: 0 to 638

This is the X-coordinate of the left side of the component.
X = 0 for X < 0
X = (Max. width*1 – Width) for (X + Width) > Max. width*1

Y DX1000: 24(0) to 238 
DX2000: 40(0) to 478 
(   ) = Status area set to No 
display

This is the Y-coordinate of the upper side of the component.
Y = Min. Y*2 for Y < Min. Y*2

Y = (Min. Y*2 + Max. height*3 – Height) for (Y + Height) > (Min. Y*2 + 
Max. height*3)

Width DX1000: 2 to 320
DX2000: 2 to 640

This is the component width.
Width = 2 for width < 2 
X = (Max. width*1 – Width) for width < Max. width*1 and (X + Width) > 
Max. width*1

Width = Max. width*1, X = 0 for width ≥ Max. width*1

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display
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Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

Height DX1000: 2 to 216(240)
DX2000: 2 to 440(480)
(   ) = Status area set to No 
display

This is the component height.
Height = 2 for height < 2
Y = (Min. Y*2 + Max. height*3 – Height) for height < Max. height*3 and (Y 
+ Height) > (Min. Y*2 + Max. height*3)
Height = Max. height*3, Y = Min. Y*2 for height ≥ Max. height*3

Direction [Horizon], [Vertical] This is the bar graph display direction.
The initial setting depends on the aspect ratio when the bar graph 
size has been decided. 
    Height at the time of height ≥ Width 
    Width at the time of height < Width
In case of a Horizontal Bar Graph, Tag No./Channel No., Tag, Unit, 
Digital value, and Alarm indicator are not displayed. 

Channel font [Font5], [Font6], [Font8], 
[Font12], [Font16]

This is the font for display of the component tag No./channel No. 
Setting is not possible when “Direction” is [Horizontal].
The initial setting is [Font6] for DX1000 and [Font8] for DX2000.

Tag font [Font5], [Font6], [Font8], 
[Font12], [Font16]

This is the font for display of component tags. 
Setting is not possible when “Direction” is [Horizontal].
The initial setting is [Font6] for DX1000 and [Font8] for DX2000.

Digital display [Off], [On] This selects display/no display of component digital values. 
Setting is not possible when “Direction” is [Horizontal].

Digital font [Font5], [Font6], [Font8], 
[Font12], [Font16], [Font32]

This is the font for display of component digital values. 
Setting is not possible when “Direction” is [Horizontal] or when “Digital 
value display” is [Off].
The initial setting is [Font6] for DX1000 and [Font8] for DX2000.

Unit display [Off], [On] Display/No display is selected for the component unit. 
Setting is not possible when “Direction” is [Horizontal]. 

Unit font [Font5], [Font6], [Font8], 
[Font12], [Font16]

This is the font for display of component units. 
Setting is not possible when “Direction” is [Horizontal] or when Unit 
display is [Off].

Span display [Off], [On] This selects display/no display of the component span.
Span font [Font5], [Font6], [Font8], 

[Font12], [Font16]
This is the font for display of component span values. 
Setting is not possible when “Span display” is [Off].

Bar color [Green], [CHANNEL] This is the color of the bar graph. 
Green: �Display is made in the color set for each alarm level when an 

alarm has occurred (red, orange, yellow, pink). 
CHANNEL: The color set for the channel 

Base position [SET], [Normal], [Center],  
[Lower], [Upper]

This is the bar graph display origin. 
SET: Setting of the DX recorder

Alarm display [Off], [On] This selects display/no display for the alarm indicator. 
Setting is not possible when “Direction” is [Horizontal].

Alarm mark display [Off], [On] This selects display/no display of alarm marks.
2 Line display [Off], [On] This selects tag display with division into two lines (On) or not (Off).
*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display

Synchronize action
►Section 3.3

3.7  Attributes of Bar Graph Components
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3.8	 Attributes of Tag No. Components

		   

The following limitations exist for setting of attributes of the tag no. components.
•	 [Visible] can only be set when [Depend ID] is set to [None]. 

List of Settings
Refer to Section 3.3 for attributes without explanations in the list of settings.

Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

X DX1000: 0 to 318
DX2000: 0 to 638

This is the X-coordinate of the left side of the component.
X = 0 for X < 0
X = (Max. width*1 – Width) for (X + Width) > Max. width*1

Y DX1000: 24(0) to 238 
DX2000: 40(0) to 478 
(   ) = Status area set to No 
display

This is the Y-coordinate of the upper side of the component.
Y = Min. Y*2 for Y < Min. Y*2

Y = (Min. Y*2 + Max. height*3 – Height) for (Y + Height) > (Min. Y*2 + 
Max. height*3)

Width DX1000: 2 to 320
DX2000: 2 to 640

This is the component width.
Width = 2 for width < 2 
X = (Max. width*1 – Width) for width < Max. width*1 and (X + Width) > 
Max. width*1

Width = Max. width*1, X = 0 for width ≥ Max. width*1

Height DX1000: 2 to 216(240)
DX2000: 2 to 440(480)
(   ) = Status area set to No 
display

This is the component height.
Height = 2 for height < 2
Y = (Min. Y*2 + Max. height*3 – Height) for height < Max. height*3 and (Y 
+ Height) > (Min. Y*2 + Max. height*3)
Height = Max. height*3, Y = Min. Y*2 for height ≥ Max. height*3

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display



3-17IM 04L41B01-62EN

1

2

3

4

5

Index

D
etailed Inform

ation for A
ttributes of Screens and C

om
ponents

Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

Vertical display (can 
only be set with a 
Version 4.01 screen 
and a Version 4.11 
screen)

 [Off], [On] Sets whether or not to display the tag number vertically. 
[On]: Rotates the text label 90 degrees clockwise. 
[Off]: Displays the text label horizontally. 

Font [Font5], [Font6], [Font8], 
[Font12], [Font16], [Font32]

This is the character size for the Tag no. of a component. The initial 
setting is [Font6] for DX1000 and [Font8] for DX2000.

Color [Red], [Green], [Blue], 
[B.violet], [Brown], [Orange], 
[Y.green], [Light blue], [Violet], 
[Gray], [Lime], [Cyan], [Dark 
blue], [Yellow], [Light gray], 
[Purple], [Pink], [L.brown], 
[L.green], [Dark gray], [Olive], 
[Dark cyan], [S.green], 
[Black], [White], [BASE], 
[CHANNEL]

This is the bar color. 
BASE: Base color (background color of the screen)
CHANNEL: The color set to the specified channel 

Background color Same choice as for “Color”, 
[None]

This is the background color of the tag number display area. 
The initial setting is [BASE].

Arrangement [Left], [Center], [Right] This is the text arrangement in direction of the X-axis in the tag 
number display area. 
The Y-axis direction always is arranged at the center. 
Left: Text is displayed left-aligned. 
Center: Text is displayed centered. 
Right: Text is displayed right-aligned. 

Gap [0] to [15] The interval between characters is specified in dots.
2 Line display [Off], [On] This selects tag display with division into two lines (On) or not (Off).

Synchronize action
►Section 3.3

3.8  Attributes of Tag No. Components
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3.9	 Attributes of Tag Comment Components

		   

The following limitations exist for setting of attributes of tag comment components.
•	 [Visible] can only be set when [Depend ID] is set to [None]. 

List of Settings
Refer to Section 3.3 for attributes without explanations in the list of settings.

Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

X DX1000: 0 to 318
DX2000: 0 to 638

This is the X-coordinate of the left side of the component.
X = 0 for X < 0
X = (Max. width*1 – Width) for (X + Width) > Max. width*1

Y DX1000: 24(0) to 238 
DX2000: 40(0) to 478 
(   ) = Status area set to No 
display

This is the Y-coordinate of the right side of the component. 
When Y < min. Y*2, Y = min. Y*2

When (Y + size) > (min. Y*2 + max. height*3), Y = (min. Y*2 + max. 
height*3)

Width DX1000: 2 to 320
DX2000: 2 to 640

This is the component width.
Width = 2 for width < 2 
X = (Max. width*1 – Width) for width < Max. width*1 and (X + Width) > 
Max. width*1

Width = Max. width*1, X = 0 for width ≥ Max. width*1

Height DX1000: 2 to 216(240)
DX2000: 2 to 440(480)
(   ) = Status area set to No 
display

This is the component height.
Height = 2 for height < 2
Y = (Min. Y*2 + Max. height*3 – Height) for height < Max. height*3 and (Y 
+ Height) > (Min. Y*2 + Max. height*3)
Height = Max. height*3, Y = Min. Y*2 for height ≥ Max. height*3

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display
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Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

Vertical display (can 
only be set with a 
Version 4.01 screen 
and a Version 4.11 
screen)

[Off], [On] Sets whether or not to display the tag comment vertically. 
[On]: Rotates the text label 90 degrees clockwise. 
[Off]: Displays the text label horizontally. 

Font [[Font5], [Font6], [Font8], 
[Font12], [Font16]

This is the character size for the Tag no. of a component. The initial 
setting is [Font6] for DX1000 and [Font8] for DX2000.

Color [Red], [Green], [Blue], 
[B.violet], [Brown], [Orange], 
[Y.green], [Light blue], [Violet], 
[Gray], [Lime], [Cyan], [Dark 
blue], [Yellow], [Light gray], 
[Purple], [Pink], [L.brown], 
[L.green], [Dark gray], [Olive], 
[Dark cyan], [S.green], 
[Black], [White], [BASE], 
[CHANNEL]

The color for display of text.
BASE: Base color (background color of the screen)
CHANNEL: The color set to the specified channel 

Background color Same choice as for “Color”, 
[None]

This is the background color of the tag comment display area. The 
initial setting is [BASE].
None: No painting of the background color 

Arrangement [Left], [Center], [Right] This is the text arrangement in direction of the X-axis in the tag 
comment display area.
The Y-axis direction always is arranged at the center. 
Left: Text is displayed left-aligned.
Center: Text is displayed centered.
Right: Text is displayed right-aligned. 

Gap [0] to [15] The interval between characters is specified in dots.
2 Line display [Off], [On] This selects tag display with division into two lines (On) or not (Off).

Synchronize action
►Section 3.3

3.9  Attributes of Tag Comment Components
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3.10	 Attributes of Unit Components

		   

The following limitations exist for setting of attributes of unit components.
•	 [Visible] can only be set when [Depend ID] is set to [None]. 

List of Settings
Refer to Section 3.3 for attributes without explanations in the list of settings.

Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

X DX1000: 0 to 318
DX2000: 0 to 638

This is the X-coordinate of the left side of the component.
X = 0 for X < 0
X = (Max. width*1 – Width) for (X + Width) > Max. width*1 

Y DX1000: 24(0) to 238
DX2000: 40(0) to 478 
(   ) = Status area set to No 
display

This is the Y-coordinate of the right side of the component. 
When Y < min. Y*2, Y = min. Y*2

When (Y + size) > (min. Y*2 + max. height*3), Y = (min. Y*2 + max. 
height*3)

Width DX1000: 2 to 320
DX2000: 2 to 640

This is the component width.
Width = 2 for width < 2
X = (Max. width*1 – Width) for width < Max. width*1 and (X + Width) > 
Max. width*1

Width = Max. width*1, X = 0 for width ≥ Max. width*1

Height DX1000: 2 to 216(240)
DX2000: 2 to 440(480)
(   ) = Status area set to No 
display

This is the component height.
Height = 2 for height < 2
Y = (Min. Y*2 + Max. height*3 – Height) for height < Max. height*3 and (Y 
+ Height) > (Min. Y*2 + Max. height*3)
Height = Max. height*3, Y = Min. Y*2 for height ≥ Max. height*3

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display
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Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

Vertical display (can 
only be set with a 
Version 4.01 screen 
and a Version 4.11 
screen)

[Off], [On] Sets whether or not to display the units vertically. 
[On]: Rotates the text label 90 degrees clockwise. 
[Off]: Displays the text label horizontally. 

Font [Font5], [Font6], [Font8], 
[Font12], [Font16]

This is the font for display of unit components.
The initial setting is [Font6] for DX1000 and [Font8] for DX2000.

Color [Red], [Green], [Blue], 
[B.violet], [Brown], [Orange], 
[Y.green], [Light blue], [Violet], 
[Gray], [Lime], [Cyan], [Dark 
blue], [Yellow], [Light gray], 
[Purple], [Pink], [L.brown], 
[L.green], [Dark gray], [Olive], 
[Dark cyan], [S.green], 
[Black], [White], [BASE], 
[CHANNEL]

The color for display of text.
BASE: Base color (background color of the screen)
CHANNEL: The color set to the specified channel 

Background color Same choice as for “Color”, 
[None]

This is the background color of the unit display area.
The initial setting is [BASE].
None: No background painting 

Arrangement [Left], [Center], [Right] This is the text arrangement in direction of the X-axis in the unit 
display area.
The Y-axis direction always is arranged at the center. 
Left: Text is displayed left-aligned.
Center: Text is displayed centered.
Right: Text is displayed right-aligned. 

Gap [0] to [15] The interval between characters is specified in dots.

Synchronize action
►Section 3.3

3.10  Attributes of Unit Components
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3.11	 Attributes of Span Upper Limit Components / 
Span Lower Limit Components

		   	  

The following limitations exist for setting of attributes of span upper limit components/
span lower limit components.
•	 [Visible] can only be set when [Depend ID] is set to [None]. 

List of Settings
Refer to Section 3.3 for attributes without explanations in the list of settings.

Attribute Set value/choice 
(Underlined items are initial 
set values)

Description, conditions

X DX1000: 0 to 318
DX2000: 0 to 638

This is the X-coordinate of the left side of the component.
X = 0 for X < 0
X = (Max. width*1 – Width) for (X + Width) > Max. width*1 

Y DX1000: 24(0) to 238
DX2000: 40(0) to 478 
(   ) = Status area set to No 
display

This is the Y-coordinate of the right side of the component. 
When Y < min. Y*2, Y = min. Y*2

When (Y + size) > (min. Y*2 + max. height*3), Y = (min. Y*2 + max. 
height*3 )

Width DX1000: 2 to 320
DX2000: 2 to 640

This is the component width.
Width = 2 for width < 2 
X = (Max. width*1 – Width) for width < Max. width*1 and (X + Width) > 
Max. width*1

Width = Max. width*1, X = 0 for width ≥ Max. width*1

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display



3-23IM 04L41B01-62EN

1

2

3

4

5

Index

D
etailed Inform

ation for A
ttributes of Screens and C

om
ponents

Attribute Set value/choice 
(Underlined items are initial 
set values)

Description, conditions

Height DX1000: 2 to 216(240)
DX2000: 2 to 440(480)
(   ) = Status area set to No 
display

This is the component height.
Height = 2 for height < 2
Y = (Min. Y*2 + Max. height*3 – Height) for height < Max. height*3 and (Y 
+ Height) > (Min. Y*2 + Max. height*3)
Height = Max. height*3, Y = Min. Y*2 for height ≥ Max. height*3

Vertical display 
(can only be set with 
a Version 4.01 screen 
and a Version 4.11 
screen)

[Off], [On] Sets whether or not to display the span display vertically.
[On]: Rotates the text label 90 degrees clockwise. 
[Off]: Displays the text label horizontally. 

Font [Font5], [Font6], [Font8], 
[Font12], [Font16]

This is the font for display of span upper limit components/span lower 
limit components.
The initial setting is [Font6] for DX1000 and [Font8] for DX2000.

Color [Red], [Green], [Blue], 
[B.violet], [Brown], [Orange], 
[Y.green], [Light blue], [Violet], 
[Gray], [Lime], [Cyan], [Dark 
blue], [Yellow], [Light gray], 
[Purple], [Pink], [L.brown], 
[L.green], [Dark gray], [Olive], 
[Dark cyan], [S.green], 
[Black], [White], [BASE], 
[CHANNEL]

The color for display of text.
BASE: Base color (background color of the screen)
CHANNEL: The color set to the specified channel 

Background color Same choice as for “Color”, 
[None]

This is the background color for the span display area.
The initial setting is [BASE].
None: No background painting

Arrangement [Left], [Center], [Right] This is the text arrangement in direction of the X-axis in the span 
display area.
The Y-axis direction always is arranged at the center. 
Left: Text is displayed left-aligned.
Center: Text is displayed centered.
Right: Text is displayed right-aligned. 

Gap [0] to [15] The interval between characters is specified in dots.
*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display

Synchronize action
►Section 3.3

3.11  Attributes of Span Upper Limit Components / Span Lower Limit Components
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3.12	 Attributes of Alarm Indicator Components

		   

The following limitations exist for setting of attributes of alarm indicator components.
•	 [Visible] can only be set when [Depend ID] is set to [None]. .

List of Settings
Refer to Section 3.3 for attributes without explanations in the list of settings.

Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

X DX1000: 0 to 318
DX2000: 0 to 639

This is the X-coordinate of the left side of the component.
X = 0 for X < 0
X = (Max. width*1 – Width) for (X + Width) > Max. width*1 

Y DX1000: 24(0) to 238
DX2000: 40(0) to 478 
(   ) = Status area set to No 
display

This is the Y-coordinate of the right side of the component. 
When Y < min. Y*2, Y = min. Y*2

When (Y + size) > (min. Y*2 + max. height*3), Y = (min. Y*2 + max. 
height*3 )

Width DX1000: 2 to 320
DX2000: 2 to 640

This is the component width.
Width = 2 for width < 2 
X = (Max. width*1 – Width) for width < Max. width*1 and (X + Width) > 
Max. width*1

Width = Max. width*1, X = 0 for width ≥ Max. width*1

Height DX1000: 2 to 216(240)
DX2000: 2 to 440(480)
(   ) = Status area set to No 
display

This is the component height.
Height = 2 for height < 2
Y = (Min. Y*2 + Max. height*3 – Height) for height < Max. height*3 and (Y 
+ Height) > (Min. Y*2 + Max. height*3)
Height = Max. height*3, Y = Min. Y*2 for height ≥ Max. height*3

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display
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Attribute Set value/choice 
(Underlined items are initial 
set values)

Description, conditions

Alarm level [1], [2], [3], [4], [All] The assigned alarm level is set. 
All: �This becomes ON when an alarm occurs for any one of Alarm 

level 1 to 4.  
Text indicating the alarm kind is not displayed. 

Text showing the alarm kind is not displayed when Channel alarm is 
OFF.

Color [Red], [Orange], [Lime], 
[Yellow], [Pink], [Black], 
[White]

This is the color for display when no alarm has occurred.

Level 1 [Red], [Orange], [Lime], 
[Yellow], [Pink], [Black], 
[White], [ALARM]

This is the character color for display at the time of occurrence of a 
level 1 alarm. 
ALARM: �This is the alarm display color set for each alarm level.  

The alarm levels are [1] and [All]. 
Level 2 Same choice as for “level 1” This is the character color for display at the time of occurrence of a 

level 2 alarm. 
ALARM: �This is the alarm display color set for each alarm level.  

The alarm levels are [2] and [All]. 
Level 3 Same choice as for “level 1” This is the character color for display at the time of occurrence of a 

level 3 alarm. 
ALARM: �This is the alarm display color set for each alarm level.  

The alarm levels are [3] and [All]. 
Level 4 Same choice as for “level 1” This is the character color for display at the time of occurrence of a 

level 4 alarm. 
ALARM: �This is the alarm display color set for each alarm level.  

The alarm levels are [4] and [All]. 
Alarm kind display [Off], [On] This selects display (On) / no display (Off) of strings that indicate 

alarm kind.

Synchronize action
►Section 3.3

3.12  Attributes of Alarm Indicator Components
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3.13	 System Icon Component Attribute

(Can only be set with a Version 4.01 screen and a Version 4.11 screen)

		   

The following restrictions apply to the attribute settings of system icon components.
•	 [Visible] can only be set when [Depend ID] is set to [None]. 

List of Settings
Refer to Section 3.3 for attributes without explanations in the list of settings.

Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

X DX1000: 0 to 318
DX2000: 0 to 638 

This is the X-coordinate of the left side of the component. 
When X < 0, X = 0
When (X + size) > max. width*1, X = (max. width - size)

Y DX1000: 24(0) to 238
DX2000: 40(0) to 478 
(   ) = Status area set to No 
display

This is the Y-coordinate of the right side of the component. 
When Y < min. Y*2, Y = min. Y*2
When (Y + size) > (min. Y*2 + max. height*3), Y = (min. Y*2 + max. 
height*3 - size)

Type [Memory sample], [Alarm], 
[CF card], [Math], [Key lock], 
[Email], [Status], [Key & 
email], [UserLock], [User & 
status]

Selects the kind of system icon to display. 

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display
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Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

Size [24], [32] The size of the displayed icon. 
When creating components, using length A of the shortest side of 
the dotted frame as a reference, the size is 24 or 32, whichever is 
closest. 
When A ≥ 28, the size is [32]
When A < 28, the size is [24]

Background color [Red], [Green, [Blue], 
[B.violet], [Brown], [Orange], 
[Y.green], [Light blue], [Violet], 
[Gray], [Lime], [Cyan], [Dark 
blue], [Yellow], [Light gray], 
[Purple], [Pink], [L.brown], 
[L.green], [Dark gray], [Olive], 
[Dark cyan], [S.green], 
[Black], [White], [Background 
color]

This is the color that fills the background of the component. 

BG transparent [Off], [On] On:  �The background of the DX recorder execution panel is 
transparent  
The software screen construction area shows the frame as a 
dotted line, and indicates that the background transparency is 
On.

Note:  �The background transparency is valid when a trend 
display component exists under the system icon 
component that completely overlaps with it. The 
transparency is invalid if the system icon component 
protrudes from the trend component. 

Synchronize action
►Section 3.3

3.13  System Icon Component Attribute
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3.14	 Attribute of Memory Bar Components

(Can only be set with a Version 4.01 screen and a Version 4.11 screen)

		   

The following restrictions apply to the attribute settings of Memory bar components. 
•	 [Visible] can only be set when [Depend ID] is set to [None]. 
•	 When [Data type] is [Display], [Color(pre-Trig)] cannot be set. 
•	 When [Rem. time display] is [Off] and [Data type] is [Display], [Font] and [String color] 

cannot be set.
•	 If the Batch function is Off or On in the settings file, [Batch group no.] cannot be set. 
•	 The MultiBatch number specified in the settings file is the maximum value for [Batch 

group no.]. 
List of Settings
Refer to Section 3.3 for attributes without explanations in the list of settings.

Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

X DX1000: 0 to 318
DX2000: 0 to 638

This is the X-coordinate of the left side of the component.
When X < 0, X = 0
When (X + size) > max. width*1, X = (max. width - size)

Y DX1000: 24(0) to 238
DX2000: 40(0) to 478 
(   ) = Status area set to No 
display

This is the Y-coordinate of the right side of the component. 
When Y < min. Y*2, Y = min. Y*2

When (Y + size) > (min. Y*2 + max. height*3), Y = (min. Y*2 + max. 
height*3 - size)

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display
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Attribute Set value/choice 
(Underlined items are initial 
set values)

Description, conditions

Width DX1000: 2 to 320
DX2000: 2 to 640

This is the component width.
Width = 2 for width < 2 
X = (Max. width*1 – Width) for width < Max. width*1 and (X + Width) > 
Max. width*1
Width = Max. width*1, X = 0 for width ≥ Max. width*1

Height DX1000: 2 to 216(240)
DX2000: 2 to 440(480)
(   ) = Status area set to No 
display

This is the component height.
Height = 2 for height < 2
Y = (Min. Y*2 + Max. height*3 – Height) for height < Max. height*3 and (Y 
+ Height) > (Min. Y*2 + Max. height*3)
Height = Max. height*3, Y = Min. Y*2 for height ≥ Max. height*3, Y = 
min. Y*2

Batch group number Setting range:  1 to multi-
batch number set by the 
basic settings of the DX 
recorder
DX1000: [1] to [6]
DX2000 standard memory:

[1] to [6]
DX2000 expanded memory:

[1] to [12]

This is the batch group no. which can be selected within the range of 
the multi-batch number set by the basic settings of the DX recorder. 
This item is not displayed when multi-batch is Off. 

Data type [Display], [event] Select the type of data to display in the Memory bar. 
When the data type specified here is sent to the DX recorder, it 
automatically changes to a valid setting on the DX recorder. For 
example, even if you set the Memory bar data type to [Display] and 
send it to the DX recorder, if the DX recorder’s memory type in Basic 
setting mode is Event, the data type from the memory sample bar is 
changed to [Event]. 

Direction [Vertical], [Horizontal] Sets the direction of bar graphs. 
The default value differs depending on the vertical-to-horizontal size 
ratio of the plotted component. 
If the component is taller than it is wide, the direction is [Vertical]
If the component is wider than it is tall, the direction is [Horizontal]
Vertical: The bar expands vertically from bottom to top. 
Horizontal: The bar expands horizontally from left to right. 

Rem. time display [Off], [On] Sets whether or not to display the remaining sampling time in the 
Memory bar. 
On: Displayed
Off: Not displayed

Font [Font5], [Font6], [Font8], 
[Font12], [Font16] 

This is the display font for the text label that shows the remaining time 
and event data status. 

Color [Red], [Green, [Blue], 
[B.violet], [Brown], [Orange], 
[Y.green], [Light blue], [Violet], 
[Gray], [Lime], [Cyan], [Dark 
blue], [Yellow], [Light gray], 
[Purple], [Pink], [L.brown], 
[L.green], [Dark gray], [Olive], 
[Dark cyan], [S.green], 
[Black], [White], [Background 
color]

The color of the bar graph.
Background color: Base color (base color of the screen)

Background color Same choices as for [Color] This is the color of the fill for the background.
The default setting is [Background color].

Color(pre-Trig) Same choices as for [Color] This is the color of the bar during a trigger wait. 
The default setting is [Orange].

String color Same choices as for [Color] This is the display color for the text label that shows the remaining 
time and event data status. 
The default setting is [Black].

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display

Synchronize action
►Section 3.3

3.14  Attribute of Memory Bar Components
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3.15	 Attributes of Time Label Component

(Can only be set with a Version 4.01 screen and a Version 4.11 screen)

		   

The following restrictions apply to the attribute settings of Time label components. 
•	 [Visible] can only be set when [Depend ID] is set to [None]. 
•	 When [NoDate display] is [On], [2 Line display] cannot be set.
•	 When [Time display] is [Off], [2 Line display] and [Second display] cannot be set. 
•	 When [NoDate display]  is [On], [Year display form] cannot be set. 

List of Settings
Refer to Section 3.3 for attributes without explanations in the list of settings.

Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

X DX1000: 0 to 318
DX2000: 0 to 638

This is the X-coordinate of the left side of the component.
X = 0 for X < 0
X = (Max. width*1 – Width) for (X + Width) > Max. width*1

Y DX1000: 24(0) to 238
DX2000: 40(0) to 478 
(   ) = Status area set to No 
display

This is the Y-coordinate of the right side of the component. 
When Y < min. Y*2, Y = min. Y*2

When (Y + size) > (min. Y*2 + max. height*3), Y = (min. Y*2 + max. 
height*3 - size)

Width DX1000: 2 to 320
DX2000: 2 to 640

This is the component width.
Width = 2 for width < 2 
X = (Max. width*1 – Width) for width < Max. width*1 and (X + Width) > 
Max. width*1

Width = Max. width*1, X = 0 for width ≥ Max. width*1

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display
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Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

Height DX1000: 2 to 216(240)
DX2000: 2 to 440(480)
(   ) = Status area set to No 
display

This is the component height.
Height = 2 for height < 2
Y = (Min. Y*2 + Max. height*3 – Height) for height < Max. height*3 and (Y 
+ Height) > (Min. Y*2 + Max. height*3)
Height = Max. height*3, Y = Min. Y*2 for height ≥ Max. height*3, Y = 
min. Y*2

NoDate display [Off], [On] Selects Display/No display for the date. 
Off: Date is displayed
On: Date not displayed

Year display form [None], [4digits], [2digits] Selects the number of digits for the year. 
None: The year is not displayed
4digits: The year is displayed in yyyy format
2digits: The year is displayed in yy format

Time display [Off], [On] Select Display/No display for the time. 
Off: The time is not displayed
On: The time is displayed

Second display [Off], [On] Selects Display/No display for the seconds. 
Off: The seconds are not displayed
On: The seconds are displayed

Vertical display
(can only be set with 
a Version4 screen)

[Off], [On] Sets whether or not to display the date time label display vertically. 
[On]: Rotates the text label 90 degrees clockwise. 
[Off]: Displays the text label horizontally. 

Font [Font5], [Font6], [Font8], 
[Font12], [Font16] 

This is the font for displaying the time. 
The default settings are: DX1000 = [Font6]; and DX2000 = [Font8]. 

Color [Red], [Green, [Blue], 
[B.violet], [Brown], [Orange], 
[Y.green], [Light blue], [Violet], 
[Gray], [Lime], [Cyan], [Dark 
blue], [Yellow], [Light gray], 
[Purple], [Pink], [L.brown], 
[L.green], [Dark gray], [Olive], 
[Dark cyan], [S.green], 
[Black], [White], [Background 
color]

The display color of the time. 
Background color:  Base color (base color of the screen)

Background color Same choice as for [Color] This is the color of the fill for the label area. 
The default setting is [Background color].

Arrangement [Left], [Center], [Right] This is the arrangement along the X axis within the label area. 
It is always centered along the Y-axis. 
Left: Text label is left justified
Center: Text label is centered
Right: Text label is right justified

Gap [0] to [15]  Specifies a distance between characters in dots. 
BG transparent [Off], [On] On:  �The background in the DX recorder execution panel is 

transparent  
The software screen construction area shows the frame as a 
dotted line, and indicates that the background transparency is 
On. 

Note:  �The background transparency is valid when a trend 
display component exists under the Time label component 
that completely overlaps with it. The transparency is 
invalid if the time label component protrudes from the 
trend display component.

2 Line display [Off], [On] On: �The date and time are displayed in 2 lines in the DX recorder 
execution panel. 
The date and time are displayed in 2 lines, respectively. 
When [NoDate display] is [On], the Time label takes 1 row. 

Off: 2-line display not used. 
*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display
Synchronize action
►Section 3.3

3.15  Attributes of Time Label Component
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3.16	 Attributes of Batch Group Number 
Components

(Can only be set with a Version 4.01 screen and a Version 4.11 screen)

		   

The following restrictions apply to the attribute settings of batch group number 
components. 
•	 [Visible] can only be set when [Depend ID] is set to [None].  
•	 The MultiBatch number specified in the settings file is the maximum value for [Batch 

group no.].
•	 If the Batch function is Off or On in the settings file, a batch group number component 

cannot be created. For existing batch group number components, no attributes other 
than X, Y, Width, and Height can be set.

List of Settings
Refer to Section 3.3 for attributes without explanations in the list of settings.

Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

X DX1000: 0 to 318
DX2000: 0 to 638

This is the X-coordinate of the left side of the component.
X = 0 for X < 0
X = (Max. width*1 – Width) for (X + Width) > Max. width*1

Y DX1000: 24(0) to 238
DX2000: 40(0) to 478 
(   ) = Status area set to No 
display

This is the Y-coordinate of the right side of the component. 
When Y < min. Y*2, Y = min. Y*2

When (Y + size) > (min. Y*2 + max. height*3), Y = (min. Y*2 + max. 
height*3 - size)

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display
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Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

Width DX1000: 2 to 320
DX2000: 2 to 640

This is the component width.
Width = 2 for width < 2 
X = (Max. width*1 – Width) for width < Max. width*1 and (X + Width) > 
Max. width*1

Width = Max. width*1, X = 0 for width ≥ Max. width*1

Height DX1000: 2 to 216(240)
DX2000: 2 to 440(480)
(   ) = Status area set to No 
display

This is the component height.
Height = 2 for height < 2
Y = (Max. height*3 – Height) for height < Max. height*3 and (Y + 
Height) > Max. height*3

Height = Max. height*3, Y = 0 for height ≥ Max. height*3

Batch group number Setting range:  1 to multi-
batch number set by the 
basic settings of the DX 
recorder
DX1000: [1] to [6]
DX2000 standard memory:

[1] to [6]
DX2000 expanded memory:

[1] to [12]

This is the batch group no. which can be selected within the range of 
the multi-batch number set by the basic settings of the DX recorder. 
This item is not displayed when multi-batch is Off. 

Disp.in BATOverview [Off], [On] Turns the display On/Off for when a screen being displayed is in 
Common mode. 
On: Number indicated by the batch group number is displayed
Off: Not displayed

Vertical display [Off], [On] Sets whether or not to display the batch group number vertically. 
[On]: Rotates the text label 90 degrees clockwise. 
[Off]: Displays the text label horizontally. 

Font [Font5], [Font6], [Font8], 
[Font12], [Font16] 

This is the font for displaying the batch group number. 
The default settings are: DX1000 = [Font6]; and DX2000 = [Font8]. 

Color [Red], [Green, [Blue], [B.violet], 
[Brown], [Orange], [Y.green], 
[Light blue], [Violet], [Gray], 
[Lime], [Cyan], [Dark blue], 
[Yellow], [Light gray], [Purple], 
[Pink], [L.brown], [L.green], 
[Dark gray], [Olive], [Dark 
cyan], [S.green], [Black], 
[White], [Background color]

The color of the text label. 
Background color: Base color (background color of the screen)

Background color Same choices as for [Color], 
and [None]

This is the color of the background. 
None: No background fill color 

Arrangement [Left], [Center], [Right] This is the arrangement of the text label along the X axis of the batch 
group number. 
It is always centered along the Y-axis. 
Left: Text label is left justified
Center: Text label is centered
Right: Text label is right justified

Gap [0] to [15] Specifies a distance between characters in dots. 
*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display

Synchronize action
►Section 3.3

3.16  Attributes of Batch Group Number Components
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3.17	 Attributes of Batch Name Components

(Can only be set with a Version 4.01 screen and a Version 4.11 screen)

		   

The following restrictions apply to the attribute settings of batch name components. 
•	 [Visible] can only be set when [Depend ID] is set to [None]. 
•	� When the Batch function is Off in the settings file, no attributes other than X, Y, Width, 

and Height can be set.
•	 If the Batch function is On in the settings file, [Batch group no.] cannot be set. 
•	� The MultiBatch number specified in the settings file is the maximum value for [Batch 

group no.]. 
List of Settings
Refer to Section 3.3 for attributes without explanations in the list of settings.

Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

X DX1000: 0 to 318
DX2000: 0 to 638

This is the X-coordinate of the left side of the component.
X = 0 for X < 0
X = (Max. width*1 – Width) for (X + Width) > Max. width*1

Y DX1000: 24(0) to 238
DX2000: 40(0) to 478 
(   ) = Status area set to No 
display

This is the Y-coordinate of the right side of the component. 
When Y < min. Y*2, Y = min. Y*2

When (Y + size) > (min. Y*2 + max. height*3), Y = (min. Y*2 + max. 
height*3 - size

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display
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Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

Width DX1000: 2 to 320
DX2000: 2 to 640

This is the component width.
Width = 2 for width < 2 
X = (Max. width*1 – Width) for width < Max. width*1 and (X + Width) > 
Max. width*1

Width = Max. width*1, X = 0 for width ≥ Max. width*1

Height DX1000: 2 to 216(240)
DX2000: 2 to 440(480)
(   ) = Status area set to No 
display

This is the component height.
Height = 2 for height < 2
Y = (Max. height*3 – Height) for height < Max. height*3 and (Y + 
Height) > Max. height*3

Height = Max. height*3, Y = 0 for height ≥ Max. height*3

Batch group number Setting range:  1 to multi-
batch number set by the 
basic settings of the DX 
recorder
DX1000: [1] to [6]
DX2000 standard memory:

[1] to [6]
DX2000 expanded memory:

[1] to [12]

This is the batch group no. which can be selected within the range of 
the multi-batch number set by the basic settings of the DX recorder. 
This item is not displayed when multi-batch is Off. 

Vertical display [Off], [On] Sets whether or not to display the batch name vertically. 
[On]: Rotates the text label 90 degrees clockwise. 
[Off]: Displays the text label horizontally.

Font [Font5], [Font6], [Font8], 
[Font12], [Font16]

This is the font for displaying the batch group number. 
The default settings are: DX1000 = [Font6]; and DX2000 = [Font8]. 

Gap [0] to [15] The interval between characters is specified in dots.
Color [Red], [Green, [Blue], 

[B.violet], [Brown], [Orange], 
[Y.green], [Light blue], [Violet], 
[Gray], [Lime], [Cyan], [Dark 
blue], [Yellow], [Light gray], 
[Purple], [Pink], [L.brown], 
[L.green], [Dark gray], [Olive], 
[Dark cyan], [S.green], 
[Black], [White], [Background 
color]

The color of the text label. 
Background color: Base color (background color of the screen)

Background color Same choices as for [Color] This is the color of the background. 
The default setting is [Background color]. 

Arrangement [Left], [Center], [Right] This is the arrangement of the text label along the X axis of the batch 
name. 
The Y-axis direction always is arranged at the center. 
Left: Text is displayed left-aligned.
Center: Text is displayed centered.
Right: Text is displayed right-aligned. 

Gap [0] to [15] Specifies a distance between characters in dots. 
BG transparent
(can only be set 
with a Version 4.11 
screen)

[Off], [On] On:  �The background of the DX recorder execution panel is 
transparent  
The software screen construction area shows the frame as a 
dotted line, and indicates that the background transparency is 
On.

Note:  �The background transparency is valid when a trend 
display component exists under the batch name 
component that completely overlaps with it. The 
transparency is invalid if the batch name component 
protrudes from the trend component. 

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display

3.17  Attributes of Batch Name Components
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Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

2 Line display [Off], [On] On: �Batch name displayed in 2 lines in the DX recorder execution 
panel. 

Off: �Batch name not displayed in 2 lines in the DX recorder execution 
panel. 

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display

Synchronize action
►Section 3.3

3.17  Attributes of Batch Name Components
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3.18	 Attributes of Group Name Components

(Can only be set with a Version 4.01 screen and a Version 4.11 screen)

		   

If there is no settings file, or if the Batch function is Off or On, the displayed text label is 
[GROUP] + number. 
If there is no settings file, or if the Batch function is MultiBatch, the displayed text label is 
[BATCH] + batch number + [-] + group number. 
The following restrictions apply to the attribute settings of group name components. 
•	 [Visible] can only be set when [Depend ID] is set to [None]. 
•	 If the Batch function is Off or On in the settings file, [Batch group no.] cannot be set. 
•	� The MultiBatch number specified in the settings file is the maximum value for [Batch 

group no.].
List of Settings
Refer to Section 3.3 for attributes without explanations in the list of settings.

Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

X DX1000: 0 to 318
DX2000: 0 to 638

This is the X-coordinate of the left side of the component.
X = 0 for X < 0
X = (Max. width*1 – Width) for (X + Width) > Max. width*1

Y DX1000: 24(0) to 238
DX2000: 40(0) to 478 
(   ) = Status area set to No 
display

This is the Y-coordinate of the right side of the component. 
When Y < min. Y*2, Y = min. Y*2

When (Y + size) > (min. Y*2 + max. height*3), Y = (min. Y*2 + max. 
height*3 - size

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display
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Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

Width DX1000: 2 to 320
DX2000: 2 to 640

This is the component width.
Width = 2 for width < 2 
X = (Max. width*1 – Width) for width < Max. width*1 and (X + Width) > 
Max. width*1

Width = Max. width*1, X = 0 for width ≥ Max. width*1

Height DX1000: 2 to 216(240)
DX2000: 2 to 440(480)
(   ) = Status area set to No 
display

This is the component height.
Height = 2 for height < 2
Y = (Max. height*3 – Height) for height < Max. height*3 and (Y + 
Height) > Max. height*3

Height = Max. height*3, Y = 0 for height ≥ Max. height*3

Batch group number Setting range:  1 to multi-
batch number set by the 
basic settings of the DX 
recorder
DX1000: [1] to [6]
DX2000 standard memory:

[1] to [6]
DX2000 expanded memory:

[1] to [12]

This is the batch group no. which can be selected within the range of 
the multi-batch number set by the basic settings of the DX recorder. 
This item is not displayed when multi-batch is Off.

Group No. When the Batch function if 
Off or On
DX1000: [1] to [10]
DX2000: [1] to [36]
When the Batch function is 
MultiBatch
DX1000: [1] to [6]
DX2000: [1] to [12] 

Sets the Group No. 
Display on the builder screen of the DX recorder is made as “Group 
No.”.

Display group 
switching (“Group 
switching” on the 
DX recorder builder 
screen)

[Off], [On] Sets whether or not to switch display groups. 
Off: Display groups not switched
On: Display groups switched

Vertical display [Off], [On] Sets whether or not to display the batch group name vertically. 
[On]: Rotates the text label 90 degrees clockwise. 
[Off]: Displays the text label horizontally.

Font [Font5], [Font6], [Font8], 
[Font12], [Font16]

This is the font for displaying the batch group number. 
The default settings are: DX1000 = [Font6]; and DX2000 = [Font8].

Color [Red], [Green], [Blue], 
[B.violet], [Brown], [Orange], 
[Y.green], [Light blue], [Violet], 
[Gray], [Lime], [Cyan], [Dark 
blue], [Yellow], [Light gray], 
[Purple], [Pink], [L.brown], 
[L.green], [Dark gray], [Olive], 
[Dark cyan], [S.green], 
[Black], [White], [BASE]

The color of the text label. 
Background color: Base color (background color of the screen)

Background color Same choice as for “Color”, 
[None]

This is the color of the component area.
None: No background fill color

Arrangement [Left], [Center], [Right] This is the arrangement of the text label along the X axis of the group 
name. 
The Y-axis direction always is arranged at the center. 
Left: Text is displayed left-aligned.
Center: Text is displayed centered.
Right: Text is displayed right-aligned. 

Gap [0] to [15]  Specifies a distance between characters in dots. 
2 Line display [Off], [On] On: �Batch name displayed in 2 lines in the DX recorder execution 

panel. 
Off: �Batch name not displayed in 2 lines in the DX recorder execution 

panel. 
*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display

Synchronize action
►Section 3.3

3.18  Attributes of Group Name Components
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3.19	 Attributes of Label Components

		   

You can double-click a component to directly input a text label on the component. After 
input, press the Return key or click the mouse anywhere outside the component to 
finalize the entry. 
If the font is taller than the component, the text label input area becomes as tall as the 
font. 
If the 64-character limit is exceeded, the characters over the limit are deleted. 
The following restrictions apply to the attribute settings of label components. 
•	 [Visible] can only be set when [Depend ID] is set to [None]. 

List of Settings
Refer to Section 3.3 for attributes without explanations in the list of settings.

Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

X DX1000: 0 to 318
DX2000: 0 to 638

This is the X-coordinate of the left side of the component.
X = 0 for X < 0
X = (Max. width*1 – Width) for (X + Width) > Max. width*1

Y DX1000: 24(0) to 238
DX2000: 40(0) to 478 
(   ) = Status area set to No 
display

This is the Y-coordinate of the upper side of the component.
Y = Min. Y*2 for Y < Min. Y*2

Y = (Min. Y*2 + Max. height*3 – Height) for (Y + Height) > (Min. Y*2 + 
Max. height*3)

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display
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Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

Width DX1000: 2 to 320
DX2000: 2 to 640

This is the component width.
Width = 2 for width < 2 
X = (Max. width*1 – Width) for width < Max. width*1 and (X + Width) > 
Max. width*1

Width = Max. width*1, X = 0 for width ≥ Max. width*1

Height DX1000: 2 to 216(240)
DX2000: 2 to 440(480)
(   ) = Status area set to No 
display

This is the component height.
Height = 2 for height < 2
Y = (Min. Y*2 + Max. height*3 – Height) for height < Max. height*3 and (Y 
+ Height) > (Min. Y*2 + Max. height*3)
Height = Max. height*3, Y = Min. Y*2 for height ≥ Max. height*3

Text Labels Label The text label displayed on screen. Up to 64 characters (or 32 double-
byte characters) can be displayed. 

Vertical display 
(can only be set with 
a Version 4.01 screen 
and a Version 4.11 
screen)

[Off], [On] Sets whether or not to display the label display vertically. 
[On]: Rotates the text label 90 degrees clockwise. 
[Off]: Displays the text label horizontally. 

Font [Font5], [Font6], [Font8], 
[Font12], [Font16], [Font32]

This is the font for display of component text strings. 
This is the character size for the Tag no. of a component. The initial 
setting is [Font6] for DX1000 and [Font8] for DX2000.

Color [Red], [Green, [Blue], [B.violet], 
[Brown], [Orange], [Y.green], 
[Light blue], [Violet], [Gray], 
[Lime], [Cyan], [Dark blue], 
[Yellow], [Light gray], [Purple], 
[Pink], [L.brown], [L.green], 
[Dark gray], [Olive], [Dark 
cyan], [S.green], [Black], 
[White], [Background color]

This is the color of the text.
Background color: Base color (base color of the screen)

Background color Same choices as for [Color], 
and [None]

This is the color of the background of the label area. 
None: No background fill color 

Arrangement [Left], [Center], [Right] This is an arrangement kind for text strings in horizontal direction in 
the label display area.
It is always centered along the Y-axis. 
Left: Text label is left justified
Center: Text label is centered
Right: Text label is right justified 

Gap [0] to [15] Specifies a distance between characters in dots. 

Synchronize action
►Section 3.3

3.19  Attributes of Label Components



3-41IM 04L41B01-62EN

1

2

3

4

5

Index

D
etailed Inform

ation for A
ttributes of Screens and C

om
ponents

3.20	 Attributes of Push Button Components

		   

You can double-click a component to directly input a text label on the component. After 
input, press the Return key or click the mouse anywhere outside the component to 
finalize the entry. 
If the font is taller than the component, the text label input area becomes as tall as the 
font. 
If the 64-character limit is exceeded, the characters over the limit are deleted. 
The following restrictions apply to the attribute settings of push button components. 
•	 [Visible] can only be set when [Depend ID] is set to [None]. 

List of Settings
Refer to Section 3.3 for attributes without explanations in the list of settings.

Attribute Set value/choice 
(Underlined items are initial 
set values)

Description, conditions

X DX1000: 0 to 318
DX2000: 0 to 638

This is the X-coordinate of the left side of the component.
X = 0 for X < 0
X = (Max. width*1 – Width) for (X + Width) > Max. width*1

Y DX1000: 24(0) to 238
DX2000: 40(0) to 478 
(   ) = Status area set to No 
display

This is the Y-coordinate of the upper side of the component.
Y = Min. Y*2 for Y < Min. Y*2

Y = (Min. Y*2 + Max. height*3 – Height) for (Y + Height) > (Min. Y*2 + 
Max. height*3)

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display
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Attribute Set value/choice 
(Underlined items are initial 
set values)

Description, conditions

Width DX1000: 2 to 320
DX2000: 2 to 640

This is the component width.
Width = 2 for width < 2  
X = (Max. width*1 – Width) for width < Max. width*1 and (X + Width) > 
Max. width*1

Width = Max. width*1, X = 0 for width ≥ Max. width*1

Height DX1000: 2 to 216(240)
DX2000: 2 to 440(480)
(   ) = Status area set to No 
display

This is the component height.
Height = 2 for height < 2
Y = (Min. Y*2 + Max. height*3 – Height) for height < Max. height*3 and (Y 
+ Height) > (Min. Y*2 + Max. height*3)
Height = Max. height*3, Y = Min. Y*2 for height ≥ Max. height*3

Text label “PushButton” This is text displayed on a button. Input of max 64 characters is 
possible.

Font [Font5], [Font6], [Font8], 
[Font12], [Font16]

This is the font for display of text strings.
The initial setting is [Font6] for DX1000 and [Font8] for DX2000.

Event edge switch [1] to [30] —
Action prompt [Off], [On] This selects use/no use of dialog boxes confirming execution of an 

action function. 
Off: Dialog boxes are not used 
On: Dialog boxes are used 

Arrangement [Left], [Center], [Right] This is the text arrangement in direction of the X-axis.
The Y-axis direction always is arranged at the center. 
Left: Text is displayed left-aligned.
Center: Text is displayed centered.
Right: Text is displayed right-aligned. 

Color [Red], [Green], [Blue], 
[B.violet], [Brown], [Orange], 
[Y.green], [Light blue], [Violet], 
[Gray], [Lime], [Cyan], [Dark 
blue], [Yellow], [Light gray], 
[Purple], [Pink], [L.brown], 
[L.green], [Dark gray], [Olive], 
[Dark cyan], [S.green], 
[Black], [White], [BASE]

This is the text display color. 
BASE: Base color (background color of the screen)

Background color Same choice as for “Color”, 
[BASE]

This is the background color of the push button.

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display

Synchronize action
►Section 3.3

3.20  Attributes of Push Button Components
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3.21	 Attributes of Switch Components

		   

Only when [String display] is [On], you can directly input an On or Off text label. You can 
change the On and Off text label within the screen construction area of switches whose 
[Style] is [Selector], [Seesaw], [Lever], [Toggle], [SlideX], or [SlideY]. 
For switches whose [Style] is [Connector], [Push], or [Power], you can change the Off 
text label in the screen construction area. The procedure for entering a text label directly 
is to double-click the text label in the component. After input, press the Return key or 
click the mouse anywhere outside the component to finalize the entry. If the font is taller 
than the component, the text label input area becomes as tall as the font. 
If more than 8 characters are entered, the characters after the 8th are deleted. 

The following limitations exist for setting of attributes of switch components.
•	 [Visible] can only be set when [Depend ID] is set to [None]. 
•	 Setting of Font, Gap, On Text, and Off Text is not possible when Text display is [Off].
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List of Settings
Refer to Section 3.3 for attributes without explanations in the list of settings.

Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

X DX1000: 0 to 318
DX2000: 0 to 638

This is the X-coordinate of the left side of the component.
X = 0 for X < 0
X = (Max. width*1 – Width) for (X + Width) > Max. width*1

Y DX1000: 24(0) to 238
DX2000: 40(0) to 478 
(   ) = Status area set to No 
display

This is the Y-coordinate of the upper side of the component.
Y = Min. Y*2 for Y < Min. Y*2

Y = (Min. Y*2 + Max. height*3 – Height) for (Y + Height) > (Min. Y*2 + 
Max. height*3)

Width DX1000: 2 to 320
DX2000: 2 to 640

This is the component width.
Width = 2 for width < 2 
X = (Max. width*1 – Width) for width < Max. width*1 and (X + Width) > 
Max. width*1

Width = Max. width*1, X = 0 for width ≥ Max. width*1

Height DX1000: 2 to 216(240)
DX2000: 2 to 440(480)
(   ) = Status area set to No 
display

This is the component height.
Height = 2 for height < 2
Y = (Max. height*3 – Height) for height < Max. height*3 and (Y + 
Height) > Max. height*3

Height = Max. height*3, Y = 0 for height ≥ Max. height*3

Style [Selector], [Seesaw], [Lever], 
[SlideX], [SlideY], [Push], 
[Power], [Connector],  
[Toggle]

This is the switch display kind.

Event level switch [1] to [30] —
Action prompt [Off], [On] This selects use/no use of dialog boxes confirming execution of an 

action function. 
Off: Dialog boxes are not used 
On: Dialog boxes are used 

Color [Red], [Green], [Blue], 
[B.violet], [Brown], [Orange], 
[Y.green], [Light blue], [Violet], 
[Gray], [Lime], [Cyan], [Dark 
blue], [Yellow], [Light gray], 
[Purple], [Pink], [L.brown], 
[L.green], [Dark gray], [Olive], 
[Dark cyan], [S.green], 
[Black], [White], [BASE]

This is the switch color. 
BASE: Base color (background color of the screen) 

On color Same choice as for “Color”, 
[Cyan]

This is the color when the switch is ON. 
The color at the time of ON is not displayed on the builder screen of 
the DX recorder.

Off color Same choice as for “Color” This is the color when the switch is OFF. 
The initial setting is [BASE].

String display [Off], [On] ON: Display of On Text and Off Text 
Off: No display of On Text and Off Text 

Font [Font5], [Font6], [Font8], 
Font12], [Font16]

This is the size of On/Off text.
The initial setting is [Font6] for DX1000 and [Font8] for DX2000.

Gap [0] to [15] The interval between characters is specified in dots.
On string “ON” This is text showing ON. 

Input of max. 8 single-byte characters is possible. ON Text is not 
displayed on the execution screen of the DX recorder when “Style” is 
[Push], [Power], or [Connector]. 

Off string “OFF” This is text showing OFF. Input of up to 8 single-byte characters is 
possible.

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display

Synchronize action
►Section 3.3

3.21  Attributes of Switch Components
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3.22	 Attributes of Communication Input 
Components

		   

The displayed width of the component frame is 1 dot for the DX1000 and 2 dots for the 
DX2000. 
The following limitations exist for attribute setting for communication input components. 
•	 [Visible] can only be set when [Depend ID] is set to [None]. 
•	 Switching the max. value and the min. value is not possible.
•	 If a value smaller than [Minimum] is input for [Maximum], [Minimum] becomes that 

value. 
•	 If a value larger than [Maximum] is input for [Minimum], [Maximum] becomes that 

value. 

List of Settings
Refer to Section 3.3 for attributes without explanations in the list of settings.

Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

X DX1000: 0 to 318
DX2000: 0 to 638

This is the X-coordinate of the left side of the component.
X = 0 for X < 0
X = (Max. width*1 – Width) for (X + Width) > Max. width*1

Y DX1000: 24(0) to 238
DX2000: 40(0) to 478 
(   ) = Status area set to No 
display

This is the Y-coordinate of the upper side of the component.
Y = Min. Y*2 for Y < Min. Y*2

Y = (Min. Y*2 + Max. height*3 – Height) for (Y + Height) > (Min. Y*2 + 
Max. height*3)

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display
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Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

Width DX1000: 2 to 320
DX2000: 2 to 640

This is the component width.
Width = 2 for width < 2 
X = (Max. width*1 – Width) for width < Max. width*1 and (X + Width) 
> Max. width*1

Width = Max. width*1, X = 0 for width ≥ Max. width*1

Height DX1000: 2 to 216(240)
DX2000: 2 to 440(480)
(   ) = Status area set to No 
display

This is the component height.
Height = 2 for height < 2
Y = (Max. height*3 – Height) for height < Max. height*3 and (Y + 
Height) > Max. height*3

Height = Max. height*3, Y = 0 for height ≥ Max. height*3

Commu data no DX1000: 1 to 24 
DX2000: 1 to 60 

This is the communication data number that is entered and 
displayed. 

Decimal place (can 
only be set with a 
Version 4.11 screen)

0 to 4 This is the decimal place of the device that you have connected 
using Modbus, which is set by the specification of the number of 
digits to the right of the decimal point.
You can match the decimal place of the DX to the fixed decimal 
place of the connected device to display input values or, using 
action functions, write values to the device.
If the input value cannot be displayed using five digits, the sixth digit 
is rounded to display five significant digits in scientific notation.
Example: If there are two decimal places
	 Set value:2
	 Displayed value: 123.45

Minimum –9.9999E+29 to –1.0000E–30
0

1.0000E–30 to 9.9999E+29

The lower limit value that can be input. 
If a value greater than the maximum is entered for the minimum, the 
maximum also becomes that value. 

Maximum –9.9999E+29 to –1.0000E–30
0

1.0000E–30 to 9.9999E+29

The upper limit value that can be input. 
If a value less than the minimum is entered for the maximum, the 
minimum also becomes that value. 

Font [Font5], [Font6], [Font8], 
[Font12], [Font16], [Font32]

This is the font for display of Comment block text.
The default settings are: DX1000 = [Font6]; and DX2000 = [Font8]. 

Color [Red], [Green, [Blue], [B.violet], 
[Brown], [Orange], [Y.green], 
[Light blue], [Violet], [Gray], 
[Lime], [Cyan], [Dark blue], 
[Yellow], [Light gray], [Purple], 
[Pink], [L.brown], [L.green], 
[Dark gray], [Olive], [Dark 
cyan], [S.green], [Black], 
[White], [Background color]

This is the color for display of numerals. 
Background color: Base color (background color of the screen)

Background color Same choices as for [Color] This is the color of the background of the Comm. In area.  
The default setting is [White].

Arrangement [Left], [Center], [Right] This is the arrangement of the text label along the X axis within the 
Comm. In area. 
The Y-axis direction always is arranged at the center. 
Left: Text is displayed left-aligned.
Center: Text is displayed centered.
Right: Text is displayed right-aligned. 

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display

Synchronize action
►Section 3.3

3.22  Attributes of Communication Input Components
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3.23 	 Attributes of Modbus In Component

(Can only be set with a Version 4.01 screen and a Version 4.11 screen)

		

The displayed width of the component frame is 1 dot for the DX1000 and 2 dots for the 
DX2000. 
The following restrictions apply to the attribute settings of Modbus In components. 
•	 [Visible] can only be set when [Depend ID] is set to [None]. 
•	 [Maximum] and [Minimum] are not interchangeable. 
•	 If a value smaller than [Minimum] is input for [Maximum], [Minimum] becomes that 

value. 
•	 If a value larger than [Maximum] is input for [Minimum], [Maximum] becomes that 

value. 

List of Settings
Refer to Section 3.3 for attributes without explanations in the list of settings.

Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

X DX1000: 0 to 318
DX2000: 0 to 638

This is the X-coordinate of the left side of the component.
X = 0 for X < 0
X = (Max. width*1 – Width) for (X + Width) > Max. width*1

Y DX1000: 24(0) to 238
DX2000: 40(0) to 478 
(   ) = Status area set to No 
display

This is the Y-coordinate of the upper side of the component.
Y = Min. Y*2 for Y < Min. Y*2

Y = (Min. Y*2 + Max. height*3 – Height) for (Y + Height) > (Min. Y*2 + 
Max. height*3)

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display
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Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

Width DX1000: 2 to 320
DX2000: 2 to 640

This is the component width.
Width = 2 for width < 2 
X = (Max. width*1 – Width) for width < Max. width*1 and (X + Width) 
> Max. width*1

Width = Max. width*1, X = 0 for width ≥ Max. width*1

Height DX1000: 2 to 216(240)
DX2000: 2 to 440(480)
(   ) = Status area set to No 
display

This is the component height.
Height = 2 for height < 2
Y = (Max. height*3 – Height) for height < Max. height*3 and (Y + 
Height) > Max. height*3

Height = Max. height*3, Y = 0 for height ≥ Max. height*3

Communication [Ethernet], [Serial] Selects a communication kind of [Ethernet] or [Serial]. 
Ethernet: Uses Modbus client send commands
Serial: Uses Modbus master send commands

Command no. [1] to [16] Sets the Modbus send command number specified under 
Communication. 

Decimal place (can 
only be set with a 
Version 4.11 screen)

0 to 4 This is the decimal place of the device that you have connected 
using Modbus, which is set by the specification of the number of 
digits to the right of the decimal point.
You can match the decimal place of the DX to the fixed decimal 
place of the connected device to display input values or, using 
action functions, write values to the device.
If the input value cannot be displayed using five digits, the sixth digit 
is rounded to display five significant digits in scientific notation.
Example: If there are two decimal places
	 Set value:2
	 Displayed value: 123.45

Minimum –9.9999E+29 to –1.0000E–30
0

1.0000E–30 to 9.9999E+29

The lower limit value that can be input. 
If a value greater than the maximum is entered for the minimum, the 
maximum also becomes that value. 

Maximum –9.9999E+29 to –1.0000E–30
0

1.0000E–30 to 9.9999E+29

The upper limit value that can be input. 
If a value less than the minimum is entered for the maximum, the 
minimum also becomes that value. 

Font [Font5], [Font6], [Font8], 
[Font12], [Font16], [Font32]

Set the character size of the Modbus input.
The default settings are: DX1000 = [Font6]; and DX2000 = [Font8]. 

Color [Red], [Green, [Blue], [B.violet], 
[Brown], [Orange], [Y.green], 
[Light blue], [Violet], [Gray], 
[Lime], [Cyan], [Dark blue], 
[Yellow], [Light gray], [Purple], 
[Pink], [L.brown], [L.green], 
[Dark gray], [Olive], [Dark 
cyan], [S.green], [Black], 
[White], [Background color]

Sets the color of the string showing the Modbus input.
Background color: Base color (background color of the screen)

Background color Same choices as for [Color] This is the color of the background of the Modbus In area.  
The default setting is [White].

Arrangement [Left], [Center], [Right] This is the arrangement of the text label along the X axis within the 
Modbus In area.  
The Y-axis direction always is arranged at the center. 
Left: Text is displayed left-aligned.
Center: Text is displayed centered.
Right: Text is displayed right-aligned. 

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display

3.23   Attributes of Modbus In Component
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3.24	 Attributes of Comment Box Components

		   

The following limitations exist for setting of attributes of comment box components.
•	 [Visible] can only be set when [Depend ID] is set to [None].

List of Settings
Refer to Section 3.3 for attributes without explanations in the list of settings.

Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

X DX1000: 0 to 318
DX2000: 0 to 638

This is the X-coordinate of the left side of the component.
X = 0 for X < 0
X = (Max. width*1 – Width) for (X + Width) > Max. width*1

Y DX1000: 24(0) to 238
DX2000: 40(0) to 478 
(   ) = Status area set to No 
display

This is the Y-coordinate of the upper side of the component.
Y = Min. Y*2 for Y < Min. Y*2

Y = (Min. Y*2 + Max. height*3 – Height) for (Y + Height) > (Min. Y*2 + 
Max. height*3)

Width DX1000: 2 to 320
DX2000: 2 to 640

This is the component width.
Width = 2 for width < 2 
X = (Max. width*1 – Width) for width < Max. width*1 and (X + Width) > 
Max. width*1

Width = Max. width*1, X = 0 for width ≥ Max. width*1

Height DX1000: 2 to 216(240)
DX2000: 2 to 440(480)
(   ) = Status area set to No 
display

This is the component height.
Height = 2 for height < 2
Y = (Max. height*3 – Height) for height < Max. height*3 and (Y + 
Height) > Max. height*3

Height = Max. height*3, Y = 0 for height ≥ Max. height*3

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display
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Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

Comment box no DX1000: [1] to [100], 
DX2000: [1] to [200]

—

Font [Font5], [Font6], [Font8], 
[Font12], [Font16]

This is the font for display of Comment block text.
The initial setting is [Font6] for DX1000 and [Font8] for DX2000.

Gap [0] to [15] The interval between characters is specified in dots.
Color [Red], [Green], [Blue], 

[B.violet], [Brown], [Orange], 
[Y.green], [Light blue], [Violet], 
[Gray], [Lime], [Cyan], [Dark 
blue], [Yellow], [Light gray], 
[Purple], [Pink], [L.brown], 
[L.green], [Dark gray], [Olive], 
[Dark cyan], [S.green], 
[Black], [White], [BASE]

The color for display of text.
BASE: Base color (background color of the screen)

Background color Same choice as for “Color”, 
[None]

This is the background color of the Comment box area. 
The initial setting is [BASE].

Arrangement [Left], [Center], [Right] This is the text arrangement in direction of the X-axis in the comment 
box area.
The Y-axis direction always is arranged at the center. 
Left: Text is displayed left-aligned.
Center: Text is displayed centered.
Right: Text is displayed right-aligned. 

Synchronize action
►Section 3.3

3.24  Attributes of Comment Box Components
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3.25	 Attributes of Comment Block Components

		   

The following limitations exist for setting of attributes of comment block components.
•	 [Visible] can only be set when [Depend ID] is set to [None].

List of Settings
Refer to Section 3.3 for attributes without explanations in the list of settings.

Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

X DX1000: 0 to 318
DX2000: 0 to 638

This is the X-coordinate of the left side of the component.
X = 0 for X < 0
X = (Max. width*1 – Width) for (X + Width) > Max. width*1

Y DX1000: 24(0) to 238
DX2000: 40(0) to 478 
(   ) = Status area set to No 
display

This is the Y-coordinate of the upper side of the component.
Y = Min. Y*2 for Y < Min. Y*2

Y = (Min. Y*2 + Max. height*3 – Height) for (Y + Height) > (Min. Y*2 + 
Max. height*3)

Width DX1000: 2 to 320
DX2000: 2 to 640

This is the component width.
Width = 2 for width < 2 
X = (Max. width*1 – Width) for width < Max. width*1 and (X + Width) > 
Max. width*1

Width = Max. width*1, X = 0 for width ≥ Max. width*1

Height DX1000: 2 to 216(240)
DX2000: 2 to 440(480)
(   ) = Status area set to No 
display

This is the component height.
Height = 2 for height < 2
Y = (Max. height*3 – Height) for height < Max. height*3 and (Y + 
Height) > Max. height*3

Height = Max. height*3, Y = 0 for height ≥ Max. height*3

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display
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Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

Comment block no DX1000: [1] to [50],  
DX2000: [1] to [100]

—

Font [Font5], [Font6], [Font8], 
[Font12], [Font16]

This is the font for display of Comment block text.
The initial setting is [Font6] for DX1000 and [Font8] for DX2000.

Gap [0] to [15] The interval between characters is specified in dots.
Line space [0] to [15] The text line space is specified in dots.
Color [Red], [Green], [Blue], 

[B.violet], [Brown], [Orange], 
[Y.green], [Light blue], [Violet], 
[Gray], [Lime], [Cyan], [Dark 
blue], [Yellow], [Light gray], 
[Purple], [Pink], [L.brown], 
[L.green], [Dark gray], [Olive], 
[Dark cyan], [S.green], 
[Black], [White], [BASE]

This is the text display color. 
BASE: Base color (background color of the screen)

Background color Same choice as for “Color”, 
[None]

This is the background color of the Comment block area. 
The initial setting is [BASE].

Arrangement [Left], [Center], [Right] This is the text arrangement in direction of the X-axis in the comment 
block area.
The Y-axis direction always is arranged at the center. 
Left: Text is displayed left-aligned.
Center: Text is displayed centered.
Right: Text is displayed right-aligned. 

Synchronize action
►Section 3.3

3.25  Attributes of Comment Block Components
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3.26	 Attributes of Alarm List Components

		   

The following limitations exist for setting of attributes of alarm list components.
•	 [Visible] can only be set when [Depend ID] is set to [None].
•	 NoDate display is not possible when Time display is [Off]. 

List of Settings
Refer to Section 3.3 for attributes without explanations in the list of settings.

Attribute Set value/choice 
(Underlined items are initial 
set values)

Description, conditions

X DX1000: 0 to 318
DX2000: 0 to 638

This is the X-coordinate of the left side of the component.
X = 0 for X < 0
X = (Max. width*1 – Width) for (X + Width) > Max. width*1

Y DX1000: 24(0) to 238
DX2000: 40(0) to 478 
(   ) = Status area set to No 
display

This is the Y-coordinate of the upper side of the component.
Y = Min. Y*2 for Y < Min. Y*2

Y = (Min. Y*2 + Max. height*3 – Height) for (Y + Height) > (Min. Y*2 + 
Max. height*3)

Width DX1000: 2 to 320
DX2000: 2 to 640

This is the component width.
Width = 2 for width < 2 
X = (Max. width*1 – Width) for width < Max. width*1 and (X + Width) > 
Max. width*1

Width = Max. width*1, X = 0 for width ≥ Max. width*1

Height DX1000: 2 to 216(240)
DX2000: 2 to 440(480)
(   ) = Status area set to No 
display

This is the component height.
Height = 2 for height < 2
Y = (Max. height*3 – Height) for height < Max. height*3 and (Y + 
Height) > Max. height*3

Height = Max. height*3, Y = 0 for height ≥ Max. height*3

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display
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Attribute Set value/choice 
(Underlined items are initial 
set values)

Description, conditions

Batch group number Setting range:  1 to multi-
batch number set by the 
basic settings of the DX 
recorder
DX1000: [1] to [6]
DX2000 standard memory: 
	 [1] to [6]
DX2000 expanded memory: 
	 [1] to [12]

This is the batch group number that can be selected within the range 
of the number of multibatches set in the basic settings on the DX 
recorder. 
This item is not displayed when multi-batch is Off. 

Font [Font6], [Font8] This is the font for Alarm list display. 
The initial setting is [Font6] for DX1000 and [Font8] for DX2000.

BG transparent [Off], [On] ON: �The background color becomes transparent on the execution 
screen of the DX recorder.  
In the Screen construction area of this software, frames are 
displayed by dotted lines to indicate that background transparent 
display is On. 

Caution: �Background transparent display is effective when trend 
components are placed completely overlapping under 
list components. It is not effective when the trend 
components project beyond the list components. 

Color [Red], [Green], [Blue], 
[B.violet], [Brown], [Orange], 
[Y.green], [Light blue], [Violet], 
[Gray], [Lime], [Cyan], [Dark 
blue], [Yellow], [Light gray], 
[Purple], [Pink], [L.brown], 
[L.green], [Dark gray], [Olive], 
[Dark cyan], [S.green], 
[Black], [White], [BASE]

The color for display of text.
BASE: Base color (background color of the screen)

Background color [Black], [White] This is the alarm list background color.
Display mode [List], [Watch] This is the mode for display of the alarm list. 

List: All alarm events are displayed. 
Watch: Only presently active alarms are displayed.

Header display [Off], [On] This selects header display always/not on the execution screen of the 
DX recorder. 
On: Display 
Off: No display 

Mark display [Off], [On] This selects display/no display of alarm event marks and text on 
the execution screen of the DX recorder. No display is made on the 
Screen construction area. 
On: Display 
Off: No display 

Lv&Kind display [Off], [On] This selects display/no display of text showing alarm level and type 
on the execution screen of the DX recorder.
On: Display 
Off: No display 

Time display [Off], [On] This selects display/no display of the alarm time on the execution 
screen of the DX recorder. No display is made in the Screen 
construction area.
On: Display 
Off: No display 

NoDate display [Off], [On] This selects time display without or with the date on the execution 
screen of the DX recorder. No display is made in the Screen 
construction area. 
On: The time is displayed without the date. 
Off: Time and date are displayed. 

2 Line display [Off], [On] On: �One alarm is displayed on two lines on the execution screen of 
the DX recorder.  
Channel text and time are displayed separately on two lines.  
When “Display without date” is [On], the time is displayed on one 
line. 

Off: 2 line display is not performed.

Synchronize action
►Section 3.3

3.26  Attributes of Alarm List Components
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3.27	 Attributes of Message List Components

		   

The following limitations exist for setting of attributes of message list components.
•	 [Visible] can only be set when [Depend ID] is set to [None].
•	 NoDate display is not possible when Time display is [Off].

List of Settings
Refer to Section 3.3 for attributes without explanations in the list of settings.

Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

X DX1000: 0 to 318
DX2000: 0 to 638

This is the X-coordinate of the left side of the component.
X = 0 for X < 0
X = (Max. width*1 – Width) for (X + Width) > Max. width*1

Y DX1000: 24(0) to 238
DX2000: 40(0) to 478 
(   ) = Status area set to No 
display

This is the Y-coordinate of the upper side of the component.
Y = Min. Y*2 for Y < Min. Y*2

Y = (Min. Y*2 + Max. height*3 – Height) for (Y + Height) > (Min. Y*2 + 
Max. height*3)

Width DX1000: 2 to 320
DX2000: 2 to 640

This is the component width.
Width = 2 for width < 2 
X = (Max. width*1 – Width) for width < Max. width*1 and (X + Width) > 
Max. width*1

Width = Max. width*1, X = 0 for width ≥ Max. width*1

Height DX1000: 2 to 216(240)
DX2000: 2 to 440(480)
(   ) = Status area set to No 
display

This is the component height.
Height = 2 for height < 2
Y = (Max. height*3 – Height) for height < Max. height*3 and (Y + 
Height) > Max. height*3

Height = Max. height*3, Y = 0 for height ≥ Max. height*3

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display
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Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

Batch group number Setting range:  1 to multi-
batch number set by the 
basic settings of the DX 
recorder
DX1000: [1] to [6]
DX2000 standard memory: 
	 [1] to [6]
DX2000 expanded memory: 
	 [1] to [12]

This is the batch group number that can be selected within the range 
of the number of multibatches set in the basic settings on the DX 
recorder. 
This item is not displayed when multi-batch is Off.

Font [Font6], [Font8] This is the font for Message list display. 
The initial setting is [Font6] for DX1000 and [Font8] for DX2000.

BG transparent [Off], [On] ON: �The background color becomes transparent on the execution 
screen of the DX recorder.  
In the Screen construction area of this software, frames are 
displayed by dotted lines to indicate that background transparent 
display is On. 

Caution: �Background transparent display is effective when trend 
components are placed completely overlapping under 
list components. It is not effective when the trend 
components project beyond the list components. 

Color [Red], [Green], [Blue], 
[B.violet], [Brown], [Orange], 
[Y.green], [Light blue], [Violet], 
[Gray], [Lime], [Cyan], [Dark 
blue], [Yellow], [Light gray], 
[Purple], [Pink], [L.brown], 
[L.green], [Dark gray], [Olive], 
[Dark cyan], [S.green], 
[Black], [White], [BASE]

The color for display of text.
BASE: Base color (background color of the screen)

Background color [Black], [White] This is the background color for the Message list.
Header display [Off], [On] This selects header display always/not on the execution screen of the 

DX recorder. 
On: Display 
Off: No display

Mark display [Off], [On] This selects display/no display of message marks on the execution 
screen of the DX recorder. No display is made on the Screen 
construction area. 
On: Display 
Off: No display

Time display [Off], [On] This selects display/no display of the message time on the execution 
screen of the DX recorder.
On: Display 
Off: No display

NoDate display [Off], [On] This selects time display without or with the date on the execution 
screen of the DX recorder. No display is made in the Screen 
construction area. 
On: The time is displayed without the date. 
Off: Time and date are displayed. 

Group display [Off], [On] This selects display/no display of the message write group on the 
execution screen of the DX recorder. 
On: Display 
Off: No display

User display [Off], [On] This selects display/no display of the message write user on the 
execution screen of the DX recorder.
On: Display 
Off: No display

2 Line display [Off], [On] This selects display/no display of messages on two lines on the 
execution screen of the DX recorder. 
ON: 2 Line display 
Off: No 2 Line display

Synchronize action
►Section 3.3

3.27  Attributes of Message List Components
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3.28	 Attributes of Trend Components

		   

The following limitations exist for attribute setting for trend components. 
•	 [Visible] can only be set when [Depend ID] is set to [None].
•	 The time/div font cannot be set when Time/div display is [Off]. 
•	 The message mark size cannot be set when message mark display is [Off]. 
•	 2nd span upper limit and 2nd span lower limit cannot be set when 2nd span is [Off]. 
•	 2nd span upper limit and 2nd span lower limit cannot be switched against each other. 
•	 When the synchro target is [Switch], alarm level setting is not possible. 
•	 If the MultiBatch function is not enabled, the [Batch group no.] cannot be set. 
•	 When [Time Grid Display] is [Off], the time grid for trend components is not displayed. 
•	 When [Scale Grid Display] is [Off], the scale grid for trend components is not 

displayed. 
•	 When the [Time Grid Display] and [Scale Grid Display] are [Off], the background fill 

color is applied without displaying the frame. 
•	 When the [Time Grid Display] is [Off], the [Time display] is [Off] and cannot be set. 
•	 When the [Time Grid Display] is [Off], the [Time font] and [Time interval] cannot be set. 
•	 When [Time display] is [Off], the [Time interval] and [Time font] cannot be set. 



3-58 IM 04L41B01-62EN

Note
•	 Some time may be required until display data are displayed. Please do the following if you 

want to shorten the time. 
•	 If All Channel display is On, set it to Off. 

•	 When displaying data compressed in direction of the time axis, lower the compression 
ratio or reduce the number of trend components. 

•	 When trend components are arranged superposed with push button components, 
communication input components, and switch components, arrange the components so 
that they are not superposed. When parts are arranged without gaps, they can overlap. 
Keep a gap of at least 1 dot between parts. 

•	 When the “Compress ratio” for trend components is set to [2] or higher, the old waveform 
screen may disappear and an intermediate waveform may be displayed in case of display 
switching with trend display at the DX recorder. This is caused by a limitation of the internal 
memory capacity, and it is no abnormality. The data are written to the internal memory. 

List of Settings
Refer to Section 3.3 for attributes without explanations in the list of settings.

Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

X DX1000: 0 to 318
DX2000: 0 to 638

This is the X-coordinate of the left side of the component.
X = 0 for X < 0
X = (Max. width*1 – Width) for (X + Width) > Max. width*1

Y DX1000: 24(0) to 238
DX2000: 40(0) to 478 
(   ) = Status area set to No 
display

This is the Y-coordinate of the upper side of the component.
Y = Min. Y*2 for Y < Min. Y*2

Y = (Min. Y*2 + Max. height*3 – Height) for (Y + Height) > (Min. Y*2 + 
Max. height*3)

Width DX1000: 2 to 320
DX2000: 2 to 640

This is the component width.
Width = 2 for width < 2 
X = (Max. width*1 – Width) for width < Max. width*1 and (X + Width) > 
Max. width*1

Width = Max. width*1, X = 0 for width ≥ Max. width*1

Height DX1000: 2 to 216(240)
DX2000: 2 to 440(480)
(   ) = Status area set to No 
display

This is the component height.
Height = 2 for height < 2
Y = (Max. height*3 – Height) for height < Max. height*3 and (Y + 
Height) > Max. height*3

Height = Max. height*3, Y = 0 for height ≥ Max. height*3

Batch group number Setting range:  1 to multi-
batch number set by the 
basic settings of the DX 
recorder
DX1000: [1] to [6]
DX2000 standard memory: 
	 [1] to [6]
DX2000 expanded memory: 
	 [1] to [12]

This is the batch group number that can be selected within the range 
of the number of multibatches set in the basic settings on the DX 
recorder. 
This item cannot be set when multi-batch of the DX recorder is OFF.

Display Grp no when multi-batch is Off.
DX1000: �[1] to [10]
DX2000: [1] to [36]
when multi-batch is On.
DX1000: [1] to [6]
DX2000: [1] to [12]

Display on the builder screen of the DX recorder is made as “Group 
No.”. 
The group selection range differs according to the batch.

Direction [SET], [Horizontal], [Vertical] This is the waveform flow direction. 
SET: Setting of the DX recorder 
Vertical: Vertical waveform direction 
Horizontal: Horizontal waveform direction

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display

3.28  Attributes of Trend Components
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Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

Compress ratio [1], [2], [4], [5], [6], [7], [8] This selects the number of data represented by 1 dot.
Trend area [50], [60], [70], [80], [90], [100] The rate for the width of the waveform display is calculated with the 

width in direction of the time axis as 100 %. This is used when “Trend 
blank” of the DX recorder is ON. 

Margin 
(can only be set with 
a Version 4.01 screen 
and a Version 4.11 
screen)

[Off], [On] Sets whether or not to display a margin on both sides in the direction 
of the span.
Off: No margin
On: �Margin of 3% of component width is added in the direction of the 

span
Display group 
switching 
(can only be set with 
a Version 4.01 screen 
and a Version 4.11 
screen)

[Off], [On] Sets whether or not to switch the group display in the DX recorder’s 
execution panel when the left/right keys are pressed. 
On: Switched
Off: Not switched

Time/div display [Off], [On] This selects display/no display of Time/div.
Time/div font [Font6], [Font8] This is the font for display of Time/div. Setting is not possible when 

“Time/div display” is [Off]. 
The initial setting is [Font6] for DX1000 and [Font8] for DX2000. 

Time grid display 
(can only be set with 
a Version 4.01 screen 
and a Version 4.11 
screen)

[Off], [On] Sets [On] or [Off] to indicate whether or not the time is displayed. 
When set to [Off], the [Time display] and [Time font] items cannot be 
set. 

Time display [Off], [On] This selects display/no display of the grid time.
On: Display 
Off: No display 

Time interval (can 
only be set with a 
Version 4.01 screen 
and a Version 4.11 
screen)

[Alternate], [EveryGrid] Sets the interval for displaying the time. 
EveryGrid: Displays in all time grids
Alternate: Displays in every other time grid

Time font [Font5], [Font6] This is the font for display of the grid time. 
Setting is not possible when “Time display” is [Off].

Scale grid display 
(can only be set with 
a Version 4.01 screen 
and a Version 4.11 
screen)

[Off], [On] Sets whether or not to display the scale grid. 
On: Displayed
Off: Not displayed

Message display [Off], [On] This selects display/no display of message marks.
On: Display 
Off: No display 

Message mark size [Small], [Large] This is the size for display of message marks. 
Setting is not possible when “Message display” is [Off].

2nd span [Off], [On] This selects effective/disabled for 2nd span. 
On: Effective 
Off: Disabled

2nd span Lower
(On Version3 
screens, no decimal 
places allowed)

[0.0] to [90.0] The 2nd span lower limit is set between setting span lower limit (0.0 %) 
and upper limit (100.0 %). 
Setting is not possible when “2nd span” is [Off]. 

2nd span Upper
(On Version3 
screens, no decimal 
places allowed)

[10.0] to [100.0] The 2nd span lower limit is set between setting span lower limit (0.0 %) 
and upper limit (100.0 %). 
Setting is not possible when “2nd span” is [On]. 

Synchronize action
►Section 3.3

3.28  Attributes of Trend Components
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3.29	 Attributes of Scale Components

		

Bitmap components can be assigned to scale components. 
If bitmap components overlap with scale components that display bitmap components, 
only the bitmap of the component in front is displayed, and components in back are 
displayed in a dotted frame. 
When scale components are assigned bitmaps that cannot be displayed on the DX 
recorder, an X appears in the center of the component.  
The following restrictions apply to the attribute settings of scale components. 
•	 [Visible] can only be set when [Depend ID] is set to [None]. 
•	 If the MultiBatch function is not enabled, the [Batch group no.] cannot be set. 
•	 When [Kind] is [Off], [Bmp filename], [...] button, [Indicator], [Digit], [Alarm mark 

display], [Alarm mark], and [Unit] cannot be set. 
•	 When [Kind] is [On], [Bmp filename] and the [...] button cannot be set. 
•	 When [Kind] is [Bmp], [Digit] cannot be set. 
•	 When [Alarm mark display] is [Off], [Alarm mark] cannot be set. 
•	 When [2ndspan] is [Off], [2nd span Lower] and [2nd span Upper] cannot be set. 
•	 When [Unit] is [Off], scale units are not displayed. 

Note
• Place bitmap files into the same directory as display data (.CDC). The bitmap files cannot be 

displayed when the data are in a different directory. 
• If you assign a bitmap that cannot be displayed on the DX recorder to a scale component, a “×” 

is displayed in the center of the component.
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List of Settings
Refer to Section 3.3 for attributes without explanations in the list of settings.

Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

X DX1000: 0 to 318
DX2000: 0 to 638

This is the X-coordinate of the left side of the component.
X = 0 for X < 0
X = (Max. width*1 – Width) for (X + Width) > Max. width*1

Y DX1000: 24(0) to 238
DX2000: 40(0) to 478 
(   ) = Status area set to No 
display

This is the Y-coordinate of the upper side of the component.
Y = Min. Y*2 for Y < Min. Y*2

Y = (Min. Y*2 + Max. height*3 – Height) for (Y + Height) > (Min. Y*2 + 
Max. height*3)

Width DX1000: 2 to 320
DX2000: 2 to 640

This is the component width.
Width = 2 for width < 2 
X = (Max. width*1 – Width) for width < Max. width*1 and (X + Width) > 
Max. width*1

Width = Max. width*1, X = 0 for width ≥ Max. width*1

Height DX1000: 2 to 216(240)
DX2000: 2 to 440(480)
(   ) = Status area set to No 
display

This is the component height.
Height = 2 for height < 2
Y = (Max. height*3 – Height) for height < Max. height*3 and (Y + 
Height) > Max. height*3

Height = Max. height*3, Y = 0 for height ≥ Max. height*3

Batch group number Setting range:  1 to multi-
batch number set by the 
basic settings of the DX 
recorder
DX1000: [1] to [6]
DX2000 standard memory: 
	 [1] to [6]
DX2000 expanded memory: 
	 [1] to [12]

This is the batch group number which can be selected within the 
range of the multi-batch number set by the basic settings of the DX 
recorder. 
This item cannot be set when multi-batch of the DX recorder is OFF.

Display Grp no when multi-batch is Off.
DX1000: �[1] to [10]
DX2000: [1] to [36]
when multi-batch is On. 
DX1000: [1] to [6]
DX2000: [1] to [12]

This is the batch group number that can be selected within the range 
of the number of multibatches set in the basic settings on the DX 
recorder. 
The group selection range differs according to the batch.

Kind [Off], [On], [Bmp] This is the scale plate kind. 
Off: A simple scale plate without scale values 
On: �Display with the scale plate display divided into the set number of 

divisions and drawing of scale values at fixed intervals. 
Bitmap: �A bitmap designed by the user is used for the scale plate.

Bitmap filename Input is possible for max. 51 
single-byte alphanumeric 
characters. 

This specifies the file name of the bitmap to be displayed. 
This is effective when “Kind” is [Bmp]. This is the name of the bitmap 
file to be pasted onto the scale plate. 
The bitmap file read destination is the folder that the latest display 
data (.CDC) has saved. 

Form [Small], [Large] Scale band format. When the format is [Small] and the channel’s 
green band setting is [Off] in the settings file, the area for the scale 
value and units is filled with the background color of the scale band. 
If there is no settings file, the channel’s green band setting is Off.
Small: �A small scale plate  

The same image as for 4-screen display with DX2000 or the 
scale plate with DX1000. 

Large: �A large scale plate  
This is the same image as for the scale plate at the time of 
other than 4-screen display with DX2000. 

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display

3.29  Attributes of Scale Components
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Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

Indicator [SET], [Mark], [Bar] This is the indicator displayed on the scale plate. 
Setting is not possible when “Kind” is [Off]. 
SET: Setting of the DX recorder 
Mark: �Present value marks are displayed for the number of channels 

registered to the group. 
Bar: �Bars are displayed for the number of channels registered to the 

group. 
Indicator type 
(can only be set with 
a Version 4.01 screen 
and a Version 4.11 
screen)

[Standard], [Micro], [Small], 
[Balance]

Selects the indicator format. 

Digit [SET], [Normal], [Fine] This is the number of display digits of the scale value displayed on 
the scale plate. 
Setting is not possible when “Kind” is [Off]. 
SET: Setting of the DX recorder 
Normal: Effective digits of the scale value: 2 digits 
Fine: Effective digits of the scale value: 3 digits 

Unit 
(can only be set with 
a Version 4.01 screen 
and a Version 4.11 
screen)

[Off], [On] Selects whether or not to display the units. 
On: The units are displayed
Off: The units are not displayed

Margin (can only be 
set with a Version 
4.01 screen and a 
Version 4.11 screen)

[Off], [On] Sets whether or not to display a margin on both sides in the direction 
of the span.
On: �Margin of 3% of component width is added in the direction of the 

span
Off: The margin is not displayed

Display group 
switching 
(can only be set with 
a Version 4.01 screen 
and a Version 4.11 
screen)

[Off], [On] Sets whether or not to switch the group display in the DX recorder’s 
execution panel when the left/right keys are pressed. 
On: Switched
Off: Not switched

Trend direction [SET], [Vertical], [Horizontal] This is the waveform flow direction. 
SET: Setting of the DX recorder 
Vertical: Vertical waveform direction 
Horizontal: Horizontal waveform direction

Alarm mark display [Off], [On], [SET] Selection of alarm mark display/no display 
Setting is not possible when “Kind” is [Off]. 
Off: No alarm mark display 
On: Alarm mark display 
SET: Setting of the DX recorder

Alarm mark [Alarm], [Fixed], [SET] This selects the alarm mark style. 
Setting is not possible when “Kind” is [Off] or “Alarm mark display” is 
[Off] 
Alarm: �Color change may occur at the time of trapezoid display and 

at the time of alarm ON. 
Fixed: �No color change at the time of trapezoid display and at the 

time of alarm ON. 
SET: Setting of the DX recorder

2nd span [Off], [On] This selects effective/disabled for 2nd span. 
On: Effective 
Off: Disabled

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display

3.29  Attributes of Scale Components
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Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

2nd span Lower
(On Version3 
screens, no decimal 
places allowed)

[0.0] to [90.0] The 2nd span lower limit is set between setting span lower limit (0.0 %) 
and upper limit (100.0 %). 
Setting is not possible when “2nd span” is [Off]. 

2nd span Upper
(On Version3 
screens, no decimal 
places allowed)

[10.0] to [100.0] The 2nd span lower limit is set between setting span lower limit (0.0 %) 
and upper limit (100.0 %). 
Setting is not possible when “2nd span” is [On]. 

Synchronize action
►Section 3.3

3.29  Attributes of Scale Components
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3.30	 Attributes of Line Components

		   

The following limitations exist for setting of attributes of line component attributes.
•	 [Visible] can only be set when [Depend ID] is set to [None].

List of Settings
Refer to Section 3.3 for attributes without explanations in the list of settings.

Attribute Set value/choice 
(Underlined items are initial 
set values)

Description, conditions

From X DX1000: 0 to 319
DX2000: 0 to 639

This is the X-coordinate of the start point for component creation.
From X = 0 for From X < 0
From X = (Max. width*1 – 1) for From X > (Max. width*1 – 1)

From Y DX1000: 24(0) to 239
DX2000: 40(0) to 479 
(   ) = Status area set to No 
display

This is the Y-coordinate of the start point for component creation.
From Y = Min. Y*2 for From Y < Min. Y*2

From Y = (Min. Y*2 + Max. height*3 – 1) for From Y > (Min. Y*2 + Max. 
height*3 – 1)

To X DX1000: 0 to 319
DX2000: 0 to 639

This is the X-coordinate of the end point for component creation.
To X = 0 for To X < 0
To X = (Max. width*1 – 1) for To X > (Max. width*1 – 1)

To Y DX1000: 24(0) to 239
DX2000: 40 (0)to 479
(   ) = Status area set to No 
display

This is the Y-coordinate of the end point for component creation.
To Y = Min. Y*2 for To Y < Min. Y*2

To Y = (Min. Y*2 + Max. height*3 – 1) for To Y > (Min. Y*2 + Max. 
height*3 – 1)

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display
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Attribute Set value/choice 
(Underlined items are initial 
set values)

Description, conditions

Line color [Red], [Green], [Blue], 
[B.violet], [Brown], [Orange], 
[Y.green], [Light blue], [Violet], 
[Gray], [Lime], [Cyan], [Dark 
blue], [Yellow], [Light gray], 
[Purple], [Pink], [L.brown], 
[L.green], [Dark gray], [Olive], 
[Dark cyan], [S.green], 
[Black], [White], [BASE]

This is the line color. 
BASE: Base color (background color of the screen)

Line kind [Solid], [Dotted], [Dash],  
[Longdash]

The line kind is set. 
Solid:  A solid line 
Dotted: �A line with continuous repetition of two dots and two blank 

spaces. 
Dash: �A line with continuous repetition of four dots and four blank 

spaces. 
Longdash: �A line with continuous repetition of six dots and two blank 

spaces.
Trend grid (can only 
be set with a Version 
4.01 screen and a 
Version 4.11 screen)

[On], [Off] Sets whether or not it should act as the grid of the dependant trend 
component. 
ON: �Plotted as the grid of the trend component specified by the 

Depend ID. 
Off: Displayed as lines. 

Synchronize action
►Section 3.3

3.30  Attributes of Line Components
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3.31	 Attributes of Rectangle Components

		   

The following limitations exist for setting of attributes of rectangle components.
•	 [Visible] can only be set when [Depend ID] is set to [None].

List of Settings
Refer to Section 3.3 for attributes without explanations in the list of settings.

Attribute Set value/choice 
(Underlined items are initial 
set values)

Description, conditions

X DX1000: 0 to 318
DX2000: 0 to 638

This is the X-coordinate of the left side of the component.
X = 0 for X < 0
X = (Max. width*1 – Width) for (X + Width) > Max. width*1

Y DX1000: 24(0) to 238
DX2000: 40(0) to 478 
(   ) = Status area set to No 
display

This is the Y-coordinate of the upper side of the component.
Y = Min. Y*2 for Y < Min. Y*2

Y = (Min. Y*2 + Max. height*3 – Height) for (Y + Height) > (Min. Y*2 + 
Max. height*3)

Width DX1000: 2 to 320
DX2000: 2 to 640

This is the component width.
Width = 2 for width < 2 
X = (Max. width*1 – Width) for width < Max. width*1 and (X + Width) > 
Max. width*1

Width = Max. width*1, X = 0 for width ≥ Max. width*1

Height DX1000: 2 to 216(240)
DX2000: 2 to 440(480)
(   ) = Status area set to No 
display

This is the component height.
Height = 2 for height < 2
Y = (Max. height*3 – Height) for height < Max. height*3 and (Y + 
Height) > Max. height*3

Height = Max. height*3, Y = 0 for height ≥ Max. height*3

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display
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Attribute Set value/choice 
(Underlined items are initial 
set values)

Description, conditions

Line color [Red], [Green], [Blue], 
[B.violet], [Brown], [Orange], 
[Y.green], [Light blue], [Violet], 
[Gray], [Lime], [Cyan], [Dark 
blue], [Yellow], [Light gray], 
[Purple], [Pink], [L.brown], 
[L.green], [Dark gray], [Olive], 
[Dark cyan], [S.green], 
[Black], [White], [BASE], 
[None]

This is the line color. 
BASE: Base color (background color of the screen)
None: No line (outer frame)

Background color Same choice as for “Line”, 
[None]

This is the color inside the rectangle. 
None: No background color

Line kind [Solid], [Dotted], [Dash],  
[Longdash]

This is the kind of line for drawing the rectangle.
Solid:  A solid line 
Dotted: �A line with continuous repetition of two dots and two blank 

spaces. 
Dash: �A line with continuous repetition of four dots and four blank 

spaces. 
Longdash: �A line with continuous repetition of six dots and two blank 

spaces.

Synchronize action
►Section 3.3

3.31  Attributes of Rectangle Components
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3.32	 Attributes of Circle Components

		   

The following limitations exist for setting of attributes of circle components.
•	 [Visible] can only be set when [Depend ID] is set to [None].

List of Settings
Refer to Section 3.3 for attributes without explanations in the list of settings.

Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

X DX1000: 0 to 318
DX2000: 0 to 638

This is the X-coordinate of the left side of the square enclosing the 
component.
X = 0 for X < 0
X = (Max. width*1 – size) for (X + size) > Max. width*1

Y DX1000: 24(0) to 238
DX2000: 40(0) to 478 
(   ) = Status area set to No 
display

This is the Y-coordinate of the top of the square enclosing the 
component.
Y = Min. Y*2 for Y < Min. Y*2

Y = (Min. Y*2 + Max. height*3 – size) for (Y + size) > (Min. Y*2 + Max. 
height*3)

Size DX1000: 2 to 216(240)
DX2000: 2 to 440(480)
(   ) = Status area set to No 
display

This is the size of the square enclosing the component.
Size = 1 for Size < 1
X = (Max. height*3 – Size) for height < Max. height*3 and (Y + Size) > 
Max. height*3

Y = (Min. Y*2 + Max. height*3 – Size) for Size < Max. height*3 and (Y + 
Size) > (Min. Y*2 + Max. height*3)
Size = Max. height*3, Y = Min. Y*2 for Size ≥ Max. height*3

Size = Max. height*3, X = (Max. width*1 – Max. height*3)  
for Size ≥ Max. height*3 and (X + Max. height*3) > Max. width*1

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display
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Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

Line color [Red], [Green], [Blue], 
[B.violet], [Brown], [Orange], 
[Y.green], [Light blue], [Violet], 
[Gray], [Lime], [Cyan], [Dark 
blue], [Yellow], [Light gray], 
[Purple], [Pink], [L.brown], 
[L.green], [Dark gray], [Olive], 
[Dark cyan], [S.green], 
[Black], [White], [BASE], 
[None]

This is the line color. 
BASE: Base color (background color of the screen)
None: No line (outer frame)

Background color Same choice as for “Line”, 
[None]

This is the color inside the circle. 
None: No background color

Synchronize action
►Section 3.3

3.32  Attributes of Circle Components
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3.33	 Attributes of Bitmap Components

		

Click here to browse for 
a bitmap file

 

The following limitations exist for setting of attributes of bitmap components.
•	 [Visible] can only be set when [Depend ID] is set to [None].
•	� When setting [Depend ID] to the ID of a trend component, if [Trend grid mode] is 

turned [On], [Disp. on editing] is [On] and cannot be set. 
•	� When setting [Depend ID] to the ID of a trend component, if [Trend grid mode] is 

turned [Off], display in the builder screen becomes available for setting 
•	� When setting [Depend ID] to the ID of a trend component, if [Trend grid mode] is 

turned [On], [Image processing] is [Off] and cannot be set. 
•	� When setting [Depend ID] to the ID of a trend component, if [Trend grid mode] is 

turned [Off], you can set [Image processing]. 
•	� If [Trend grid mode] is [On], when [Depend ID] is set to the ID of a trend component, 

[Disp. on editing] is [On] and cannot be set. 
•	� If [Trend grid mode] is [On], when [Depend ID] is set to the ID of a component other 

than a trend component, [Disp. on editing] can be set.  
•	� If [Trend grid mode] is [On], when [Depend ID] is set to the ID of a trend component, 

[Image processing] is [Off] and cannot be set. 
•	� If [Trend grid mode] is [On], when [Depend ID] is set to the ID of a component other 

than a trend component, [Image processing] can be set.  
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Note
•	 When “Image processing” is [On], some time may be required until display of display data at 

the DX recorder. Set to [Off] if you want to shorten the time. 
•	 Place bitmap files into the same directory as display data (.CDC). The bitmap files cannot 

be displayed when the data are in a different directory. 
•	 When display data using bitmap components are sent to the internal memory of the DX 

recorder, the bitmap image is not displayed on the execution screen. For display of bitmap 
images which have not been displayed even once, the external storage media (CF card) 
where these bitmap files are stored, must be inserted into this unit. 

•	 For arrangement of bitmap components overlapping each other and using them with display 
switching, the external storage media (CF card) where these bitmap files are stored must be 
inserted into the DX recorder. 

•	 When bitmap components are assigned bitmaps that cannot be displayed on the DX 
recorder, an X appears in the center of the component. 

List of Settings
Refer to Section 3.3 for attributes without explanations in the list of settings.

Attribute Set value/choice
(Underlined items are initial 
set values)

Description, conditions

X DX1000: 0 to 318
DX2000: 0 to 638

This is the X-coordinate of the left side of the component.
X = 0 for X < 0
X = (Max. width*1 – Width) for (X + Width) > Max. width*1

Y DX1000: 24(0) to 238
DX2000: 40(0) to 478 
(   ) = Status area set to No 
display

This is the Y-coordinate of the upper side of the component.
Y = Min. Y*2 for Y < Min. Y*2

Y = (Min. Y*2 + Max. height*3 – Height) for (Y + Height) > (Min. Y*2 + 
Max. height*3)

Width DX1000: 2 to 320
DX2000: 2 to 640

This is the component width.
Width = 2 for width < 2 
X = (Max. width*1 – Width) for width < Max. width*1 and (X + Width) > 
Max. width*1

Width = Max. width*1, X = 0 for width ≥ Max. width*1

Height DX1000: 2 to 216(240)
DX2000: 2 to 440(480)
(   ) = Status area set to No 
display

This is the component height.
Height = 2 for height < 2
Y = (Min. Y*2 + Max. height*3 – Height) for height < Max. height*3 and (Y 
+ Height) > (Min. Y*2 + Max. height*3)
Height = Max. height*3, Y = Min. Y*2 for height ≥ Max. height*3

Bitmap filename Input is possible for max. 51 
single-byte alphanumeric 
characters. 

This specifies the bitmap file name. The bitmap file read destination is 
the folder that the latest display data (.CDC) has saved. To browse for 
a new file, click the button to the right of the file name box. 

Trend grid (can only 
be set with a Version 
4.01 screen and a 
Version 4.11 screen)

[Off], [On] Sets whether or not it should act as the grid of the trend component. 
On: Acts as the trend grid
Off: Does not act as the trend grid
If the Depend ID is set to On while the Trend component was being 
set, [Disp. on editing] is fixed to [On] and cannot be changed, and 
[Image Processing] is also fixed to [Off] and cannot be changed. 

Image processing [Off], [On] This sets image processing conversion at the time of bitmap file 
reading to [On] or [Off]. When this is set to On, some time is required 
until display. This time is approximately 30 sec when the image size is 
640 x 480 pixel. 
On:� When a bitmap is read in on the DX recorder, display is made 

after optimizing for the display of the DX recorder. 
Off: �No image processing 

Disp. On editing [Off], [On] On: �Bitmap images are displayed on the execution screen of the DX 
recorder. 

Off: �Dotted line frames and characters indicating that these are 
bitmap components are displayed.

*1	 DX1000 max. width = 320, DX2000 max. width = 640
*2	 DX1000 min. Y = 24(0), DX2000 min. Y = 40(0), (   ) = Status area set to No display
*3	 DX1000 max. height = 216(240), DX2000 max. height = 440(80), (   ) = Status area set to No display

Continued on the next page

3.33  Attributes of Bitmap Components
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Specifying the Bmp file name
If you specify a folder and try to assign a bitmap of a file name that already exists in the 
bitmap folder, a message appears. 

		

Overwrite: Overwrites the specified bitmap
Copy to Different Name: Copies the specified bitmap to a different name
Cancel: Cancels bitmap assignment. 

If you select to copy to a different name, the file is copied to the bitmap folder with a ˜ 
followed by a serial number starting with 0 added to the filename. Serial numbers range 
from 0 to 200. (for example, sample.bmp would be copied to sample˜0.bmp)
If adding the ˜ and serial number causes the file name to exceed 51 characters, enough 
characters (excluding the extension) are removed from the end of the file name to make 
it contain 51 characters. 
(for example, if sample....abcde.bmp contains 51 characters, it would be copied as 
sample....abc˜0.bmp)

Synchronize action
►Section 3.3

3.33  Attributes of Bitmap Components
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Chapter 4	 Communication with DX Recorder

4.1	 Receiving Display Data from DX Recorder

If screen data (custom display data) is received from the DX recorder via 
communications, it is reflected on DAQStudio. 
If the Batch function is MultiBatch, the Batch/Group list page appears in the work area, 
and the Group list page is not displayed. 
If the Batch function is Off or On, the Group list page appears in the work area, and the 
Batch/Group list is not displayed. 
When receiving screen data from the DX recorder, the Channel/alarm list page is 
displayed in the work area. 
If the DX includes the /AS1 option, set up the DX in advance as follows. (In the example 
of setting up the DX below, the user ID is not set.)
DX main unit (with /AS1 option) settings
1.	 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > Security > Communication, and set 
Login. 

2.	 Select the Menu tab > User registration > Admin settings > Mode, set [Key+Comm], 
enter the user name, and return to the operation screen.

If a password is set, this concludes the setup. If no password set, perform the following 
additional steps. 
3.	 Press FUNC, select Admin1, then press DISP/ENTER. 
4.	 Skip the user ID and select ENT. 
5.	 Enter Admin1 for the password, then select ENT. 
6.	 Enter a new password (between 6 and 20 alphanumeric characters, no spaces 

allowed), then select ENT. 
7.	 Reenter the new password and select ENT.

Procedure
1.	 Select Communication > Receive. 

“Receive” dialog box appears. 

					      

2.		 Enter the DX recorder’s IP address and host name, and the user name, user ID, 
and password.
IP address/Host name: 	�Up to 64 single-byte alphanumeric characters can be entered. The 

initial setting is “admin.”
User name:	 Up to 20 alphanumeric characters can be entered. 
User ID:	 Up to 8 alphanumeric characters can be entered. 
Password:	 Up to 20 single-byte alphanumeric characters can be entered.
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3.	 Click [Receive].
A message is displayed. 

					   

4.	 Click [OK].
All custom display screen data in the internal memory of the DX recorder and on the CF 
card are received to the save object folder. 

5.	 Save the file. (►Section 2.5)

Explanation
Only the items set for the DX recorder are entered for IP address/host name, user name, 
and password. The IP address/host name and user name entered at this time are saved, 
and they are displayed when the software is started the next time. The user ID and 
password are not stored. They cleared each time.

The extension of data which can be received by the software from the DX recorder is 
CDC, CDS, and bmp. The file name is as shown below. 

Internal1.CDC to Internal3.CDC: 	� Saved in the root directory of the internal memory 
of the DX recorder. 

External1.CDC to External25.CDC: 	� They are saved in the CF card inserted into the 
DX recorder.

Setting.CDS: 	 These are the DX recorder settings. 
Arbitrary_name.bmp:	� The bitmap file assigned to the component. They are 

saved in the CF card inserted into the DX recorder. 

When screen data is received from the DX recorder, the software screen version is as follows.
・	 The software screen version is the newest version in the received display data (.CDC).

All custom display screen data (Internal1.CDC to Internal3.CDC and External1.CDC to
External25.CDC), setting file(.CDS), and bitmap file(.bmp) in the root directory of the 
internal memory of the DX recorder and in the root directory of the CF card are received 
to the folder that the latest display data has saved. 
The display data and bitmap data must be saved every time they have been received 
from DX recorder.
Custom display screen data (.CDC) can be received to DX recorders with a release 
number from R3 on. 

Notes on Firewalls
Under Windows Vista or Windows 7, a firewall-related warning appears when receiving 
screen data from the DX. Check the contents of the message, then click [Unblock] 
(Windows Vista) or [Allow access] (Windows 7).

		

Example: Windows Vista

4.1  Receiving Display Data from DX Recorder
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4.2	 Sending Display Data to DX Recorder

If the DX includes the /AS1 option, perform the DX main unit (with /AS1 option) settings 
procedure in section 4.1 in advance.

Procedure
1.	 Select Communication > Send. 

“Send” dialog box appears.

					      

2.	 Enter the IP address/host name of the DX recorder, the user name, and the 
password. 
IP address/Host name:	 Up to 64 single-byte alphanumeric characters can be entered.
User name:	� Up to 20 alphanumeric characters can be entered. The initial setting 

is “admin.” 
User ID:	� Up to 8 alphanumeric characters can be entered. This is only set if 

the DX recorder includes the /AS1 option and the user ID is used. 
([User ID] is only displayed on the version 4.01 and 4.11 screens.)

Password: 	 Up to 20 single-byte alphanumeric characters can be entered. 

3.	 Click [Send]. 
A message is displayed. 

					   

4.	 Click [OK]. 
The opening display data (including editing display data) and bitmap files used for the 
display data are sent to the DX recorder. 
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Explanation
Only the items set for the DX recorder are entered for IP address/host name, user name, 
user ID, and password. The IP address/host name and user name entered at this time 
are saved, and they are displayed when the software is started the next time. The user 
ID and password are not stored. They cleared each time. Once you close the [Send] 
dialog box, the previously entered user ID and password become blank when the dialog 
box is reopened.
When sending data, if there are any bitmap files that are not supported by the DX 
recorder, a message (W8039, see section 5.1) appears.
Before sending data, please check the options on the main unit. If you try to send screen 
data that requires options to a DX recorder without those options, a message (W8042, 
see section 5.1) appears. 
Options to check
Component Attribute Setting Option
System icon Type Math Math

UserLock AS1
User & status AS1

Modbus In Communication Serial RS232, RS422A/485

Sending is not allowed if the DX recorder version differs from the DAQStudio screen 
version. 
►Section 2.4

The extension of data which are sent from this software to the DX recorder is CDC and 
bmp. The file name is as shown below. 

Internal1.CDC to Internal3.CDC: 	� Written to the root directory of the internal 
memory of the DX recorder. 

External1.CDC to External25.CDC: 	� Written to the CF card inserted into the DX 
recorder. 

Arbitrary_name.bmp:	� If saved to the same directory as the screen 
data, it is written to the internal memory of the 
DX recorder. 

Display data can be sent from DAQStudio to DX recorders with a release number of R3 
or higher. 
Display data for DX1000 cannot be sent to DX2000. In the same way, Display data for 
DX2000 cannot be sent to DX1000. Please send display data corresponding to the 
equipment. 

Cautions in regard to the display processing time by the DX recorder 
Some time may be required until the created display data are displayed by the DX 
recorder. In such a case, saving of measuring data and output of communication data 
are performed normally, but attention should be paid to the following. 
•	 Do not operate keys until display processing has been completed. 
•	 Even if event phenomena of event actions occur, event processing may not be started 

until completion of display processing. 
•	 Web screen updating may be delayed. 

4.2  Sending Display Data to DX Recorder



5.1	 List of Messages

Messages may be displayed on the screen during use.
Error message
Code Message Handling Methods/Explanation Refer to
E0004 Invalid License number. Please enter a correct license number. —
E0250 Failed to start Adobe Reader.  Adobe Reader 7.0 or later is required to view the user’s 

manual. 
Check whether Adobe Reader is installed. 

—

E8001 Connection error, please check 
communication setting!

Please use System environment to confirm that the 
communication settings (IP address/host name, user name, 
password) with the connection object equipment are correct. 

Section 4.1, 
Section 4.2

E8002 The connected device is not 
supported!

The following causes can be assumed. Please confirm the 
connected equipment. 
•  The equipment is not DX1000/DX1000N/DX2000. 
•  The release number of DX1000/DX1000N/DX2000 is not 

R3 or higher. 

Section 4.1, 
Section 4.2

E8003 Receive failed! The following causes can be assumed. Please check.
•  Communication with the DX is not normal. 
•  The DX’s FTP server function is On. 
•  �A CF card is inserted into the DX recorder. Also make sure 

that the CF card has free space. 
•  �If Multilogin is On, communication will always result 

in an error when users logged on via key login have 
communication connections open and have moved to a 
mode other than Operate mode. 

—

E8004 Send failed! The following causes can be assumed. Please check. 
•  Communication with the DX is not normal. 
•  The DX’s FTP server function is On. 
•  �A CF card is inserted into the DX recorder. Also make sure 

that the CF card has free space. 
•  �If Multilogin is On, communication will always result 

in an error when users logged on via key login have 
communication connections open and have moved to a 
mode other than Operate mode. 

•  If the version of the connected DX recorder is earlier than 
4.11 and the recorder is a model with the /AS1 option, 
memory start is in progress.

•  �The same user is logged in to the main unit. (If Multilogin is 
OFF, an error occurs if another user is logged in.)

•  Settings are being entered on the main unit. 

—

E8005 Failed to save graphic file! The following causes can be assumed. Please check. 
•  The save object disk is broken. 
•  No permission has been given for file and folder writing/

reading. 
•  The empty capacity of the disk is not sufficient. 

—

E8006 Failed to read graph file! The following causes can be assumed. 
•  The object data are being used for another program. 
•  The present user does not have the authority to access the 

file. Confirm the file attributes. 
•  The file is broken. Confirm the file attributes. 

—

E8007 Invalid folder name! The entered folder name is not correct. Enter a correct folder 
name. 

Section 2.12

E8008 Failed to send! The machine’s 
hardware is different.

Check if a DX1000 screen construction file has been sent to 
DX2000 or vice versa. 

Section 4.1

Continued on the next page

Chapter 5	 Messages and Handling Methods
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Code Message Handling Methods/Explanation Refer to
E8009 Login failed! The following causes can be assumed. Please check. 

•  Wrong user name, user ID, or password. 
•  The DX unit is connected by different software. 
•  If Multilogin is Off, users are already logged in. 
•  Password has expired.
•  �The number of failures exceeded the previously specified 

number. 

—

E8010 Failed to paste all or some parts. The following causes can be assumed. Please check. 
The max. number of components which can be created on 
one screen has been exceeded at the time of pasting. 

Section 3.2

E8011 Failed to create folder! Check for normal disk capacity and file system. —
E8013 There is no CF card in the 

DXAdvanced. 
Check whether the CD card has been inserted into the DX 
recorder.  installed. 

Section 3.34
Chap 4

E8014 Failed to copy bitmap file. The following causes can be assumed. Please check.
•  The disc is corrupt. 
•  �There is insufficient space in the directory. If there is 

insufficient space, free up some space. 
•  �The current user does not have permission to access the 

file, and read/write permission for files and folders has not 
been granted. 

•  �If copying a bitmap file not supported by the DX recorder, 
copy a bitmap file that can be displayed by the DX recorder. 

•  �When copying a bitmap to a different name, if the number 
after the ~ in the file name exceeds 200, delete other 
unneeded bitmaps. 

Section 3.34

E8015 Cannot send due to firmware version 
mismatch. 

Make sure the DAQStudio screen version is the same as the 
DX recorder firmware version (release number). 

Section 2.4

Warning message
Code Message Description Refer to
W8031 Do you want to save the changes of 

display?
The screen changes have not been saved. Select Save (OK)/
Don’t save (Cancel).

Section 2.1

W8032 Is it OK to discard recent display and 
open selected one?

Select discarding of the present screen and creation of a new 
screen (OK)/No (Cancel). 

Section 2.5

W8033 Is it OK to delete [displayname]? Select Delete screen/No. The [Screen name] is the deletion 
object data name selected in the Screen list. 

Section 2.9

W8034 Send display data to DX. Is it OK to 
save display data in DX?

Screen construction data are sent to the DX unit. Section 2.9

W8035 Receiving display data from DX. Is 
it OK to discard recent display and 
create new ones?

Screen construction data are received from the DX unit. Section 4.1

W8036 Is it OK to discard [displayname], 
and paste another one to here.

Screen name is the Screen name selected in the Screen 
list. This screen is discarded and the screen is pasted to this 
position.  

Section 2.9

W8037 The specified file already exists in 
the bitmap folder. Choose one of the 
following options.

Specify the copy action. Section 3.34

W8038 Because "xxx.bmp" is longer than 
51 characters, it will be copied to a 
different file name. Is this OK?

Copy the file specified in the bitmap browsing dialog box to a 
different name having 51 characters or fewer. 

Section 3.34

W8039 A bitmap file that the DX does not 
support exists. Are you sure you 
want to send the files? 

Move the bitmaps that are not supported by the recorder to 
another folder, or delete them. If OK to send, click [OK]. 

Section 4.2

W8040 When you convert to the previous 
version display, all unsupported 
components and attributes will 
be lost. Are you sure you want to 
continue?

Confirm whether it is OK to lose the components that are not 
supported by screen versions that are earlier than the current 
screen version. The attributes or components will also be lost.

Section 5.3

W8041 All displays will be discarded and a 
new display will be created. Are you 
sure you want to continue? 

If you do not wish to change or delete a created screen, click 
[Cancel], and then save the screen data. 

Section 2.5

5.1  List of Messages
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W8042 Settings that the DX does not 
support are included. Are you sure 
you want to send the settings? 

There are settings that are not supported by the DX recorder. 
Determine whether you will send all files before performing 
the procedure. 

—

5.1  List of Messages
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5.2	 Version Information

Procedure
1.	 Select Help > Version Information from the menu bar or click the Version 

Information icon. 
The version information is displayed. 

					   

Explanation
Data incompatible due to a different DAQStudio version 
As long as it is the same language, DAQStudio version R1.01 and R1.02 data are 
mutually compatible. When loading R1.01 and R1.02 data, the sizes of the components 
are adjusted. 
Line component:	� If the start and end points overlap, adjust the end point to 

1 dot along the X axis away from the start point. 
Components other than lines:	� If the minimum width and height is less than 2 dots, 

change it to 2 dots.

Depending on the software version, the indicated component attribute names may differ.
DAQStudio version Attribute name Corresponding Component
R3.01.01 BG transparent Batch name

Decimal place Commnication input, Modbus in
R2.01.01 Batch group number Screen, Alarm list, Message list, Trend, 

scaleR1.02 Previous batch number
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5.3	 Changing the Screen Version

When you switch the screen version, the screen construction data is converted to the 
new version. 

When switching from Version 3 to Version 4.01 or Version 4.11
•	 Version 3 component attributes remain the same. 
•	 Component attributes that became available for setting in Version 4.01 or Version 4.11 

are set to their defaults. 
•	 [2nd span Lower] and [2nd span Upper] settings of trend and scale components can 

now be set up to 1 decimal place. 

When switching from Version 4.01 to Version 4.11
•	 Version 4.01 component attributes remain the same. 
•	 Component attributes that became available for setting in Version 4.11 are set to their 

defaults. 

When switching from Version 4.01 or Version 4.11 to Version 3
•	 Components not supported in Version 3 are deleted. 
•	 The [Depend ID]’s of components dependent on other components not supported in 

Version 3 are set to [None]. - Attributes of components not supported in Version 3 are 
deleted. The [Vertical display] of components whose attributes are deleted (Labels, 
Tag no., Tag comment, Units, SpanL, and SpanU) is changed to [Off] (horizontal 
display). 

•	 Attributes of components not supported in Version 3 are deleted. The method of 
plotting is changed for components whose attributes are deleted (trend and scale). 

•	 For the trend component’s [2nd span Lower] and [2nd span Upper] settings, the 
number of decimal places is changed to 0, and the number after the decimal point is 
rounded. 

•	 For the scale component’s [2nd span Lower] and [2nd span Upper] settings, the 
number of decimal places is changed to 0, and the number after the decimal point is 
rounded. 

•	 If not displaying the status area in a Version 4.01 screen or Version 4.11 screen, it is 
displayed. Components in the status area are repositioned. 

	 When switching the status area from [No display] to [Display], components overlapping 
the status area move into the screen display area. Also, if the height of a component 
exceeds the maximum value for the screen construction area, the height is changed 
to the maximum value.

When switching from Version 4.11 to Version 4.01
•	 Components not supported in Version 4.01 are deleted. 
•	 Attributes of components not supported in Version 4.01 are deleted. 
・	 The method of plotting is changed for components whose attributes are deleted.

Component differences by screen version
Component Version 3 screen Version 4.01 screen

Version 4.11 screen
System icon New
Group name New
Batch group number New 
Batch name New 
Time label  New
Memory bar New
Modbus In New
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Attribute differences by screen version
Component Attribute Version 3 screen Version 4.01 screen

Version 4.11 screen
Screen Status area New
Labels Vertical display New
Tag no. Vertical display New 
Tag comments Vertical display New 
Unit Vertical display  New
SpanL Vertical display New
SpanU Vertical display New
Bitmap Trend grid mode New 
Line Trend grid mode New

Continued on the next page

Component Attribute Version 3 screen Version 4.01 screen
Version 4.11 screen

Trend Margin New
Display group switching New
Time interval New
Time grid display New
Scale Grid Display New
2nd span     Lower No decimal place setting One decimal place 

can be set
2nd span     Upper No decimal place setting One decimal place 

can be set
Scale Indicator type

Unit
Margin on both sides of Span 
Display group switching
2nd span     Lower No decimal place setting One decimal place 

can be set
2nd span     Upper No decimal place setting One decimal place 

can be set

Component Attribute Version 4.01 screen Version 4.11 screen
Batch name BG transparent New
Communication 
input

Decimal place New

Modbus input Decimal place New

5.3   Changing the Screen Version
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